
PeopleTools 8.62: Lifecycle
Management Guide

April 2025



PeopleTools 8.62: Lifecycle Management Guide
Copyright © 1988, 2025, Oracle and/or its affiliates.

This software and related documentation are provided under a license agreement containing restrictions on use and
disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement
or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute,
exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or
decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you
find any errors, please report them to us in writing.

If this is software, software documentation, data (as defined in the Federal Acquisition Regulation), or related
documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government,
then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs (including any operating system, integrated software,
any programs embedded, installed, or activated on delivered hardware, and modifications of such programs) and
Oracle computer documentation or other Oracle data delivered to or accessed by U.S. Government end users
are "commercial computer software," "commercial computer software documentation," or "limited rights data"
pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such,
the use, reproduction, duplication, release, display, disclosure, modification, preparation of derivative works,
and/or adaptation of i) Oracle programs (including any operating system, integrated software, any programs
embedded, installed, or activated on delivered hardware, and modifications of such programs), ii) Oracle computer
documentation and/or iii) other Oracle data, is subject to the rights and limitations specified in the license contained
in the applicable contract. The terms governing the U.S. Government's use of Oracle cloud services are defined by
the applicable contract for such services. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is
not developed or intended for use in any inherently dangerous applications, including applications that may create a
risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible
to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation
and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous
applications.

Oracle®, Java, MySQL, and NetSuite are registered trademarks of Oracle and/or its affiliates. Other names may be
trademarks of their respective owners.

Intel and Intel Inside are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used
under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Epyc, and the AMD
logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The
Open Group.

This software or hardware and documentation may provide access to or information about content, products, and
services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all
warranties of any kind with respect to third-party content, products, and services unless otherwise set forth in an
applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be responsible for any
loss, costs, or damages incurred due to your access to or use of third-party content, products, or services, except as
set forth in an applicable agreement between you and Oracle.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program
website at https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle
Support. For information, visit https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit https://
docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=info
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs
https://docs.oracle.com/pls/topic/lookup?ctx=acc&id=trs


Contents

Preface: Preface...........................................................................................................................................xi
Understanding the PeopleSoft Online Help and PeopleBooks............................................................. xi

Hosted PeopleSoft Online Help...................................................................................................... xi
Locally Installed PeopleSoft Online Help...................................................................................... xi
Downloadable PeopleBook PDF Files............................................................................................xi
Common Help Documentation........................................................................................................xi
Field and Control Definitions........................................................................................................ xii
Typographical Conventions............................................................................................................xii
ISO Country and Currency Codes................................................................................................xiii
Region and Industry Identifiers.................................................................................................... xiii
Translations and Embedded Help................................................................................................. xiv

Using and Managing the PeopleSoft Online Help.............................................................................. xiv
PeopleTools Related Links.................................................................................................................. xiv
Contact Us............................................................................................................................................xiv
Follow Us..............................................................................................................................................xv

Chapter 1: Getting Started with Application Designer's Lifecycle Management Features................17
PeopleSoft Application Designer Implementation............................................................................... 17
Other Sources of Information...............................................................................................................17

Chapter 2: Upgrading with PeopleSoft Application Designer.............................................................. 19
Understanding a PeopleSoft Upgrade...................................................................................................19

PeopleSoft Application Designer Upgrade Features......................................................................19
Definition Types That You Can Upgrade...................................................................................... 20

Using the Upgrade Workspace............................................................................................................. 20
Switching to the Upgrade View.....................................................................................................20
Viewing Upgrade Attributes by Definition Type...........................................................................21
Working with Upgrade Definition Columns..................................................................................22
Using Upgrade Menu Actions....................................................................................................... 22
Setting Upgrade Options................................................................................................................ 24

Preparing Projects for an Upgrade....................................................................................................... 37
Understanding Upgrade Projects....................................................................................................37
Populating Projects......................................................................................................................... 37
Searching for Definitions............................................................................................................... 38
Printing All Definitions in a Project..............................................................................................38
Obtaining Access for Upgrading....................................................................................................38

Viewing Upgrade Messages..................................................................................................................38
Understanding Upgrade Messages................................................................................................. 38
Determining Whether Errors Were Encountered........................................................................... 38
Viewing Messages.......................................................................................................................... 39
Printing Upgrade Messages............................................................................................................39
Clearing Messages..........................................................................................................................39

Chapter 3: Comparing Source and Target Definitions..........................................................................41
Understanding the Compare Process....................................................................................................41

Comparing All Definitions by Type.............................................................................................. 42
Comparing Definitions by Project................................................................................................. 42
Synchronizing Databases When Comparing Record Definitions.................................................. 42

Working With Compare Reports.......................................................................................................... 44

Copyright © 1988, 2025, Oracle and/or its affiliates. iii



Contents

Running a Compare Report........................................................................................................... 44
Working with the Compare and Report Dialog Box..................................................................... 46

Working With Workspace Reports....................................................................................................... 48
Accessing Reports.......................................................................................................................... 48
Searching for Definitions in Reports............................................................................................. 48
Navigating the Differences in a Compare Report..........................................................................49
Printing the Report......................................................................................................................... 50
Saving Reports as Text Files..........................................................................................................51

Working with Browser Reports............................................................................................................ 51
Understanding Browser Reports.................................................................................................... 51
Accessing and Sharing Browser Reports.......................................................................................52
Selecting a Project..........................................................................................................................53
Searching for Definitions............................................................................................................... 53
Viewing Report Details.................................................................................................................. 54
Viewing Status Summary............................................................................................................... 54
Viewing Compare Results by Definition Type.............................................................................. 55

Working With PrintProject Reports......................................................................................................56
Accessing the PrintProject Report................................................................................................. 58

Working with Composite Reports........................................................................................................ 58
Understanding Composite Reports.................................................................................................58
Generating Composite Reports...................................................................................................... 59
Working With Composite Report Output...................................................................................... 60
Example: Creating a Composite Report........................................................................................ 61

Working with Definition Status............................................................................................................63
Determining Definition Status........................................................................................................63
Comparing Source Status to Target Status.................................................................................... 64

Comparing and Merging Page Definitions...........................................................................................66
Comparing and Merging Page Definitions.................................................................................... 67
Working with the Page Compare Results...................................................................................... 67

Chapter 4: Working with Text Definitions and Text Files During Upgrades...................................... 73
Understanding Comparing Text Definitions and Text Files.................................................................73
Comparing and Merging Text Definitions and Files............................................................................73

Running the Merge Process for Text Definitions.......................................................................... 74
Running the Merge Process for External Text Files......................................................................74
Using the Merge Interface..............................................................................................................75

Working with Merge Properties............................................................................................................78
Accessing the Merge Properties Dialog Box.................................................................................78
Viewing and Setting Merge Properties.......................................................................................... 78

Running a Project PeopleCode Diff/Merge..........................................................................................81
Understanding the Project PeopleCode Diff/Merge.......................................................................81
Running a Project PeopleCode Diff/Merge................................................................................... 81
Using the Project PeopleCode Diff/Merge.................................................................................... 81
Filtering the Project PeopleCode Diff List.................................................................................... 82

Chapter 5: Copying Projects and Definitions.........................................................................................83
Reviewing Upgrade Settings................................................................................................................ 83

Selecting View Options..................................................................................................................83
Selecting Custom View Settings.................................................................................................... 83
Overriding Upgrade Defaults......................................................................................................... 84
Recording Upgrade Settings...........................................................................................................86

Copying Projects................................................................................................................................... 86
Understanding Project Copy Options............................................................................................ 87

iv  Copyright © 1988, 2025, Oracle and/or its affiliates.



Contents

Copying Projects to a Target Database..........................................................................................87
Copying a Project to Multiple Databases...................................................................................... 88
Copying a Project to a File............................................................................................................88
Copying a Project From a File...................................................................................................... 89

Stamping the Target Database.............................................................................................................. 93
Reusing Projects....................................................................................................................................93

Chapter 6: Working With Alter Analyzer.............................................................................................. 97
Understanding the Alter Analyzer........................................................................................................97
Loading Metadata..................................................................................................................................98
Running the Alter Analyzer..................................................................................................................99
Working with the Alter Repository...................................................................................................... 99

Understanding the Alter Repository.............................................................................................. 99
PS_PTUALTRECDATA Table.......................................................................................................99
PS_PTUALTRECFLDDAT Table................................................................................................ 100
PS_PTUALTRECFLDDEF Table................................................................................................ 103
Querying The Alter Repository....................................................................................................104

Chapter 7: Using Command Line Parameters..................................................................................... 107
Understanding PeopleSoft Application Designer Command Line Parameters.................................. 107

Command Line Option Sequence................................................................................................ 107
Command Line Parameters.................................................................................................................108

Required and Optional Parameters Matrix.................................................................................. 108
Available Parameters for the Various Functions..........................................................................112

Starting the PeopleSoft Application Designer Command Line Interface...........................................125
Building Projects Using the Command Line......................................................................................126
Creating Projects Using the Command Line......................................................................................127
Creating Customization Project Using the Command Line............................................................... 128
Copying Definitions Using the Command Line.................................................................................130
Merging Projects Using the Command Line......................................................................................132
Comparing Definitions for Upgrade Using the Command Line........................................................ 132
Compiling and Saving Directive PeopleCode....................................................................................134

Chapter 8: Getting Started with Application Data Sets......................................................................135
Application Data Set Overview..........................................................................................................135

Application Data Sets (ADS).......................................................................................................135
Data Migration Workbench.......................................................................................................... 137
Main Components.........................................................................................................................137
Application Data Set Integration with PeopleSoft Update Manager........................................... 138

Deployment of Application Data Using Application Data Sets.........................................................138
Application Data Set Implementation................................................................................................ 140
Application Data Set Limitations and Recommendations..................................................................141

Chapter 9: Using Application Data Set Designer.................................................................................143
Creating and Editing Data Set Definition.......................................................................................... 143

Searching For and Creating Data Sets.........................................................................................143
Defining the Data Set...................................................................................................................144
Cloning a Data Set Definition......................................................................................................150

Defining Relations.............................................................................................................................. 150
Defining Groups..................................................................................................................................155
Defining Data Set Properties.............................................................................................................. 156
Defining Extension..............................................................................................................................158

CustomValidate............................................................................................................................. 160
DoTransform................................................................................................................................160
CustomTransform......................................................................................................................... 161

Copyright © 1988, 2025, Oracle and/or its affiliates. v



Contents

CustomMerge................................................................................................................................162
Flow for the To File Process........................................................................................................162
Flow for the From File Processes................................................................................................162

Chapter 10: Understanding ADS Projects............................................................................................ 165
Understanding ADS Projects.............................................................................................................. 165
Searching for, Adding and Deleting Projects.....................................................................................165
Defining ADS Project.........................................................................................................................167
Defining Data Set Content..................................................................................................................170
Inserting Data Content........................................................................................................................ 171

Using Operators to Build the WHERE Clause............................................................................174
Adding Data Set Instances from Object Designer Pages................................................................... 177

Chapter 11: Copying and Comparing ADS Projects........................................................................... 179
Copy Compare Overview................................................................................................................... 179

Copy to File..................................................................................................................................179
Compare........................................................................................................................................179
Using Compare Viewer................................................................................................................ 181
Copy from File............................................................................................................................. 181

Managing ADS Project File Locations.............................................................................................. 181
Copying Project to File.......................................................................................................................182
Loading Project from File.................................................................................................................. 184

Defining the Data Set Definition on the Target Database........................................................... 184
Loading Project on Target Database............................................................................................ 184

Comparing ADS Projects....................................................................................................................185
Tracked ADS Definitions.............................................................................................................185
Comparing From File................................................................................................................... 185
Compare Options..........................................................................................................................187
Removing Project Compare Sessions.......................................................................................... 190

Viewing Compare Reports..................................................................................................................191
Viewing Data Set Content............................................................................................................194
Understanding Status....................................................................................................................196
Understanding Copy Actions....................................................................................................... 196
Understanding Upgrade Action....................................................................................................197
Compare Report Details............................................................................................................... 198

Using ADS-MO Unified Compare Review........................................................................................202
Viewing ADS-MO Unified Compare Review............................................................................. 203
Viewing the Managed Objects Content....................................................................................... 204
Viewing Data Set Content............................................................................................................207

Viewing Validation Reports................................................................................................................ 208
Submitting for Copy........................................................................................................................... 210

Chapter 12: Validating Data Sets...........................................................................................................213
Understanding Data Set Validation.....................................................................................................213
Checking Integrity...............................................................................................................................215
Validating From File........................................................................................................................... 216

Chapter 13: Running ADS Summary Report.......................................................................................219
Running ADS Summary Report.........................................................................................................219

Data Set Summary Report Page.................................................................................................. 219
Chapter 14: Working With ADS Administrator Reports................................................................... 225

Understanding ADS Administrator Reports.......................................................................................225
Security Reports........................................................................................................................... 225
Metadata Reports..........................................................................................................................226

Running ADS Administrator Reports.................................................................................................226

vi  Copyright © 1988, 2025, Oracle and/or its affiliates.



Contents

Administrator Reports Search Page............................................................................................. 227
Report Definition Page.................................................................................................................228

Chapter 15: Implementing Data Set Security.......................................................................................229
Understanding Data Set Security........................................................................................................229
Assigning Data Set Permissions to Users.......................................................................................... 230

Setting ADS Project File Permissions for UNIX Users.............................................................. 231
Setting Data Migration Permissions................................................................................................... 232

Defining Access Group Permissions............................................................................................232
Defining Copy Compare Report Permission............................................................................... 234
Setting Upgrade Permissions....................................................................................................... 236
Setting PeopleTools Data Access.................................................................................................237

Encrypting Data Set Project Files...................................................................................................... 239
Setting Up Approval Framework for Data Migration........................................................................240

Assigning Data Migration Roles..................................................................................................240
Defining Workflow for User Profile............................................................................................ 240
Creating and Maintaining User List Definition........................................................................... 241
Setting up the Approval Process for Data Migration.................................................................. 241

Scheduling and Approving Copy from File....................................................................................... 244
Submitting for Copy using Approval Framework....................................................................... 244
Approving a Copy Request..........................................................................................................245

Chapter 16: Running PeopleTools Configuration Reports..................................................................249
Understanding PeopleTools Configuration Reports........................................................................... 249
Generating SQR Reports.................................................................................................................... 250

Generating SQR Reports from Process Scheduler.......................................................................250
Generating SQR Reports from the Isolated Customization Reports Page................................... 252

Chapter 17: Using PeopleSoft Data Mover...........................................................................................255
Understanding PeopleSoft Data Mover.............................................................................................. 255

PeopleSoft Data Mover Overview............................................................................................... 255
PeopleSoft Data Mover Environment.......................................................................................... 255
PeopleSoft Data Mover Operating Modes...................................................................................256

Understanding Data Mover Scripts.................................................................................................... 256
Data Mover Script Commands.....................................................................................................256
Supported SQL Commands..........................................................................................................258
Data Mover Commands Compared to SQL Commands............................................................. 260
PeopleSoft Data Mover COMMIT Statements............................................................................261

Using the Development Environment................................................................................................ 262
Signing In to the Development Environment.............................................................................. 262
Navigating the Data Mover Window...........................................................................................262

Creating and Running PeopleSoft Data Mover Scripts......................................................................263
Understanding Command Types.................................................................................................. 263
Understanding Syntax Rules........................................................................................................ 263
Creating and Editing Scripts........................................................................................................ 265
Preparing to Run Export Scripts.................................................................................................. 266
Running Scripts............................................................................................................................ 267

Using the Database Setup Utility....................................................................................................... 268
Accessing the Database Setup Utility..........................................................................................268
Working with the Database Setup Utility.................................................................................... 268
Checking the Generated Script.................................................................................................... 271

Using the PeopleSoft Data Mover Command-Line Interface............................................................ 271
Understanding the PeopleSoft Data Mover Command-Line Interface........................................ 271
Setting Up UNIX to Run PeopleSoft Data Mover...................................................................... 272

Copyright © 1988, 2025, Oracle and/or its affiliates. vii



Contents

Setting Up Tracing....................................................................................................................... 273
Running Data Mover Scripts from the Command Line.............................................................. 274

Using PeopleSoft Data Mover Commands.........................................................................................277
CHANGE_ACCESS_PASSWORD............................................................................................. 278
CREATE_SEQUENCE.................................................................................................................278
CREATE_TEMP_TABLE............................................................................................................ 279
CREATE_TRIGGER.................................................................................................................... 279
ENCRYPT_PASSWORD............................................................................................................. 279
EXPORT....................................................................................................................................... 280
IMPORT........................................................................................................................................281
REM, REMARK, and – –............................................................................................................283
RENAME......................................................................................................................................283
REPLACE_ALL........................................................................................................................... 285
REPLACE_DATA........................................................................................................................ 286
REPLACE_VIEW........................................................................................................................ 286
RUN.............................................................................................................................................. 287
SET............................................................................................................................................... 287
SET BASE_LANGUAGE............................................................................................................288
SET IGNORE_IMPORT_ERRORS.............................................................................................288
SET IGNORE_SPLCHARS.........................................................................................................289
SET COMMIT..............................................................................................................................289
SWAP_BASE_LANGUAGE....................................................................................................... 290

Using PeopleSoft Data Mover Command Modifiers......................................................................... 291
AS................................................................................................................................................. 291
IGNORE_DUPS........................................................................................................................... 292
UPDATE_DUPS........................................................................................................................... 293
WHERE........................................................................................................................................ 293

Using SET Parameters........................................................................................................................ 294
COMMIT...................................................................................................................................... 294
CREATE_INDEX_BEFORE_DATA........................................................................................... 294
DBSPACE..................................................................................................................................... 295
ENABLE_DB2UTS......................................................................................................................296
DDL.............................................................................................................................................. 296
EXECUTE_SQL...........................................................................................................................297
EXTRACT.................................................................................................................................... 297
IGNORE_DUPS........................................................................................................................... 298
INPUT...........................................................................................................................................298
INSERT_DATA_ONCE................................................................................................................299
LOG.............................................................................................................................................. 299
NO DATA..................................................................................................................................... 300
NO INDEX...................................................................................................................................300
NO RECORD............................................................................................................................... 300
NO SPACE................................................................................................................................... 301
NO TRACE.................................................................................................................................. 301
NO VIEW.....................................................................................................................................302
OUTPUT.......................................................................................................................................302
OUTPUTDb2DBDDL.................................................................................................................. 302
OUTPUTDb2UTSDDL................................................................................................................ 303
SET Db2DBDDL......................................................................................................................... 303
SET Db2UTSDDL....................................................................................................................... 304
SIZING SET................................................................................................................................. 304

viii  Copyright © 1988, 2025, Oracle and/or its affiliates.



Contents

SPACE...........................................................................................................................................305
START.......................................................................................................................................... 305
STATISTICS................................................................................................................................. 306
UNICODE.....................................................................................................................................306
VERSION..................................................................................................................................... 307

Using Script Examples........................................................................................................................307
Exporting Databases..................................................................................................................... 307
Building Databases....................................................................................................................... 307
Recreating All Views................................................................................................................... 308
Importing with REPLACE_ALL with a Commit Level..............................................................308
Combining SQL Commands and IMPORT................................................................................. 308

Copyright © 1988, 2025, Oracle and/or its affiliates. ix



Contents

x  Copyright © 1988, 2025, Oracle and/or its affiliates.



Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft
applications and PeopleTools. The help provides standard navigation and full-text searching, as well as
context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help
You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft
Online Help is updated on a regular schedule, ensuring that you have access to the most current
documentation. This reduces the need to view separate documentation posts for application maintenance
on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center,
see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed PeopleSoft Online Help
If you’re setting up an on-premises PeopleSoft environment, and your organization has firewall
restrictions that prevent you from using the hosted PeopleSoft Online Help, you can install the online help
locally. Installable PeopleSoft Online Help is made available with selected PeopleSoft Update Images and
with PeopleTools releases for on-premises installations, through the Oracle Software Delivery Cloud.

Your installation documentation includes a chapter with instructions for how to install the online help
for your business environment, and the documentation zip file may contain a README.txt file with
additional installation instructions. See PeopleSoft 9.2 Application Installation for your database platform,
“Installing PeopleSoft Online Help.”

To configure the context-sensitive help for your PeopleSoft applications to use a locally installed online
help website, see Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files
You can access downloadable PDF versions of the help content in the traditional PeopleBook format on
the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft
Online Help, but it has a different structure and it does not include the interactive navigation features that
are available in the online help.

Common Help Documentation
Common help documentation contains information that applies to multiple applications. The two main
types of common help are:

• Application Fundamentals
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• Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential
information about the setup and design of your system. This information applies to many or all
applications in the PeopleSoft product family. Whether you are implementing a single application, some
combination of applications within the product family, or the entire product family, you should be familiar
with the contents of the appropriate application fundamentals help. They provide the starting points for
fundamental implementation tasks.

In addition, the PeopleTools: Applications User's Guide introduces you to the various elements of the
PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components,
and pages to perform basic functions as you navigate through the system. While your application or
implementation may differ, the topics in this user’s guide provide general information about using
PeopleSoft applications.

Field and Control Definitions
PeopleSoft documentation includes definitions for most fields and controls that appear on application
pages. These definitions describe how to use a field or control, where populated values come from, the
effects of selecting certain values, and so on. If a field or control is not defined, then it either requires
no additional explanation or is documented in a common elements section earlier in the documentation.
For example, the Date field rarely requires additional explanation and may not be defined in the
documentation for some pages.

Typographical Conventions
The following table describes the typographical conventions that are used in the online help.

Typographical Convention Description

Key+Key Indicates a key combination action. For example, a plus sign 
(+) between keys means that you must hold down the first key
while you press the second key. For Alt+W, hold down the Alt
key while you press the W key.

. . . (ellipses) Indicate that the preceding item or series can be repeated any
number of times in PeopleCode syntax.

{ } (curly braces) Indicate a choice between two options in PeopleCode syntax.
 Options are separated by a pipe ( | ).

[ ] (square brackets) Indicate optional items in PeopleCode syntax.

& (ampersand) When placed before a parameter in PeopleCode syntax,
 an ampersand indicates that the parameter is an already
instantiated object.

Ampersands also precede all PeopleCode variables.
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Typographical Convention Description

⇒ This continuation character has been inserted at the end of a
line of code that has been wrapped at the page margin. The
code should be viewed or entered as a single, continuous line
of code without the continuation character.

ISO Country and Currency Codes
PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and
currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency
identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a
country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The
Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and
also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages
where you maintain currency code and country information depends on which PeopleSoft applications
you are using. To access the pages for maintaining the Currency Code and Country tables, consult the
online help for your applications for more information.

Region and Industry Identifiers
Information that applies only to a specific region or industry is preceded by a standard identifier in
parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear
at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft
Online Help:

• Asia Pacific

• Europe

• Latin America

• North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following
industry identifiers may appear in the PeopleSoft Online Help:

• USF (U.S. Federal)
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• E&G (Education and Government)

Translations and Embedded Help
PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft
aligns with the other Oracle applications by focusing our translation efforts on embedded help. We
are not planning to translate our traditional online help and PeopleBooks documentation. Instead we
offer very direct translated help at crucial spots within our application through our embedded help
widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that
the software and embedded help translation footprint is identical—something we were never able to
accomplish in the past.

Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see
information on the following topics:

• Using the PeopleSoft Online Help.

• Managing hosted Online Help.

• Managing locally installed PeopleSoft Online Help.

PeopleTools Related Links

PeopleTools 8.62 Home Page

PeopleSoft Search and Insights Home Page

“PeopleTools Product/Feature PeopleBook Index” (Getting Started with PeopleTools)

PeopleSoft Online Help

PeopleSoft Information Portal

PeopleSoft Spotlight Series

PeopleSoft Training and Certification | Oracle University

My Oracle Support

Oracle Help Center

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com.

Please include the applications update image or PeopleTools release that you’re using.
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Follow Us

Icon Link

Watch PeopleSoft on YouTube

Follow @PeopleSoft_Info on X.

Read PeopleSoft Blogs

Connect with PeopleSoft on LinkedIn
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Chapter 1

Getting Started with Application Designer's
Lifecycle Management Features

PeopleSoft Application Designer Implementation

Before you can begin using PeopleSoft Application Designer, the following items must be in place.

Activity Description

Set up security. For developing and customizing PeopleSoft applications you
will need access to the definitions involved, such as fields,
 records, pages, and so on. Your administrator can provide
access by adjusting your definition security settings. There
are also general PeopleTools permissions for maintaining
and upgrading data that your administrator may need to
provide access to as well. These include Build and Data
Administration, Change Control, and Upgrade.

See “Setting PeopleTools Permissions” (Security
Administration)

See “Understanding Definition Security” (Security
Administration)

Set up workstations. PeopleSoft Application Designer is a windows-based program.
 To run PeopleSoft Application Designer, you need to have a
supported version of Windows with ample CPU and memory
resources, and you need to have the workstation configured
using PeopleSoft Configuration Manager so that there is
connectivity to the appropriate database and all required
environment variables are set.

See “Setting Up the PeopleTools Development Environment”
(System and Server Administration)

Other Sources of Information

This section provides information to consider before you begin to use PeopleSoft Application Designer.
In addition to implementation considerations presented in this section, take advantage of all PeopleSoft
sources of information, including the installation guides, release notes, PeopleBooks, and training courses.

Related Links
Getting Started with PeopleTools
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Change Assistant and Update Manager
Change Impact Analyzer
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Chapter 2

Upgrading with PeopleSoft Application
Designer

Understanding a PeopleSoft Upgrade

This section provides an overview of PeopleSoft upgrade.

PeopleSoft Application Designer Upgrade Features
PeopleSoft Application Designer streamlines the migration of database definitions—such as records,
pages, projects, and PeopleCode—from one PeopleSoft database to another. You can perform a complete
database upgrade or you can upgrade only the definitions included in a particular project. This topic
focuses mainly on project upgrades, and the PeopleSoft upgrade documentation focuses on complete
database upgrades, which are typically performed when upgrading from one version of a PeopleSoft
application to another.

While this topic does not discuss the specific procedures for an enterprise-wide upgrade for a specific
platform, there are basic steps to perform in PeopleSoft Application Designer regardless of the type of
upgrade, which include:

• Updating your PeopleSoft software.

• Identifying the source and target database. The source can be a file, a project, or an entire database.

• Comparing the source and target database to determine changed definitions.

• Copy any new or changed definitions into your database and adjust all your system components—
such as application data, SQL tables, indexes, views, and so on—accordingly.

Updating the PeopleSoft software is covered in the installation documentation for PeopleTools and
PeopleSoft applications. This topic mainly focuses on comparing your source with your target and
copying the definitions from the source to the target.

When comparing your source and target you can view results in the upgrade workspace, in reports, in
your browser, and side-by-side (for pages and text definitions, such as PeopleCode). When copying
definitions into the target database you can use the PeopleSoft Application Designer interface or a
command line interface. For text definitions you can use the merge feature.

Note: The complexity of these tasks performed depends on the type of upgrade you are performing.
For example, if you are copying brand new definitions from a small project into a source database this
is a relatively uncomplicated task, as comparisons are not required and you can immediately begin a
copy. However, if you are upgrading an entire database or a large project containing numerous changed
definitions it is likely that the compare, merge, or copy process will require more analysis.
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Note: To use the PeopleSoft Application Designer upgrade features, you must have full access to projects
and upgrade access in the target database. To run a compare you only need read-only upgrade access.

Related Links
“Setting PeopleTools Permissions” (Security Administration)
Security Administration

Definition Types That You Can Upgrade
PeopleTools managed objects can be compared and can be copied to a file or to database, with the
exception of those in the following list.

These definitions can be copied to database, but cannot be compared and cannot be copied to file:

• Dimensions

• Cube definitions

• Cube instance definitions

Note: Certain definition types that are specified as compare and copy or copy only (for example,
Cube Dimensions) do not appear on the Development tab because you cannot edit them in PeopleSoft
Application Designer.

Note: PeopleSoft delivered definition types (such as pages, Application Engine programs, iScript
PeopleCode, and so on) cannot be copied across product lines. For example, you cannot copy a definition
from PeopleSoft Human Capital Management to PeopleSoft Customer Relationship Management.
License codes for these definitions are specific to the product line in which the definition is delivered. If
a PeopleSoft delivered definition is copied to a different product line, it may be inaccessible on the target
database.

Using the Upgrade Workspace

This section provides an overview of using the upgrade workspace.

Switching to the Upgrade View
When you perform an upgrade with PeopleSoft Application Designer, select the Upgrade tab at the
bottom of the project workspace to switch to the upgrade view.
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The upgrade view of the project workspace shows all of the definition types in the project that are
available for upgrade—not only those that PeopleSoft Application Designer can modify, as in the
development view. The upgrade definition window displays the definitions in the project and their
upgrade settings. One definition type appears at a time.

Displayed here are the upgrade attributes for all record definitions in the selected project.

Viewing Upgrade Attributes by Definition Type
To view the upgrade attributes by definition type in a project:

1. Open a project.

2. Select the Upgrade tab at the bottom of the project workspace.

3. Double-click a folder to open the upgrade definition window.

With the exception of PeopleCode, the folders in the upgrade view are not expandable. The upgrade
definition window contains a grid with definitions in the project that are of the selected type. For
example, if you double-click the Records folder in the upgrade view, the upgrade definition window
displays the records in the project.

You can view only one upgrade definition window—and one definition type—at a time. When you
double-click another definition type in the upgrade view, the upgrade definition window is refreshed
with the new definitions of that type.

Note: You can filter which definitions are displayed in this window. By default, no filtering is applied.
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Working with Upgrade Definition Columns
The columns in the upgrade definition window display various information about each definition.

Field or Control Description

Key Displays the name of the definition, plus any other key values.
 The number and titles of the key columns vary, depending on
the definition type.

Source Displays the definition status in the source (current) database.

Target Displays the definition target database status.

Action Displays the action that is performed if the definition is copied
into the target database.

Upgrade Select to upgrade the definition during a copy.

Done Is selected when the definition has been copied. You can't
select Done check boxes yourself—PeopleSoft Application
Designer does this after a copy—but you can clear them. Only
definitions that have Upgrade selected and Done cleared are
copied during an upgrade.

Execute Only applies to file references and Application Engine
definitions. Allows file references and Application Engine
definitions to be executed when applying a change package.

To enlarge the window enough so that you can scroll through the upgrade columns:

• Maximize the upgrade definition window.

• Maximize PeopleSoft Application Designer.

• Hide the project workspace.

To display all of the grid columns at one time when the preceding options don't enable you to see every
column, use the zooming commands in the View menu. With each Zoom Out command, the grid size is
reduced. To restore the normal view, select 100%.

You can also resize individual columns by dragging the column border to the appropriate size.

Using Upgrade Menu Actions
To access the pop-up upgrade menu, right-click anywhere in the grid in the upgrade definition window.

This table describes the upgrade menu actions and the actions they perform:
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Menu Item Action

View Definition Opens the definition. This is enabled for definitions created in
Application Designer.

View PeopleCode Opens the PeopleCode Editor. This is enabled for PeopleCode
definition types.

Find Definition References Finds all references to the selected definition.

Merge Definition Enables you to compare and merge text definitions between
two sources, either a file or another database. Text definitions
are PeopleCode, SQL, XSLT, and HTML.

Diff / Merge Page Enables you to compare (side-by-side) page definitions
between two sources, either a file or another database, and
merge the definitions.

Filtering Opens a cascading menu with filtering options that you can
apply to the upgrade grid. These same options are also in the
View menu.

Refresh View Updates the information in the upgrade definition window.

Set Action Enables you to select and tag definitions for copying and
deleting.

Set Action for Project Enables you to select and tag all definitions in a project for
copy or delete.

Tag for Upgrade Enables you to tag a group of definitions for upgrade.

Untag for Upgrade Enables you to remove the tag on a group of definitions for
upgrade.

Reset Done Flag Enables you to reset Done check boxes for a group of
definitions.

Reset Project Done Flags Enables you to reset all Done check boxes.

Insert Definitions into Project Opens the Insert Definitions into Project dialog box.

Remove from Project Removes the selected definitions from the current project. You
can also use the Delete key.

Project Properties Opens the Project Properties dialog box, in which you define
properties for the project, like description.
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Setting Upgrade Options
This section discusses how to:

• Access the upgrade options.

• Set general options.

• Set compare options.

• Set report options.

• Set report filter options.

• Set copy options.

Accessing the Upgrade Options

To access the upgrade options:

1. Select Tools >  Compare and Report.

2. Select To Database.

3. Sign in to an upgrade target database.

This example illustrates the fields and controls on the Compare and Report page.

By default the Update Project Item Status and Child Definitions is selected.

4. On the Compare and Report dialog box, click Options, and select the appropriate upgrade option tab.
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Setting General Options

This example illustrates the fields and controls on the Upgrade Options dialog box: General Options tab.
You can find definitions for the fields and controls later on this page.

Use the Upgrade Options dialog box to set general options for the Compare or Copy process.

Field or Control Description

Commit Limit Set the commit limit.

Start with the default of 50. If the Copy process seems slow
and there is sufficient log file space, try increasing the commit
limit. You can modify the initial project default commit limit
on the PeopleTools Options page.

Very large commit limits, however, can cause more work if
something goes wrong during the copy. For example, if the
commit limit is set to 1,000 and the Copy process stalls on the
999th definition, none of the previous definitions are copied.
 The Copy process must be performed again.
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Field or Control Description

Audit Flags on Records Select one:

• Keep Target Audit Flags: Select to preserve all of the
enabled target flags. This is the default. Audit flags that
are enabled in the source are also retained. Differences
between the source and target audit flags are not shown
on the compare report.

• Set Target Audit Flags from Source: Select to copy
audit flag settings from the source to the target database.

DDL on Records and Indexes Select one:

• Keep Target DDL: Select to preserve the target DDLs.
 This is the default. Differences between the source and
target DDL are not shown on the compare report.

• Take DDL from Source: Select to copy the DDL from
the source to the target database.

Note: For Oracle customers using partitioning on records
and indexes, the partitioning is not migrated with the record
or index. To migrate the partitioning use Data Migration
Workbench and create a project containing the data set
definition PTTBLIDXPART. See “Maintaining Partition
Definitions” (Data Management)and Defining ADS Project.

Materialized View Select one:

• Keep Target Properties: Select to retain the target
properties of materialized view. This is the default.

• Set Properties from Source: Select to copy the
materialized view properties like REFRESH_MODE,
 REFRESH_METHOD and BUILD_MODE from the
source to the target database.

Portal Structures Permission List Select one:

• Keep Target References: Select to preserve the target
portal structures permission list references. This is the
default.

• Set References from Source: Select to copy the portal
structures permission list references from the source to the
target database.
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Field or Control Description

Chartfield Options Set the Display Size Page Property:

• Keep Target Display Size: Does not copy any display
changes to a ChartField on the source database (the target
values are saved). If this is set for a Compare process,
 no differences between the source and target in the
named fields are displayed. If the only differences on the
page are the ChartField display properties, then the page
compares as the same for both.

• Set Display Size from Source: Copies the position, as
well as the size and type attributes, from the source to the
target database.

Set the Database Field Format:

• Keep Target Field Format: Does not copy any changes
to the field format values for a database field that is a
ChartField on the source database, and preserves the
target field format values. If this is set for a Compare
process, any changes to the ChartField field format
attributes are not displayed. If these attributes are the only
changes for a field, then the definition compares as the
same for both.

• Set Field Format from Source: Copies the ChartField
field format attributes from the source to the target
database.
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Field or Control Description

Permission List, Roles, Menus If Roles, Menus or Permission Lists are renamed or cloned,
 this information is tracked in tables that store the original
name. This information is used by PUM Security Automation
when change packages are created to apply updates.

Select one:

• Keep Target Origin

Select to preserve the tracking tables for these definitions.

Note: This option is primarily used for PUM updates.

• Set Origin from Source

Select to overwrite the tracking tables for these definitions
on the target. This is the default.

Note: This option is primarily used for project copies
executed in Application Designer, such as development to
test.

Note: This option applies to Upgrade Copy operation and is
ignored for Upgrade Compare operation.
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Setting Compare Options

Access the Upgrade Options dialog box and select the Compare Options tab to complete setting compare
options. You can find definitions for the fields and controls later on this page.

Field or Control Description

Compare Type Select Project to compare only the definitions of the specified
definition type in the current project. The contents of the
project do not change.

Select Database to compare all definitions of the specified
definition type. If you select Database, the contents of the
current project are deleted and replaced with definitions that
are found during the comparison.

Target Orientation Determines how the Upgrade check boxes in the upgrade
definition window are set for definitions that were last
modified by the customer in one database and last modified by
PeopleSoft in the other database.
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Field or Control Description

Comparison Select Release to compare databases by the highest release
that the two databases have in common. Use the drop-down
list box to select from lower common releases. The Compare
process labels definitions as Changed or Custom/Changed if
they have been changed since the date and time stamp for that
release level. This is the default.

Select Date to have the Compare process label definitions as
Changed or Custom/Changed if they have been modified since
the date that you specify.

Use LastUpdDttm (last update date and time) and
LastUpdOprid (last user to update definition) to improve
the performance of the compare process for larger compare
projects. If these options are selected, Application Designer
uses only these values to assess differences between
PeopleCode definitions. If it is determined that the
LastUpdDttm and/or LastUpdOprid are the same, Application
Designer assumes that the rest of the attributes are the same
and moves on to the next definition in the project. If it is
determined that the PeopleCode definitions are different,
 Application Designer proceeds to compare all attributes of the
definition as normal.

Note: LastUpdDttm and LastUpdOprid apply only to
PeopleCode definitions.

Compare Languages Select the languages of definitions that you want to compare,
 and select COMMON, which specifies basic definition
characteristics and parameters in the architecture that are not
language-sensitive. Language options specify label-oriented
characteristics of a definition, such as page names, labels, and
messages. If you do not select COMMON, basic definition
characteristics are omitted.

If you need specific languages and basic definition
characteristics, also select COMMON. However, to compare
only language attributes of a definition, you do not need
COMMON.

Clicking Select All is the recommended default.

Press the Ctrl key and your mouse to clear unwanted
languages.
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Field or Control Description

Checkboxes for Compare by LastUpdDttm and Compare
by LastUpdOprid

Since Compare by LastUpdDttm and Compare by
LastUpdOprid are a customization bypass, the process will
skip the comparison if LastUpdOprid = PPLSOFT or if the
LastUpdDttm has the same value on both the source and target
databases.

Setting Report Options

The following screenshot is an example showing how to set values in report options. Access the Upgrade
Options dialog box and select the Report Options tab. You can find definitions for the fields and controls
later on this page.
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Field or Control Description

Report Output • Directory:  Displays the compare report output directory.
 To change the output directory path, select Tools >
Options from the PeopleSoft Application Designer
toolbar, and select the General tab.

• Font and Size: Displays the font type and size that will
appear in the compare report output. Click Font to select
a different font or to change the font size.

• Generate Traditional Reports: Select this option to
create traditional workspace (PRN) reports that are
displayed in Application Designer.

See Working With Workspace Reports

• Generate Browser Reports: Select to generate HTML
reports that you can view in a browser in addition to
the reports that appear in the Application Designer
workspace.

See Working with Browser Reports.

• Password Protected ?: Select this option to set password
while generating browser compare report. This ensures
that only valid users access the report.

• Generate Output to Tables: Select this option to write
the compare output to database tables. This enables
you to keep a historical record of your compares in
your database, and it also provides you the flexibility
of being able to design custom queries for analyzing
specific definitions, attributes, and so on. The following
PeopleTools tables store compare data:

• PSCOMPSESSION: Contains high-level information
related to the compare, such as project name, target
database name, source database name, session type,
 and so on.

• PSCOMPOBJDIFF: Contains data related to the
individual definitions that are being compared,
 including definition type, definition name, source
status, target status, and so on, as well as specific
data for the individual attributes compared.

• Include values that are same: This checkbox only applies
to the compare results that are written to tables (generate
output to tables option).
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Field or Control Description

If selected that definitions with same-same will be written
to the tables. Any values that are same-same for the
source and target are not displayed on compare reports.

• Generate PrintProject Reports: Select this option to
create PrintProject style compare report definition.

See Working With PrintProject Reports

• Generate Composite Reports: Select to generate a
composite report, which is a subset of information
showing only the definitions customized at your site that
were also modified in the most recent PeopleSoft release.

• Old Release Report Output Directory: Enter the
directory containing the compare reports run on the
database for your previous PeopleSoft installation:
the database from which you are upgrading.

• Old Release Source Database Name: Enter the
source database name you specified when running
the compare reports on your previous PeopleSoft
installation. This enables the system to identify the
appropriate database definitions listed within the
compare reports.

See Working with Composite Reports.

Note: If no output options are selected, traditional reports will
be produced. You can select multiple output options.

PeopleCode Report Specify the PeopleCode report options.

For PeopleCode compare reports, specify whether to show the
entire program on the report (the default setting) or only the
code differences between the source and target. If you select
the latter, you can specify the number of code lines to show
above and below the difference for context. The values for the
number of lines to show are 0 to 99. A value of 0 shows only
the difference line. A value greater than 0 shows that many
lines above and below the difference line.

Note: The PeopleCode report options are global across
all projects. Changing settings for one project changes all
subsequent PeopleCode compares, regardless of project.
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Field or Control Description

Report Data Color Select the report data color.

Use the Browse button to display the standard color dialog
box. Choose a color that is not included in the drop-down list
box or create a custom color.

The custom color value appears as hex color code, for
example, #820041.

• Additions: Select a color for additional data values on the
source database. These are also source-only values. The
default value is dark green.

• Deletions: Select a color for data values that are deleted
from the source database. These are target-only values.
 The default value is red.

• Differences: Select a color for changed values, which are
both source and target values. The default value is blue.

The color selection is not applicable for Browser compare
report.

The color selection can be set through command line
parameters such as -ADDCLR, –DELCLR, and, -DIFCLR.
 For details, refer Command Line Parameters.
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Setting Report Filter Options

The following screenshot shows how to set up report filter options. Access the Upgrade Options dialog
box and select the Report Filter tab.

When you perform a comparison, the system generates a report for each definition type compared. These
reports provide detailed information about how each definition in the source differs from its counterpart in
the target.

Before performing a comparison, you can select the definition status combinations with which you
generate reports by using report filter options. For example, during an upgrade to a new PeopleSoft
release, you might decide that if a definition that was last changed in the target by PeopleSoft is found
in the source and it hasn’t changed since the last upgrade, you don’t need to see information about the
definition differences (because you intend to accept the new PeopleSoft version). In this case, you want to
filter the compare reports so that a report is not generated if:

• The source is any status.

• The target is unchanged.

Note: Filtering comparison reports does not affect which definitions are added to a project during a
database comparison, only which definitions are reported. Definitions that are defined differently in the
two databases are always added to the project.

Select the check boxes corresponding to the definition status combinations that you want to report.

Each row in the matrix corresponds to the definition status in the source database. Each column
corresponds to the definition status in the target.

The default settings for report filtering show conflicting configured definitions only.
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• To reset your selections to the default setting, click the Default button.

• To select all definition status combinations, click the Select All button.

• If you don't want to generate any reports, click the Deselect All button to clear all of the check boxes.

Setting Copy Options

This example illustrates the fields and controls on the Upgrade Options dialog box: Copy Options tab.
You can find definitions for the fields and controls later on this page.

Field or Control Description

Copy Languages Select a specific language for label-oriented characteristics of
a definition, such as page names, labels, and messages.

COMMON, specifies basic definition characteristics and
parameters in the architecture that are not language-sensitive.
 Select COMMON when you select English. Do not select
COMMON when you select a language other than English.

If you do not select COMMON, basic definition characteristics
are omitted.

Make sure that the enabled languages in the source and target
databases match. Otherwise, you might overwrite translations
in the target. Use the Ctrl key and your mouse to clear
unwanted languages.

When you save the project, the copy settings that you made are
saved and remain set unless you change them again.

This table lists translation scenario examples:
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Selection Reason

COMMON and English The source database does not include translations, but the
target database has translations that you do not want to
overwrite.

Languages (omit COMMON) You sent the database out for translations and want to avoid
copying inadvertent changes that were made by the translators
to the definitions.

COMMON (omit languages) You want to copy the source without translations to the target.

Preparing Projects for an Upgrade

This section provides an overview of preparing project for an upgrade.

Understanding Upgrade Projects
Before you can copy definitions from one database to another, you must insert them into a PeopleSoft
Application Designer project. If you have a custom application, identify which definitions must be copied
from the source into the target database. When you know which definitions you want to upgrade, specify
and insert the definitions into the project.

However, when you are unfamiliar with one of the databases, you might want to populate a project
by comparison—for example, when you upgrade to a new PeopleSoft application release. When you
populate a project by comparison, the system compares the source and target databases and automatically
populates the project with definitions that are defined differently in the two databases.

Populating Projects
To populate projects:

1. Select Insert >  Definitions into Project from the PeopleSoft Application Designer menu.

PeopleSoft Application Designer designates certain definition types as related to a parent or
controlling definition type. For example, a record's related definitions can include fields, indexes, and
subrecords. When you insert definitions into a project for upgrading, it can be important for these
related definitions to be included.

2. Select the definitions and click Insert.

3. Select Tools >  Options.

4. On the Project tab, review the settings in Related Definitions Options and reset.
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Searching for Definitions
To find a definition in the project select Edit >  Find from the menu. This opens the Find dialog box
where you can perform a search for a text string in an upgrade definition window.

Printing All Definitions in a Project
You can print a project definition for all of the definition types in the current project. This differs from the
Print menu item, which prints only the currently selected definition type that is open in the upgrade grid.
The data, however, is the same.

To print a project definition for all definitions in current project, select File >  Print Project from the
PeopleSoft Application Designer toolbar.

Obtaining Access for Upgrading
To use the PeopleSoft Application Designer upgrade features, you must have full access to projects and
upgrade access in the target database.

Also, lock all PeopleSoft Application Designer definitions in the source and target databases before
comparing and copying projects. To do this, you need supervisor-level access to Change Control (in the
Tools menu). If your Change Control administrator performs this action for you, the administrator's user
ID is the only one that is allowed to perform the copy while the target definitions are locked.

Viewing Upgrade Messages

This section provides an overview of viewing upgrade messages.

Understanding Upgrade Messages
During the compare and copy processes discussed in this section, if the system encounters any errors you
will be notified through system messages. These messages alert you to various areas that may need to be
corrected for a successful upgrade compare and copy.

Determining Whether Errors Were Encountered
Select the Upgrade tab in the output window to determine whether any errors were encountered during the
Compare or Copy process.
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This view displays upgrade messages pertaining to the definition type that was most recently displayed in
the upgrade definition window. In the preceding example, Access Groups was the last definition type that
was viewed in the window.

Viewing Messages
To view messages:

1. Open the project.

2. Select the Upgrade tab in the project workspace.

3. Double-click the folder of the definition type for which you want to view messages, or click the
project icon to view all messages.

Any upgrade messages for that definition type appear in the output window.

Printing Upgrade Messages
To print upgrade messages:

1. View the messages that you want to print.

2. Right-click the output window and select Print.

Clearing Messages
To clear messages:

1. View the messages that you want to clear.

2. Right-click the output window and select Clear.
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Comparing Source and Target Definitions

Understanding the Compare Process

PeopleSoft Application Designer enables you to compare the contents of the database to which you are
signed on (or project within) with the target database or an exported project file. It enables you to view the
status of each definition in each location so you can then decide which definitions to keep.

There are two ways to compare definitions:

• Compare all database definitions of a certain type, such as record definitions. After doing so, you
populate the upgrade project with only the definitions that are defined differently in the source than in
the target.

• Compare only the definitions in the current upgrade project to the equivalent definitions in the target
database or file.

When performing comparisons between source and target definitions, PeopleSoft Application Designer
enables you to:

• Generate workspace reports.

These reports appear in the PeopleSoft Application Designer workspace immediately after the
compare process completes.

• Generate browser reports.

These reports are written to HTML and XML files enabling you to open the report in a browser, share
the report with coworkers easily, and store report data in an industry-standard format.

• Generate Output to Tables.

Writes the compare reports to output tables.

• Generate PrintProject compare report

This report is written to the report directory in HTML using RTF format.

• Visually compare page definitions.

This feature enables you to view the source and target page definitions side-by-side with differences
clearly marked.

• Visually compare and merge text definitions.

This feature enables you to view the source and target PeopleCode, HTML, SQL, XSLT definitions
side-by-side with differences clearly marked. It also enables you to merge source PeopleCode with
target PeopleCode.
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Comparing All Definitions by Type
PeopleSoft Application Designer performs comparisons on one definition type at a time. For each
definition type that you select, the system removes any existing definitions of that type from the current
project and repopulates the project based on the comparison results. For this reason, be careful when
performing a database comparison on a predefined project.

For example, suppose that your project includes several record, page, and menu definitions and you
perform a database comparison on pages only. All of the page definitions that were originally in the
project are removed and replaced by any page definitions that were found in the Compare process.
However, the record and menu definitions in the project are not affected.

Performing a database comparison overwrites custom upgrade settings with the defaults for the specified
target orientation.

Comparing Definitions by Project
If you manually inserted definitions into the project and you want to see how those definitions differ from
the same definitions in another database, perform a project comparison. This method compares only the
definitions in the project and does not repopulate the project—except in record and field comparisons.
Upgrade settings are never modified when you perform a project comparison.

When records are compared—during a database or project comparison—differences that are found in
record fields are written into the project. For example, suppose that Record A in the source database
contains record fields 1, 2, 3, 4, and 5, and Record A in the target database contains fields 2, 4, 6, and 7.
Before the comparison, the project contains only Record A. After the comparison, the project contains
Record A and record fields 1, 3, 5, 6, and 7.

Similarly, when field definitions are compared, differences that are found in the field labels are inserted
into the project as new field definitions. For example, suppose that you are comparing the source with
the target, and both databases have the same field definitions. However, the field label for one of those
field definitions is different. The source field definition is labeled Employee ID, but in the target, it is
labeled Staff ID. The Compare process creates a new field definition that is labeled Staff ID. After the
comparison, the project contains both an Employee ID field and a Staff ID field.

Note: These are the only situations where a project comparison repopulates a project.

Synchronizing Databases When Comparing Record Definitions
The Upgrade Copy process synchronizes databases when performing an upgrade compare and copy for
record definitions. During the upgrade copy (CopyProp only) of a table, subrecord, or temporary table, the
system reorders the indexes (_, 0 through 9) to follow the source index order. The target order matches the
source order after the copy.

For example, suppose that the source record, Z, is a table with fields B, A, C, G, H and the target record,
Z, is a table with fields A, B, F, G, C, H where all of these conditions are true:

• F is a customization and a Key field.

• A and B are exactly the same except for field order, and both are keys.
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• C, G, H are exactly the same except for field order, and they are nonkey fields.

In this example, the upgrade compare produces project items for this record:

Record Name Field Name Source Target Action Upgrade

Z Not applicable 
(NA)

Changed UnChanged CopyProp Y

Z F Absent *Changed Delete N

* Unless the F record field is deleted, an upgrade copy and compare always shows this project item.

The result of an upgrade copy on this record changes record fields A, B, F, G, C, and H in the target
database to B, F, A, G, C, and H, without moving the nonkey fields. Another upgrade compare would
produce the same project items.

Likewise, during an upgrade copy of a view or dynamic view, the target order is reordered to match the
source when a record field project item is copied and the source order does not match the target order.

For example, suppose that the source record, Z, is a view with fields B, A, C, and the target record, Z, is a
view with fields A, B, F, C where all of these conditions are true:

• F is a customization.

• A and B are exactly the same except for field order.

In this example, the upgrade compare produces project items for these record fields:

Record Name Field Name Source Target Action Upgrade

Z A Changed UnChanged Copy Y

Z B Changed UnChanged Copy Y

Z C -- -- Copy Y

Z F Absent *Changed Delete N

* Unless record field F is deleted, an upgrade copy and compare always shows this project item.

The result of an upgrade copy changes A, B, F, C in the target database to B, F, A, C.

Another project compare would produce these project items:

Record Name Field Name Source Target Action Upgrade

Z A Changed UnChanged Copy Y
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Record Name Field Name Source Target Action Upgrade

Z C -- -- Copy Y

Z F Absent *Changed Delete N

* Unless F is deleted, an upgrade copy and compare always shows this project item.

Working With Compare Reports

This section discusses how to work with compare reports.

Running a Compare Report
To perform a comparison:

1. Save any changes to objects and close all windows before starting the Compare process.

This ensures that all generated reports are saved during the Compare process. Once the process is
complete, you can open the reports from a file and view them online.

2. Lock all of the PeopleSoft Application Designer definitions in the target database.

If you perform a full comparison, it might take several days for you to review all of the comparison
reports and set the upgrade settings accordingly. Locking the PeopleSoft Application Designer
definitions in the target database ensures that those definitions cannot be changed between the
comparison and the time that you perform the copy.

3. Turn off all tracing.

4. Select Tools >  Compare and Report, and select one of these options:

• From Database: The PeopleSoft Signon dialog box appears, prompting you to sign in to an
upgrade target database.

• To File: The Compare and Report From File : Select Project dialog appears for you to select the
project to compare.

5. On the Compare and Report dialog box, select the types of definitions to compare from the Definition
list.

6. Click Options to access the Upgrade Options dialog box.

Set all upgrade options including comparison report filters.

7. Select the appropriate Project Item Status / Insert Child Definitions option (if enabled it allows you to
preserve the original project).

8. Click Compare to perform the comparison.
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The system creates online reports for the definitions that you are comparing. Upgrade Compare
reports are saved to the location you specify in the Report Output Directory field in Tools >
Options on the General tab.

When the compare process completes, the PRT reports (if selected) are opened in Application Designer.
Links to reports are displayed in the Output window, as well as compare messages.

This example illustrates the fields and controls in Application Designer when the compare process
completes.

Note: You can also compare definitions using command line syntax.

See Comparing Definitions for Upgrade Using the Command Line.
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Working with the Compare and Report Dialog Box
This example illustrates the fields and controls on the Compare and Report From File dialog box. You can
find definitions for the fields and controls later on this page.

Note: Depending on whether you are comparing to a database or from a file, the dialog box name changes
accordingly.

Field or Control Description

Source Identifies the file or database name, the application release,
 and the service pack level of the source file or database.

Target Identifies the database name, the application release, and the
service pack level of the target database.
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Field or Control Description

Update Item Status/Child Definitions Deselect the Update Project Item and Child Definitions
option to preserve the status of the items in your upgrade
project and the child definitions when running a compare.
 Child definitions apply only to records and fields in which
fields are the child definitions of the record, and field labels
are the child definitions of record fields.

When running a compare report, the system compares the
definitions in an another database or file to the database to
which you are currently signed on. Based on the compare
results, the system updates the status of the project items in
your upgrade project in the definition window. For example,
 after running the compare, the system inserts the status of the
Source and Target (Absent, Changed, Unchanged, and so on),
 the Action to take (None, Copy, CopyProp, and so on).

Regarding child definitions with the case of records, if a record
is the same version in both places, the system removes the
fields. With the case of fields, if a field is the same version
in both places the system removes the field labels from the
upgrade project definition.

When a child item is found to be different between the two
places, then that item is inserted into the project so the child
item can then be copied as a unique item. When this option
is deselected, no child items are deleted nor inserted into the
project.

In some cases, as in when you want to compare the same
upgrade project to multiple sources, for example a demo
database, a production database, and a project file, you may
decide to deselect this option so that the source upgrade
project remains unchanged. When deselected, the project
item status and child definitions information only appears in
the generated compare report, not online in the PeopleSoft
Application Designer project definition.

Note: By default, this setting is selected, which should
accommodate most situations.

Note: This option applies only when performing project
compares, and is not applicable when performing a full
database compare (Compare Type is set to Database on the
Compare Options tab in the Upgrade Options dialog box).
 A full database compare should start with an empty upgrade
project and insert the different items into the upgrade project.

Note: When performing a compare from file, if the option is
turned off, the resulting project definition after the compare
will have the same status settings and project items as in the
file project definition. The compare reports will still reflect the
status settings and differences in any child items. When the
option is left on, the compare will change the project definition
based on the compare results, changing the status settings, and
inserting or deleting child items as needed.
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Field or Control Description

Definition Displays the current set of definitions being compared. The
system only compares the definitions in the list that are
highlighted.

Compare Executes the compare process.

Cancel Cancels the compare process.

Options Opens the Upgrade Options dialog box.

See Setting Upgrade Options.

Select All/Deselect All Selects all the definitions in the Definition list, or deselects all.

Working With Workspace Reports

PeopleSoft provides online comparison reports in PeopleSoft Application Designer. These reports appear
in the project workspace area after you run a compare report.

Accessing Reports
To access reports:

1. Select Tools >  Compare and Report from the PeopleSoft Application Designer toolbar.

2. Select one of these options:

• From Database

• To File

3. Sign in to the target database.

The system automatically displays a comparison report for each definition that you selected to be
copied. If the current definition type has a PeopleSoft Application Designer based editor, you can
double-click the definition name in the report to open it. If the comparison report is large, you can
search for specific definition names.

Searching for Definitions in Reports
For long compare reports, it is useful to perform a search to locate specific items. The Find in Report
feature searches by column. To search for an object in a comparison report highlight or place your cursor
in the column that you want to search and select Edit >  Find in Report.
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Navigating the Differences in a Compare Report
Use the different options to navigate through the differences and objects in a compare report. Especially
in a larger compare report, finding the differences becomes easier with these options.

To open an existing compare report, select File> Report from File> View Report.

This example illustrates the fields and controls in Application Designer 's toolbar that is used to navigate
through the compare report.

Field or Control Description

Displays the very first difference in the compare report.

Keyboard shortcut is Alt + Home.

Displays the previous difference in the compare report.

Keyboard shortcut is Alt + Up Arrow.

Displays the next difference in the compare report.

Keyboard shortcut is Alt + Down Arrow.

Displays the last difference in the compare report.

Keyboard shortcut is Alt + End.
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Field or Control Description

Navigates to the previous object.

On the status bar, the details of the object is displayed.

Also, the count of current focused object and count of total
number of objects are displayed. For example, object 5 of 39.

Keyboard shortcut is Shift + Up.

Navigates to the next object.

On the status bar the details of the object is displayed.

Also, the count of current focused object and count of total
number of objects are displayed. For example, object 6 of 39.

Keyboard shortcut is Shift + Down.

All the options listed above can be accessed through the View menu also.

Initially when the compare report is opened, the View First Difference, View Next Difference, and View
Last Difference options are enabled if any differences are present in the report.

If there are no differences in the report, none of the options will be enabled.

Based on the option you have selected, some of the options get disabled or enabled. For example, when
you are viewing the very first difference, the options View First Difference and View Previous Difference
get disabled.

Printing the Report

Printing the Comparison Report

This example illustrates the fields and controls on the Print preview comparison report.

To print the comparison report select File >  Print. The standard Print dialog box appears, enabling you
to select the printer, number of copies, and so on.

Printing a Comparison Report From a File

To print a comparison report from a file:
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1. To print a saved comparison report, select File >  Report from File.

2. Select Print Preview,  Print, or View Report.

These options require that you specify the report name and its location in a standard Open dialog box.
View Reportdisplays the specified report in the project workspace.

Moving Print Files

You might want to move the comparison report files to another directory or send them as email
attachments. Each comparison report file is saved as two files with the following format:

• Upg<number>DefinitionType.prt

• Upg<number>DefinitionType.idx

Both files (filename.prt and filename.idx) are required to view or print the report.

Saving Reports as Text Files
While the report is open in the workspace, you can save the workspace report as a text file. This enables
you to import the report results into applications of your choice, such as Microsoft Excel.

To save the workspace report as a text file:

1. Select File, Save Report As.

2. On the Save Report As dialog box insert a file name into the File Name edit box, and select a file type
from the Save as type drop-down list.

You can select Tab Delimited (.txt) or Comma Delimited (.csv).

3. Click Save.

Working with Browser Reports

This section provides an overview of working with browser reports.

Understanding Browser Reports
Browser reports enable you to view compare results using your browser.

You use the Compare Report Viewer to view and navigate within the results. The Compare Report Viewer
is a client-based HTML program through which you view the compare results, which are stored in XML.
Having the compare results in HTML and XML enables you to:

• Share compare results online with colleagues that do not have PeopleTools installed.

• Display results in custom formats using the data stored in the generated XML files.
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By setting the Generate Browser Reports option, when you run the Compare and Report process, the
system generates browser reports in addition to the workspace reports that automatically appear in the
PeopleSoft Application Designer workspace.

Accessing and Sharing Browser Reports
This section discusses how to:

• Access browser reports.

• Share browser reports.

Accessing Browser Reports

To access a browser report, double-click on the line in the output window containing "Browser Compare
Report Created.”

Enter password, if prompted. You can set password for browser compare reports in Report Options tab on
the Upgrade Options dialog box.

The following is a screen image of Accessing Browser Reports in PeopleSoft Compare Report Viewer.

The Viewer menu contains menu options related to navigating within the report. The Definition Types
menu enables you to dill down into the compare data for each definition type compared. The Definition
Types menu only contains the definitions compared.

Note that the PeopleSoft Compare Report Viewer (pscmpviewer.exe) is placed in the same folder location
where browser compare reports are saved.

The compare reports are saved to the location you specify in the Report Output Directory field in Tools >
Options on the General tab.
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Sharing Browser Reports

PeopleSoft Application Designer writes the browser reports to a subdirectory named after the project
name within the Report Output Directory specified on the General tab on the Options dialog. For
example, if the Report Output Directory is c:\psreports and the project name is “PROJECT,” then
the browser reports exist in c:\psreports\PROJECT. To view the compare results, double-click
CompareViewer.html and then select the desired project name.

For each type of definition you compare, there is a subdirectory containing XML files storing the compare
data for that definition type. For example, if you compared pages, the XML file containing compare data
for the page compare exists in c:\psreports\PROJECT\Pages. These files can be used as source data for
custom displays of the compare data. The PeopleSoft Compare Report Viewer uses these XML files along
with various HTML and XSL files to present your compare data.

To share the browser reports, PeopleSoft recommends:

• Copying the entire high-level report output directory (containing all subdirectories, HTML, and XSL
files) and copying it to a shared network drive.

• Compressing the entire directory and sending or posting individual copies as needed.

Selecting a Project
If you've run multiple compare reports on the same workstation, the PeopleSoft Compare Report Viewer
enables you to switch between them easily.

To select a project:

1. Click Select Project.

2. Select the appropriate project in the Project Name list.

Searching for Definitions
You can search for specific definitions within the compare data.

To search for definitions:

1. Select Search.

2. From the Definition Type list, specify the appropriate definition type, such as Records.

3. In the Search Text edit box, enter the name or part the name of the definition you want to view.

Note: You must enter at least three characters.

Note: The search returns the parent and child definitions. For example, if you enter 'RecordA' that
contains FieldB and FieldC, the search returns RecordA, RecordA.FieldB, and RecordA.FieldC. Also,
the search returns all definitions beginning with the search string entered.

4. Click Search.
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Viewing Report Details
Click Report Details to view information related to the databases and/or files compared.

Field or Control Description

Project Name The name of the project in the primary database.

PeopleTools Release The PeopleTools release number on which the primary
database runs.

Source Database/Source File The name of the primary database or file depending on which
compare option you selected.

Source Date The date the primary database was last updated.

Target Database The name of the secondary database.

Target Date The date the secondary database was last updated.

Compare By Displays the Comparison options selected on the Compare
Options dialog box either the release or date.

See Setting Upgrade Options.

Viewing Status Summary
To view the status summary, click Status Summary.

The status summary is a high-level view of the compare results showing the definitions compared and
the occurrence of differences. The summary table indicates whether the difference occurred because of
additions, modifications, or deletions that were the result of activity at your site, or whether the difference
occurred as a result of an addition or modification made by PeopleSoft. This summary can be useful for
managers and executives who are scoping and budgeting for an upgrade.

Each of the columns in the status summary indicate the number of items found to differ by definition type.
The columns represent the "Source" and "Target" status values set during the compare process. You can
click on any of the cell values to view the items filtered for each particular status result. You can also click
the value in the Definition Type column to view further status information.

The following table shows how each column in the status summary table equates to the status in the
source and target locations.

Field or Control Description

Customer Added Source: Absent

Target: *Changed or *Unchanged
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Field or Control Description

Customer Modified Source: Changed or Unchanged

Target: *Changed or *Unchanged

Customer Deleted Source: Absent

Target: Changed or Unchanged

PeopleSoft Added Source: Any

Target: Absent

PeopleSoft Modified Source: Changed or Unchanged

Target: Changed or Unchanged

Note: If you have generated composite reports, two tabs appear for the status summary: Compare Report
and Composite Report.

Note: The compare report values reflect the assumption that the source is the delivered PeopleSoft
demonstration database and the target is a customer's production copy of a database.

Related Links
Working with Definition Status

Viewing Compare Results by Definition Type
The Definition Types menu displays a menu item for each type of definition you compared. Click the link
for a particular definition type to view the comparison results for each definition of that type.

Each definition compared appears in a grid containing identification information relevant to that
definition type as well as the status of the definition in each location, the action, and the upgrade flag. The
identification columns are links enabling you to drill down into the compare results of that definition so
you can compare source and target values.

Field or Control Description

Expand All Expands all definitions in the grid to reveal all associated
attributes and child definitions.

Collapse All Collapses the expanded grid so that only the list of definitions
appear.

Show All Attributes Click to show all attributes within a definition in Expand All
mode after hiding an attribute or hiding all attributes.
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Field or Control Description

Hide this/all Attribute Hides the values of a specific attribute, or hides all attributes
of a specific type.

Next, Previous, First, Last Enables you to navigate between pages in a report containing
multiple pages.

Items Per Page Shows the number of items appearing on a single, current
page, and the total number of items in the project.

Note: If you have generated a composite report, two tabs appear: Compare Report and Composite Report.

See Working with Definition Status.

Working With PrintProject Reports

PrintProject produces an HTML report in RTF (rich text) format. The report is written directly to the
report directory. The report will be named <PROJECT_NAME>-PrtPrj.html for example if the project
name is EXAMPLE, the report name is EXAMPLE-PrtPrj.html. In Application Designer there will be a
link to the report in the output window.
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This example illustrates the fields and controls on the PrintProject report. You can find definitions for the
fields and controls later on this page.

The first section of the report contains some general information including the project name, project
description, and comments.

The second section of the report contains an index of all the objects included in the project. The objects in
this section that appear in red with a strikethrough are objects marked for deletion.

A details section is displayed for each object type in the projects, this section displays added, deleted or
changed code and/or attributes.

Copyright © 1988, 2025, Oracle and/or its affiliates. 57



Comparing Source and Target Definitions Chapter 3

Accessing the PrintProject Report
You can access the PrintProject report by either:

• In Application Designer when the compare is run double-click on the line in the output window
containing "PrintProject Compare Report Created.”

• Navigate to the report directory, select the Project folder and select <PROJECT_NAME>-PrtPrj.html.

Working with Composite Reports

This section provides an overview of working with composite reports.

Understanding Composite Reports
When performing a PeopleSoft application upgrade, part of the process involves identifying the
customizations made on your previous database and ensuring that all customizations are reflected in the
upgraded database. During the development of a new PeopleSoft application release, many changes are
made to the underlying metadata of the PeopleSoft application. If your application database is highly
customized, it's likely that you've customized at least some of the definitions that PeopleSoft has modified
in the new release. You identify your customizations and PeopleSoft modifications by running compare
reports.

For example, suppose you are performing an upgrade from PeopleSoft 8.1x applications to PeopleSoft
8.4x applications. To identify your customizations, you run compare reports between your current 8.1x
production database and the delivered 8.1x DEMO database. Then, to view your customizations and
the PeopleSoft modifications after your 8.1x database has been upgraded to the 8.4x version, you run
compare reports between your upgraded database and the delivered DEMO version of the 8.4x database.

Generating composite reports during this process greatly enhances your ability to identify the definitions
that both you have customized and that PeopleSoft has modified. Composite reports compare your
previous compare reports to the target database. The information in the previous compare reports is
considered a subset of the composite reports. That is, all data appearing in the previous compare reports
also appears on the composite reports, and those attributes that were updated by your organization and
PeopleSoft will be highlighted.

The report output displays the changed attributes of the definitions so that you can determine the
level and granularity of your customizations and how much effort will be involved in reapplying your
customizations during the upgrade. This information can assist the decision making process when
assessing the upgrade project scope.

Note: Composite reports are not a comprehensive record of all changes in the system. They only reflect
definitions that have been changed by PeopleSoft and by a customer implementation.

Note: Composite reports do not replace compare reports. Rather, a composite report provides an alternate
display of the information in compare reports, showing information appearing in both old release and new
release compare reports.
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Note: Composite reports are generated only for definitions that exist within both databases. For example,
Analytic Model definitions used for the PeopleSoft Analytic Calculation Engine do not exist in a
PeopleTools 8.1x application database. If comparing between a PeopleTools 8.1x application database and
a PeopleTools 8.47 application database, a composite report for Analytic Model definitions will not be
generated, as those definitions do not exist within a PeopleTools 8.1x database.

Generating Composite Reports
Before generating composite reports, consider the following:

• Compare report output (.PRT files and .IDX files) generated from the previous version must exist in
an accessible directory. All reports must exist in the same directory, and the report file names must not
have changed since they were originally generated.

• The previous compare reports must have been generated on applications running on at least
PeopleTools 8.1x. Compare reports generated by PeopleTools versions prior to 8.1x, such as
PeopleTools 7.x or 7.5x are not supported.

• Composite reports should only be generated when necessary, as in during the Enterprise upgrade
process. Generating composite reports can be time consuming and can cause performance
degradation.

• If you have selected Generate Browser Reports on the Report Options tab in the Upgrade Options
dialog box, the system also generates browser reports for the composite reports. To view the
composite reports in the browser, click the Composite Report tab in the Report Viewer.

• Any filtering options you've set on the Report Filter tab in the Upgrade Options dialog box also apply
to the composite reports.

To generate a composite report:

1. Make sure that the compare reports generated from your previous release exist and reside in an
accessible directory.

2. Launch Application Designer and sign on to the delivered PeopleSoft demonstration database.

3. Select Tools >  Compare and Report >  To Database.

4. On the Compare and Report dialog box, select Options.

5. On the Upgrade Options dialog box, select the Report Options tab.

6. Select the Generate Composite Reports check box, which activates the Old Release Report Output
Directory and Old Release Source Database Name edit boxes.

7. In the Old Release Report Output Directory edit box, enter the directory where the compare reports
generated from your previous database reside.

8. In the Old Release Source Database Name edit box, enter the name of your original, source database
(which is typically the PeopleSoft demonstration database from the previous release), and click OK.
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At this point, the process is identical to running a typical compare report. When the report completes,
Application Designer displays both reports: the regular compare report and the composite report for
each type of definition compared.

Note: The naming convention for composite reports is similar to compare reports, only the prefix for
composite report file names is "Cmp". For example, the naming convention for composite reports is
Cmp<number><definition>, as in Cmp05Pages.prt and Cmp05Pages.idx.

Working With Composite Report Output
Generate a composite report.

The following is a screenshot of Working with Composite Report sample output. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Old Release Previous release source data value. In a PeopleSoft upgrade,
 this is the source value from the DEMO database in the
previous release.

New Release New release source data value. In a PeopleSoft upgrade, this is
the source value from the DEMO database in the new release,
 which reflects the modification performed by PeopleSoft
development teams. If no modification has been made by
PeopleSoft for a particular attribute, the value "<same>"
appears in the New Release column.

Note: Changes represented here are not necessarily performed
by PeopleSoft. If the compare reports were ran against your
development environment, the modification was made in-
house, not by PeopleSoft.
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Field or Control Description

Customization New release's copy of the production target value. In a
PeopleSoft upgrade, this is the target value from the copy of
the production database against which all upgrade scripts have
been run.

Example: Creating a Composite Report
To illustrate how the system compiles and displays composite report information, this section provides a
simple example. Keep in mind that this example only displays information for one definition. A typical
composite report can contain information pertaining to hundreds of definitions. This example shows:

• Compare report results between a PeopleSoft 8.1 demonstration database and PeopleSoft 8.1
production copy.

• Compare report results between a PeopleSoft 8.4 demonstration database and PeopleSoft 8.4
production copy.

• Composite report result based on the previous compare report results.

Compare Report Results Between a PeopleSoft 8.1 Demonstration Database and
PeopleSoft 8.1 Customer Production Database

This compare report shows customizations. For the field, FLD1, the following customizations were made:

• Field Length: 10 to 12

• Description: ABC to XYZ

• Owner ID: PPT to CUST

With these customizations, the compare report results would appear as follows:

Definition Name Source Status Target Status Attribute Source Value Target Value

FLD1 Unchanged *Changed Field Length 10 12

Description ABC XYZ

Owner ID PPT CUST

Compare Report Results Between a PeopleSoft 8.4 Demonstration Database and
PeopleSoft 8.4 Customer Production Database

This report shows customizations and PeopleSoft modifications.

For the field, FLD1, the following customizations were made:
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• Field Length: 10 to 12

• Description: ABC to XYZ

• Owner ID: PPT to CUST

For the field, FLD1, PeopleSoft made the following modifications:

• Field Length: 10 to 14

• Format: Upper to Mixed

• Field Type: Char to Long Char

With these customizations, the compare report results would appear as follows:

Definition
Name

Source
Status

Target Status Attribute Source Value Target Value Note

FLD1 Unchanged *Changed Field Length 14 12 PeopleSoft
modification +
Customization

Description ABC XYZ Customization
Only

Owner ID PPT CUST Customization
Only

Format Mixed Upper PeopleSoft
modification
only

Field Type Long Char Char PeopleSoft
modification
only

Composite Report Result Based on the Previous Compare Report Results

The following table is a sample composite report only showing the attributes from the previous compare
reports that were changed by both PeopleSoft and a customer.

Definition Name Attribute Old Release New Release Customization

FLD1 Field Length 10 14 12

Descr ABC (same) XYZ
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Definition Name Attribute Old Release New Release Customization

OwnerID PPT (same) CUST

Working with Definition Status

This section discusses how to work with definition status.

Determining Definition Status
PeopleSoft Application Designer defines the status of a definition in the source and the target database.

Field or Control Description

Unknown Definition has not been compared. This is the default status
for all definitions inserted manually into a project and the
permanent status of all non-comparison definitions.

Absent The definition was found in the other database, but not in
this one. When upgrading to a new PeopleSoft release, all
new PeopleSoft definitions should have Absent status in the
target database and all of your custom definitions should have
Absent in the source database.

Changed The definition has been compared, the LASTUPDOPRID
value is PPLSOFT, and the LASTUPDDTTM value is greater
than the date/time stamp of the comparison release database.
This indicates that PeopleSoft modified the definition since the
comparison release.

Unchanged The definition has been compared, the LASTUPDOPRID
value is PPLSOFT, and the LASTUPDDTTM value is less
than or equal to the date/time stamp of the comparison
release database. This indicates that PeopleSoft modified the
definition prior to the comparison release.

*Changed The definition has been compared, the LASTUPDOPRID
value is not PPLSOFT, and the LASTUPDDTTM value is
greater than the date/time stamp of the comparison release
database. This indicates that a customer modified the
definition since the comparison release.

*Unchanged The definition has been compared, the LASTUPDOPRID
value is not PPLSOFT, and the LASTUPDDTTM value is
less than or equal to the date/time stamp of the comparison
release database. This indicates that a customer modified the
definition prior to the comparison release.
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Field or Control Description

Same The definition has been compared and is defined the same
in both databases. When a definition in one database has
this status its counterpart in the other database will have the
equivalent status. This status can be seen when performing
a project comparison because with a project comparison the
definitions are static; the project is not repopulated based on
the comparison results. This status is not seen in a database
comparison, because when doing so the project is populated
only with definitions defined differently.

Note: Compare by release date is determined by finding the highest release label in common between
the source and target databases. PSRELEASE.RELEASELABEL column is searched on both source and
target to find the latest common value between the two. Then PSRELEASE.PSRELEASEDTTM for that
label is used for compare by release date for the source and target, respectively. You can override this
value to set a different release label, or specific compare by date, on the Upgrade Options interface. Only
common release labels (found on both source and target PSRELEASE table) can be used.

Comparing Source Status to Target Status
The following table summarizes the possible status, action, and upgrade values that could be applied to a
single definition during the comparison process.

Source Status Target Status Action Other Action PeopleSoft
Vanilla

Keep
Customizations

Absent Changed or
Unchanged

DELETE None True True

Absent *Changed or
*Unchanged

DELETE None False False

Changed Absent COPY None True True

Changed Changed or
Unchanged

COPY COPYPROP True True

Changed *Changed or
*Unchanged

COPY COPYPROP True False

Unchanged Absent COPY None True True

Unchanged Changed COPY COPYPROP False False

Unchanged Unchanged COPY COPYPROP True True
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Source Status Target Status Action Other Action PeopleSoft
Vanilla

Keep
Customizations

Unchanged *Changed or
*Unchanged

COPY COPYPROP True False

*Changed Absent COPY None True True

*Changed Changed or
Unchanged

COPY COPYPROP False True

*Changed *Changed or
*Unchanged

COPY COPYPROP True True

*Unchanged Absent COPY None True True

*Unchanged Changed or
Unchanged

COPY COPYPROP False True

*Unchanged *Changed COPY COPYPROP False False

*Unchanged *Unchanged COPY COPYPROP True True

Absent Absent None None False False

Same Same None None False False

Unknown Unknown None None False False

The Action, Other Action, PeopleSoft Vanilla, and Keep Customizations are described in the following
sections.

Action

Describes the upgrade action set for an item.

Field or Control Description

DELETE (DEL) The item will be deleted from the target database
during the copy.

COPY The item will be copied to the target database during the copy.
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Other Action

Describes the action when the system finds differences in record or field definitions.

Note: Used for record and field definitions only.

Field or Control Description

COPYPROP Copy properties of the item only. That is, for records, only
copy the record definition, and not record fields. For fields,
 copy field definition only, and not the field labels.

NONE Use the default action instead (DELETE or COPY).

PeopleSoft Vanilla

Describes the setting of the Upgrade flag for the project item when performing the Vanilla Compare type
(set on Upgrade Options).

Field or Control Description

True Upgrade flag is ON.

False Upgrade flag is OFF. You must override this value in order to
have Copy perform the action set in the Action column.

Keep Customization

Describes the setting of the Upgrade flag for the project item when performing the Keep Customizations
Compare type (set on Upgrade Options).

Field or Control Description

True Upgrade flag is ON.

False Upgrade flag is OFF. You must override this value in order to
have Copy perform the action set in the Action column.

Comparing and Merging Page Definitions

This section discusses how to compare and merge page definitions.
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Comparing and Merging Page Definitions
To compare and merge page definitions in the Upgrade view:

1. Open the upgrade project, and make sure that you are in the Upgrade view.

2. Open the Pages window within the upgrade project.

3. Select the page(s) that you want to compare.

4. Right-click on the Pages window to display the context menu.

5. Select Diff / Merge Page, and then select one of these options:

• From Database: select if you are comparing the current definitions with definitions in another
database. After doing so, sign on to the appropriate database using the PeopleSoft Signon window.

• From File: select if you are comparing the current definitions with definitions in a project file.
After doing so, navigate to the appropriate file using the Merge from File: Select Project dialog
box.

To compare and merge page definitions from the Development view:

1. Open the page definition that you want to compare.

2. Select Diff / Merge Page, and then select one of these options:

• From Database: select if you are comparing the current definitions with definitions in another
database. After doing so, sign on to the appropriate database using the PeopleSoft Signon window.

• From File: select if you are comparing the current definitions with definitions in a project file.
After doing so, navigate to the appropriate file using the Merge from File: Select Project dialog
box.

Note: For the compare to work, the name of the page in the external database or project file must have the
same name (the same key value) as the page in the current database.

Working with the Page Compare Results
This section discusses how to:

• Use the Diff / Merge for Page interface.

• Determine differences between page definitions.

• Use the Properties panel.

• Merge attributes and properties from source to target.

Using the Diff / Merge for Pages Interface

After successfully connecting to the database or file, the interface appears similar to the following
example.
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The following is a screenshot of Page definition Diff / Merge interface.

The PeopleSoft Application Designer displays a Property Value panel to show details about every
difference or each changed page control. To the right, each page is displayed side-by-side enabling the
visual comparison.

Note: The pages appear in a read-only state. You cannot make any changes to either page definition from
the Visual Compare interface.

Determining Differences between Page Definitions

When there are differences between source and target page definitions, the system illustrates this in the
Layout tab by surrounding the page field with a red box with a red 'X' at the top, left-hand corner. The
field in which you have placed your cursor has a dotted line surrounding it.
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The following is a screenshot of determining differences between Page definition Visual Compare as
mentioned in the Order tab.

Page controls that have differences are highlighted in red. If you select a page control, you can see easily
if its order is different as the highlighted areas do not match.

Field or Control Description

Use the Previous Difference and Next Difference toolbar
buttons to navigate quickly between the differences flagged
within the active window.

Using the Properties Panel

The Properties panel enables you to view the details regarding the differences between the source and
target page controls. You can move the panel and dock it to the desired locations.

By placing your cursor into each page control surrounded by a red box, the differences in properties
between the source and target definition for that particular page control appear on the Properties panel.
You can also use the TAB key to move from field to field. For page controls that are identical between the
source and target, nothing appears in the Properties panel.

The following is a screenshot of Property Value Panel:

Page fields are identified in the Property Value panel by the field ID value displayed on the Order tab.
You can find definitions for the fields later on this page.
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Field or Control Description

Property Displays the list of properties associated with a particular page
field or control.

Note: The properties appearing for different page fields and
controls may differ. Many of the properties are only used
internally by PeopleTools for page display and position.

[A] <Signed on Database Name> Displays the property values for a page field or control
residing in the database to which you are currently signed on.
 In the context of merging pages, this is the "target" definition.

[B] <Database Name/Project File Name> Displays the property values for a page field or control
residing in an external database or project file. In the context
of merging pages, this is the "source" definition.

Note: If needed you can access the page definition properties by selecting File, Object Properties or
clicking ALT + ENTER.

Merging Attributes and Properties from Source to Target

When merging attributes of a page definition it is important to keep in mind where the two definitions
you are merging reside. The database to which you are signed on is A:, or the "target," and the database or
project file from which you are merging page properties is B:, or the "source."

Use the A and B buttons to control the merging of page definitions between the target and source.

Field or Control Description

Click B to merge a page field, a control, or the properties of a
field, to your target database (A:).

Click A to undo any previously merged items from the B
page definition. The A button is active only after you have
previously merged items from the B page definition.

Note: Before using the A or B buttons, you need to place the
cursor on the page field or page control that you intend to
merge from one definition to the other.

Note: The only way to manipulate the page definitions during
the diff / merge operation is by using the A and B buttons.
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Using the Merge Output Window

After running a diff / merge for pages operation, the Merge tab appears in the output window of the
Application Designer work space. The Merge tab enables you to view the status of your merge operation
as it records each event, such as:

• the initiation of the merge.

• the name of the page being compared.

• the number of differences identified between the two definitions.

• the operations that have occurred (merge Add, undo merge, and so on).

• the name of the saved, merged page definition.

For example:

Opening Visual Merge: MYPAGE(Page)

Comparing [A(ENG,DUT)], [B(ENG,DUT)]

2 difference(s)

(5) Merge: [B](ID:5)–>[A](ID:5)

(4) Merge, Add: [B](ID:13)–>[A](ID:0)

Save [A]:MYPAGE_NEW(Page)

Saving Merged Definitions

After you have determined that all of the appropriate page fields and page controls have been merged into
your target definition, save your changes. By doing so, the system renames the target definition according
to the following naming convention:

<previous_page_name>_NEW
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Working with Text Definitions and Text Files
During Upgrades

Understanding Comparing Text Definitions and Text Files

PeopleSoft Application Designer enables you to compare the same text definition shared between two
databases (or one database and a file) as well as the same text file used by different PeopleSoft releases.
Similar to the Visual Compare interface for pages, you can view the text definitions or files side-by-side
while the system detects each difference and clearly indicates the differences using visual queues. During
this comparison, you choose which lines from each file or definition to carry forward into the merged
version.

Note: The merge process and interface is identical for all text definitions and text files.

Text definitions are Application Designer definitions that are comprised of text, or code. They are:

• PeopleCode

• SQL

• HTML

• XSLT

Text files refer to text files used to store program logic or configuration settings within the PeopleSoft
system. They are:

• COBOL files (.CBL).

• Configuration files (.CFG).

• Data Mover script files (.DMS).

• Initialization files (.INI).

• SQR source files (.SQC).

• SQL files (.SQL).

• SQR report files (.SQR).

Comparing and Merging Text Definitions and Files

This section discusses how to compare and merge text definitions and files.
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Running the Merge Process for Text Definitions
To run the merge process for text definitions:

1. Launch the Upgrade Definition Type window for a text definition.

2. Select the definition you want to compare and merge.

3. Right-click, and select Merge Definition.

4. Select one of the following:

• Database. Select this option if the definition to which you are comparing exists in another
database. The system prompts you to sign on to the other database.

• File. Select this option if the definition to which you are comparing exists in a project file. The
system prompts you to navigate to the project file.

5. After selecting what you want to be the result of the final merge, click Save.

Running the Merge Process for External Text Files
To run the merge process for a single pair of external text files:

1. Select Tools >  Diff / Merge External Text >  Files.

2. In the To Merge File 'A': dialog box, navigate to, and select the file you want to merge, and click
Open.

Typically, the 'A' file is the file that is either older or contains less lines to merge into the most current
file.

3. In the To Merge File 'B': dialog box, navigate to, and select the file you want to merge, and click
Open.

Typically, the 'B' file is the file that is most recent and contains more of the lines you want to remain
in the resulting merged file.

To run the merge process for multiple pairs of external files:

1. Select Tools >  Diff / Merge External Text >  Folders.

2. In the Merge Folder dialog box navigate to and select the appropriate directory for Folder A: and
Folder B:.

How you have the options set on the Merge Properties dialog box, determines to which directory the
system saves the merged results.

3. Select Include sub-folders if you intend to compare multiple sub-folders within one directory,
otherwise, the system only compares and merges files in the immediate directory specified.

4. Click OK.
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Using the Merge Interface
The following is a screenshot of Merge interface for a text definition.

The merge interface displays three windows: the A: window, the B: window, and the Output window.

The following is a screenshot of Merge interface for an external text file.

The merge interface displays three windows for an external text file: the A: window, the B: window, and
the Output window.
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Working with the A: and B: Windows

Text Type Description

Text definition The A: window displays the definition existing in the database
to which you are currently signed on. Code that appears only
in this definition appear in the color specified in the Merge
Properties for A:.

The label of the A: window adheres to the following syntax:

A: Database '<Database Name>'

The B: window displays the definition existing in the database
or file to which you are comparing the definition existing in
database A:. Code that appears only in this definition appear in
the color specified in the Merge Properties for B:.

The label of the B: window adheres to the following syntax:

B: <Database/File> '<Database/File Name>'

External text file The A: window displays the text file specified in the To
Merge File 'A' dialog. Code that appears only in this file
appears in the color specified in the Merge Properties for A:.

The label of the A: window adheres to the following syntax:

A: <file path>

The B: window displays the text file specified in the To Merge
File 'A' dialog. Code that appears only in this text file appears
in the color specified in the Merge Properties for B:.

The label of the B: window adheres to the following syntax:

B: <file path>

Note: If you are comparing and merging multiple files in
a directory structure (using the Folders option), you view
individual pairs of files by selecting them in the Folder Merge
Diff List window.

Note: In the context of the merge feature, there is not necessarily a concept of "source" and "target."
Assigning an "A" and "B" value is used only to distinguish the different locations of definitions and
external text files.

Working with the Output Window

The output window displays what will be the finished result of the merge after clicking Save.
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Initially either the A: or B: definition view will appear, depending on what you selected as the Initial
Output View in the Merge Properties dialog. The Initial View window label displays the value you
selected.

The output window label also displays the Save To value, which represents the location in which the
merged results will be saved.

You can perform simple editing of a line in a text definition appearing in the output window, but you
cannot add new lines.

Note: The Merge tab of the PeopleSoft Application Designer output window, displays any PeopleCode
compile syntax errors. The merged result cannot be saved if there are syntax errors.

Note: While there is an output window for the merge feature, the output window for the PeopleSoft
Application Designer is also visible.

Note: PeopleSoft Application Designer does not provide a method for you to track the change history of a
text definition or external file. Developers must keep track of the changes made during the merge process.

Moving Lines of Code into the Output Window

Field or Control Description

Click the arrow button to insert lines of code from window A:
or B: into the output window. This button only appears next to
lines of code in the A: and B: windows that are unique to that
definition or file.

Click this button to remove from the output window lines of
code that exist only in the A: definition or file.

Field or Control Description

Click this button to remove from the output window lines of
code that exist only in the B: definition or file.

Use the Previous Difference and Next Difference buttons to
navigate quickly between the differences flagged within the
active window.

Saving Merged PeopleCode

After you are satisfied with PeopleCode in the output window that you have merged, click Save to save
the changes to the database specified as the Save Output Destination.
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After you have successfully saved the merged PeopleCode, to view the merged PeopleCode as it appears
in the Saved Output Destination, click the line in the output window indicating that the PeopleCode was
successfully saved.

Saving Merged External Files

After you are satisfied with the content of the output window, click Save to save the changes to the file
specified as the Save Output Destination in the Merge Properties. To view the results, navigate to the
directory containing the file and open it using the appropriate program.

Working with Merge Properties

This section discusses how to work with merge properties.

Accessing the Merge Properties Dialog Box
You access the Merge Properties dialog box after first running the merge process. Then you select File,
Definition Properties.

If you change any properties, and click OK, PeopleSoft Application Designer applies those to the current
merge results. Your merge property changes are applied to all future merge results.

Viewing and Setting Merge Properties
This section discusses how to:

• Set Merge properties.

• View "A" and "B" properties.

Setting Merge Properties

Access the Merge Properties dialog box and select the Merge tab.
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The following is a screenshot of Setting Merge Properties dialog box showing merge tab. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Initial Output View Select the definition you want to appear in the output window
of the compare interface. Typically, you set the Initial Output
View to contain the definition that would have the most
modifications to accept. Either "A" or "B" can be selected.

Save Output Destination Select the location where the system saves the contents of the
merged output window. The location you select appears on the
title bar of the output window.

Note: You cannot save the output to a file.
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Field or Control Description

Colors Specify the colors that the system should associate with each
definition to enhance readability.

• A Only: Select the color to attribute to text that appears
only in definition A.

• B Only: Select the color to attribute to text that appears
only in definition B.

• Common: Select the color to attribute to text that appears
in definition A and B.

View "A" and "B" Properties

Access the Merge Properties dialog box and select either the "A" or "B" tab.

The following is a screenshot of Merge properties dialog box showing “A: tab.

The "A" and "B" tabs display the properties for the current A and B definitions, respectively. These
settings are read-only.
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Note: PeopleCode definitions do not possess description or Owner ID properties, so these properties
appear blank for PeopleCode definitions.

Running a Project PeopleCode Diff/Merge

This section discusses how to run a Project PeopleCode Diff/Merge.

Understanding the Project PeopleCode Diff/Merge
Running a Project PeopleCode Diff/Merge enables you to compare all the PeopleCode definitions in
your upgrade project with another database or file simultaneously. If you have numerous PeopleCode
definitions to compare and merge, this feature can save you time.

Note: The Project PeopleCode Diff/Merge feature is only available for PeopleCode definitions. For SQL,
HTML, and XSLT definitions, you need to merge each definition separately.

Running a Project PeopleCode Diff/Merge
To run a Project PeopleCode Diff/Merge:

1. Select Tools, Diff/Merge Project PeopleCode.

2. Select either:

• Database: select this option if you are comparing definitions with another database. The system
will prompt you to sign on to the appropriate database.

• File: select this option if you are comparing definitions existing in a file. The system will prompt
you to navigate to the appropriate file.

Using the Project PeopleCode Diff/Merge
After running the Project PeopleCode Diff/Merge process a blank merge interface appears and the
PeopleCode Diff List window appears at the bottom of the Application Designer workspace.

The following is a screenshot of using the PeopleCode Diff List window.

The Item column contains the reference to every PeopleCode definition in the project.

The Diff column indicates whether the comparison between the two definitions uncovered any
differences. If there is no difference between the two definitions, the word “identical” appears in the Diff
column. If there are differences between the two definitions, the word “different” appears in the Diff
column, and indicates which definition is more recent. If the definition appears in only one location, the
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Diff column text will read "A only" or "B only.” If the definition is not present in either location the Diff
column text will read "Absent in both.”

When differences are found, the system highlights the row in red also. A and B only lines appear in blue.

Double-click a row in the PeopleCode Diff List to populate the merge interface above and view the
differences between the two definitions.

Related Links
Using the Merge Interface

Filtering the Project PeopleCode Diff List
When working with numerous PeopleCode definitions, for ease of use you may need to reduce the
number of rows appearing in the diff list. To filter what appears in the diff list, select or deselect these
items from the View menu.

Field or Control Description

Show Identical Items Show items that are identical in both data sources.

Show A-Only Items Show items that exist only in the A: data source.

Show B-Only Items Show items that exist only in B: data source.

Show Different Items Show items where a difference is found between the two data
sources.

Show Absent Items Show items where a definition is absent in either data source.

82  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 5

Copying Projects and Definitions

Reviewing Upgrade Settings

After your project is populated with definitions and has been compared (if applicable), review it and
check the upgrade settings before copying it. To reduce the number of definitions through which you must
search, filter out the information that you don't need to see by setting your view options. Afterwards, you
can adjust the default upgrade settings.

Selecting View Options
Filter your view of the upgrade definition window by selecting one of the options in the View, Filtering
menu. These same options are available in the upgrade pop-up menu in the Filtering menu. The options
are:

Field or Control Description

No Filtering Select to display all definitions.

Tagged for Upgrade Select to display only definitions with the Upgrade check box
selected.

Not Tagged for Upgrade Select to display only definitions with the Upgrade check box
cleared.

Done Select to display only definitions with the Done check box
selected.

Not Done Select to display only definitions with the Done check box
cleared.

Custom Filtering Select to open a dialog box in which you can specify which
definition status combinations to display.

When you apply a filter, the filter type appears in the bar above the upgrade columns.

Selecting Custom View Settings
Select View >  Filtering >  Custom Filtering to access the Custom Filtering dialog box, which
includes a matrix that is similar to that found on the Report Filters tab in the Project Properties dialog box.
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Custom Filtering

Select the definition status combinations to display in the upgrade definition window.

The following is a screenshot of selecting Custom view settings in the Custom Filtering dialog box. You
can find definitions for the fields and controls later on this page.

Field or Control Description

Report Filter Click to set these options to be the same as your settings on the
Report Filter tab in the Project Properties dialog box.

Show objects which are identical in source and target Select to display definitions with a status combination of
Same and Same. This status combination is possible only if
you performed a project comparison and if definitions in the
project were defined the same way in the source and target.
 You can never have a Same and Same status combination
for definition types on which you performed a database
comparison.

Overriding Upgrade Defaults
After reviewing your project and its compare reports, you can override the default upgrade column values
for any definitions by changing the Upgrade and Action values.
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For example, to preserve a definition that PeopleSoft Application Designer plans to delete from the target
(Action is Delete and the Upgrade check box is selected) change the Upgrade value. You can also
remove a definition from the project. This does not delete the definition from the database.

Overriding defaults helps if you want to propagate deletions from one database to another.

Specifying Whether Action is Taken on a Single Definition

To specify whether action is taken on a single definition, select or clear the definition’s Upgrade check
box.

When the Upgrade check box is selected, the displayed action is performed when you copy the project. If
the check box is cleared, no action is taken.

Specifying Whether Action is Taken on a Group of Definitions

To specify whether an action is taken on a group of definitions:

1. Select a group of definitions.

Use the Ctrl and Shift keys, or select all definitions in the upgrade definition window by clicking the
top, left-hand cell of the grid.

2. Right-click one of the definitions and select one of these options:

• Tag for Upgrade

Select to select the Upgrade check boxes for all of the selected definitions.

• Untag for Upgrade

Select to clear the Upgrade check boxes for all of the selected definitions.

Specifying Which Action is Performed on a Definition During a Copy

To specify which action is performed on a definition during a copy:

1. Click the Action cell of the definition.

This activates a drop-down list box in the cell.

2. Select Copy or Delete from the drop-down list box.

Remove a Definition From a Project

To remove a definition from a project, select the definition and press Del.

Selecting and Tagging Definitions for Copying or Deleting

To select and tag definitions for copying or deleting:

1. Select the definition rows.

2. Right-click one of the definitions and select Set Action.
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3. Select Copy or Delete.

Your selected definition reflects this change in the Action column. When you upgrade the project, it is
copied or deleted from the target database.

You can also select Set Action for Project to tag all of the definitions in a project for a selected action.

Recording Upgrade Settings
After you change the default upgrade settings, save the project. You might also want to print a hard-copy
record of the project in its current state. You can rerun the Compare process (as a project compare) to
regenerate new upgrade reports, or you can print the contents of the upgrade definition window to save a
high-level view of the project.

Regenerating Upgrade Reports

To regenerate upgrade reports:

1. Set up the reporting filter.

2. Perform a project comparison.

A project comparison compares only the definitions in the project, not the action and upgrade settings.
Your project contents are not altered unless record fields have changed in the target database, in which
case the corresponding changes are made in the project.

This comparison generates new upgrade reports that reflect the configured action and upgrade
settings.

Printing the Contents of the Upgrade Definition Window

To print the contents of the upgrade definition window:

1. Open the upgrade definition with the appropriate definition type displayed.

To do this, select the appropriate folder in the upgrade view.

2. Select File >  Print.

The print job is automatically in landscape format.

Copying Projects

This section provides an overview of project copy options.

Note: When upgrading from one database to another some migrated images may not display in a browser.
To remedy this situation manually clear the cache files in your browser after the project is copied. For
more information about clearing the browser cache, refer to the documentation for your internet browser
version.
The Copy Project from File and Copy to Project to File menu items are available only to users who have
upgrade security or read-only access to the database. If these menu items are not available to you, contact
your system administrator to update your security profile.
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Understanding Project Copy Options
There are two ways to copy projects to another database:

• Copying a source project directly to a target database to which you are connected.

• Copying a source project to a file and then copying the file to a target database.

This feature provides more flexibility in moving PeopleTools definitions and projects across
databases. To move definitions to another database, you copy definitions to a target directory and
files instead of another database. The directory and files can be local or reside on a file server. These
files then become the source when copying a project from a file. Note, however, that not all definition
types that are supported by the Copy to Database process are supported by the Copy to/from File
processes. Those that are not supported must be migrated using Copy to Database.

See Definition Types That You Can Upgrade.

Copying Projects to a Target Database
To copy a project:

1. (Optional) Lock target database definitions.

Before PeopleSoft Application Designer replaces or deletes a definition in the target database, it
checks to determine whether the definition has a change control lock applied. If so, PeopleSoft
Application Designer takes action on that definition if it has been locked by the same user ID that is
performing the copy. Consequently, the speed of a copy might be slow because every definition to be
deleted or replaced in the target must be checked.

You can avoid the performance degradation by locking all of the database definitions in the target
database by using the Change Control Administrator dialog box. This sets a flag telling PeopleSoft
Application Designer not to check the lock status of every definition. When all target definitions are
locked, the copy is faster.

2. Deactivate all system tracing.

3. Select Tools >  Copy Project >  To Database from the PeopleSoft Application Designer toolbar.

The Target Signon dialog box appears, prompting you to sign in to a target database.

4. Sign in to the target database as you do with any PeopleSoft database.

The Copy dialog box appears.

5. In the Copy dialog box, specify the types of definitions to copy and start the Copy process.

6. (Optional) Select the Reset Done Flags check box.

Any definition with a selected Done check box is not copied. The first time that you copy a project,
all Done check boxes are cleared. When you're repeating a copy due to problems found the first time,
however, you might want to clear the Done check boxes of definitions that were copied incorrectly.
Clear all project Done check boxes from the Copy dialog box by selecting Reset Done Flags. This
option is selected by default.

7. (Optional) Select the Copy Project Definition check box.
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If you select this check box, the project definition is copied to the target database.

8. Select the definition types to copy.

Only the definition types that exist in the project are displayed in the Object Type(s) list. To select
all types, click Select All. You can also copy one definition type at a time (repeat this procedure each
time).

Note: If you copy definition types individually, copy them in the order in which they’re presented in
the dialog box. For instance, start with records, then indexes, and so on.

9. Click Copy.

As the Copy process runs, a progress indicator appears on the status bar of the dialog box, displaying
the definition type, the total number of definitions to copy, and the number copied so far.

10. After the copy completes, check for messages.

If you find any problems, correct them and repeat the copy.

11. Stamp the database.

To track the history of the configuration upgrades, PeopleSoft recommends that you stamp the target
database after each copy.

Copying a Project to Multiple Databases
When copying a project to multiple databases, or multiple PeopleSoft systems, use one of the techniques
described in this section to ensure that version numbers remain in the correct sequence.

• Sign off and re-sign onto Application Designer between each project copy to a new environment. This
ensures the target environment version is being incremented for each copy. If you do not sign off and
re-sign onto the system, the version from the previous target environment will be incremented in the
next target environment, which may result in a version discrepancy.

• Use Change Assistant.

See “Understanding Change Packages” (Change Assistant and Update Manager).

• Create a batch file with multiple PSIDE command lines: one for each system.

See Copying Definitions Using the Command Line.

Copying a Project to a File
To copy a project to a file:

1. Open the project that you want to copy.

2. Select Tools >  Copy Project >  To File.

The Copy File dialog box appears.

3. Select the objects that you want to copy, and enter the output directory.
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4. Click Copy.

If the file already exists, a confirmation dialog box appears asking if you want to overwrite the
existing project. Select Yes to continue and overwrite project or No to cancel the Copy process.

The Progress dialog box shows the progress of the Copy process as it copies each definition in the
project to the specified directory. If you click the Cancel button, the system cancels the Copy process.
Any files that were created by the Copy process are removed from the specified directory. To continue
copying a project, restart the Copy process if it was canceled.

When the Copy process completes successfully, a directory with the same name as the current project
is created under the specified export directory. This directory contains the PeopleTools definitions and
project definition in XML file format.

Note: Index key fields are not copied to the project file in certain cases when the session language set
in Configuration Manager does not match the base language for your installation. For best results, set
your session language to match the base language before performing a project copy to file.

Copying a Project From a File
The Copy Project From File command in the Tools menu imports PeopleTools definitions and the project
definition from a file that was previously copied by using the Copy To File feature.

Tracking Fixed Incidents

When PeopleSoft delivers a software update, it is in the form of a change project file. This project
file usually includes enhancements or updates that fix incidents. You can view incident IDs and their
dependencies before you copy the file to the target database.

To view incident IDs that were included in the project file:

1. Open the maintenance project that you are planning to copy to the database.

2. Click the Project Properties button.

3. Select the Update IDs tab.

This tab contains a list of update IDs that were fixed and applied to the software.

4. Select the Pre-Requisites tab.

This tab contains a list of update IDs that are dependent on other fixes that are being applied. These
are validated against the target database when you copy the project. If a fix in the Pre-Requisites list
has not been applied, a message appears, indicating that the target database is missing a dependency.
The only way to have the system allow you to copy projects that have dependencies that are not
applied is to select the Override Pre-Requisites check box.

Note: We can track applied update ID fixes only through the Copy Project From File command in the
Tools menu. Therefore, every update ID fix that PeopleSoft delivers is in a change project that must
be copied to your database.

See “Creating a Change Project” (Change Assistant and Update Manager)
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Copying From a File a Project That Does Not Exist in the Database

To copy a project from a file:

1. Select Tools >  Copy Project >  From File.

The Copy From File: Select Project dialog box appears.

2. Browse to locate the project file or select the file from the Projects list.

Note: You can use the Open button to open folders while browsing. It does not open the project file
and begin the copy process.

You can copy only one project from a file at a time.

3. Select the project from the projects list by clicking Select or double clicking the project name.

The Copy From File dialog box appears.

4. Select whether to use the project definition from the file or the database, and click OK.

5. Select the definition types to copy.

The Definition Type(s) list shows the definition types that have been exported and are available to be
copied into the database.

6. Select the Override Pre-Requisites check box if required.

You can select the Override Pre-Requisites check box if you want the system not to check for project
prerequisites and apply the project regardless of prerequisites that have not been applied.

7. Select the Compile PeopleCode after Import check box.

You can select the Compile PeopleCode after Import check box to compile all the PeopleCode
programs in the Project.

8. Click to Options button.

9. Select the Copy Options tab.
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This example illustrates the fields and controls on the Copy Options tab. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Copy Languages Select the languages to copy.

Update Last Updated User, Date/Time of Project By default when you copy a project from file, the last update
date for the project is shown as time when the file was
created. Select this option to set the LASTUPDOPRID to
current signed on userid and LASTUPDDTTM to current
date.

10. Click Copy.

There are two phases to the Import process: content on the XML file is written to the system cache
directory (as specified in the PeopleSoft Configuration Manager) under a stage directory for the
current database. Then the cache is copied to the database. When the import is complete, the cache
files are deleted.

The Progress dialog box shows the progress of the Copy process as it copies each definition from the
export directory into the attached database. When the Copy from File process successfully completes,
the system creates a new project definition from the PeopleTools definitions in the current database.

If you click the Cancel button before copying the project, the project becomes invalid and the system
deletes the project reference from the database.

Note: When copying application packages and Portal Registry Structures, the Progress dialog box may
display unexpected counting behavior, making it appear that definitions are being processed more than
once. This behavior is expected.
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Copying From a File a Project That Does Exist in the Database

The process for copying a project from a file when a project of the same name exists in the database is
slightly different. After selecting Tools, Copy Project, From File and a project of the same name already
exists in the database to which you are currently signed on, the following dialog box appears.

This prompt enables you to specify which project definition to use, the one stored in the database to
which you are signed on or the one stored in the file from which you intend to copy. Keep in mind that the
project definition is the metadata of the project and determines which definitions (pages, fields, records,
and so on) are members of the project.

Field or Control Description

File Select this option if you intend to copy the project stored in the
file regardless of any Upgrade Action or Take Action settings
in the database.

Note: By selecting this option, you overwrite the project
definition of the same name that previously existed in the
database.

Important! After selecting File and clicking OK, the second
Copy From File dialog box appears where you can view
source and target information, select Definition Types, select
copy options, and so on. If you select Cancel from this dialog
box, the project file does not get copied into the database,
 however, the existing project definition will be deleted from
the database.
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Field or Control Description

Database Select this option if you intend to maintain control of the
upgrade project definition stored in the database and manually
override any Upgrade Action or Take Action settings.

Stamping the Target Database

After successfully copying a project into the target database, "stamp" it to reflect the fact that it has
changed from its previous customer release level. This helps to identify modifications that you make after
this version of the database.

To stamp the target database:

1. Select Tools >  Upgrade >  Stamp Database.

Use this dialog box to specify and stamp the database with a new customer release level.

2. Enter the new customer release value.

The new customer release value must be greater than or equal to the previous value.

Note: Once you are on application release 9.2, the PeopleSoft Release and Service Pack will not
change.

3. Click Stamp.

Related Links
“Change Control Stamping” (Application Designer Developer’s Guide)

Reusing Projects

PeopleSoft Application Designer enables you to reuse projects. To reuse a project, clear the Done check
boxes for the definitions to be recopied. You might also want to validate the project integrity and delete
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invalid definitions. However, this is not necessary. During a copy, invalid definitions are reported and
ignored.

Validating Project Integrity

To validate project integrity:

1. Select Tools >  Options.

2. Select the Validate tab.

Use this tab to specify what kind of checks you want to perform during a project validation. This
procedure discusses only project integrity validation.

3. Select the Validate project integrity check box.

4. Click OK.

5. Select Tools >  Validate.

A message appears, asking whether you want to delete and report invalid definitions or just to report
them.

Note: An invalid definition is any definition in the project with an Add or Replace action that does
not exist in the database. PeopleSoft Application Designer does not act on definitions with a Delete
action, because it assumes that you want to retain such definitions in the project—regardless of
whether they still exist in the database—for the purpose of deleting the same definition in a target
database.

Resetting All Done Check Boxes

To reset all Done check boxes, right-click in the upgrade definition window and select Reset Done Flag.
To reset them for the entire project, select the Reset Project Done Flags option. You can also select
Edit >  Upgrade >  Reset Project Done Flags from the main menu. All Done check boxes for all
definitions in the project are cleared.

Resetting Done Check Boxes for a Group of Definitions

To reset Done check boxes for a group of definitions:

1. Select a group of definitions.

Use the Ctrl and Shift keys, or select all definitions in the upgrade definition window by clicking the
top, left-hand cell of the grid.

2. Right-click one of the definitions and select Reset Done Flag.

You can also select Edit >  Upgrade >  Reset Done Flag from the main menu. This clears all Done
check boxes for the selected definitions.

Resetting the Done Check Box for a Single Definition

To reset the Done check box for a single definition, clear the Done check box for the definition.
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Note: You can only manually clear Done check boxes. You cannot activate these check boxes yourself;
they are automatically selected after a successful copy.
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Working With Alter Analyzer

Understanding the Alter Analyzer

In addition to PeopleSoft Application Designer compare features, you can also use the Alter Analyzer to
compare the PeopleSoft record source and target metadata, gaining insight into an Alter operation. The
Alter Analyzer does not compare all application metadata, just selected attributes, highly relevant to the
application DDL.

In most cases, the Alter Analyzer will be used during PeopleSoft application upgrades, and specific
instructions for setting this up appear in your PeopleSoft upgrade instructions and Change Assistant
templates. The Alter Analyzer applies, for the most part, to the traditional PeopleSoft upgrade process
referred to as "upgrade in place." The main focus of the Alter Analyzer is to enable you to determine the
DDL implications of applying a change to the metadata. The change can be a new release (upgrade), but
could also be a patch, a bundle, a maintenance pack, and so on.

The Alter Analyzer consists of two Application Engine programs that:

1. Load selected record metadata values from the database into a set of staging tables to create a 'base
line' of your metadata, capturing a snapshot of the metadata at that time.

2. Compare the equivalent metadata attributes between the baseline and the target record metadata.

3. Record metadata differences between baseline and target record metadata in the alter repository for
ongoing analysis.

A typical scenario when using the Alter Analyzer would be:

1. Run the metadata loading program to establish a baseline of the metadata.

2. Apply the metadata change(s).

3. Run the metadata analyzer program, and review the alter repository information.

Benefits of the Alter Analyzer include:

• Insight into the alter process, which enables the upgrade process to become more fine-tuned.
Designers of the PeopleSoft application upgrade process can use the Alter Analyzer (internally)
to rearrange the alter process, making it more modular and flexible, which passes on improved
performance to customers upgrading applications.

• A record of all metadata changes can be stored in the alter repository, which you can refer to, query,
run reports against as needed, both during and after an upgrade.

• Improved visibility of important record metadata changes, especially if there is a large volume of
record and record field definitions to be compared. With the alter repository, you can quickly access
the most relevant changes related to DDL.
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Note: While the upgrade process can involve various releases of PeopleTools, the Alter Analyzer is
designed for and tested only on PeopleTools 8.50 and later versions.

Related Links
Lifecycle Management Guide
“Running Application Engine Programs” (Application Engine)

Loading Metadata

In order to compare the source and target metadata, the selected record metadata attributes need to be
extracted from the metadata tables. This creates a baseline of your metadata, against which you can
compare changes. You load the metadata required for Alter Analyzer by running the PTALTDATLOAD
Application Engine program. PTALTDATLOAD, runs against a subset of PeopleTools metadata tables,
storing metadata related to record definitions into the metadata load PeopleTools tables.

Keep in mind that this process is designed for the "alter in place" upgrade process, where the source
and target exist within the same physical database. PTALTDATLOAD runs against the current metadata
tables, extracts the important record metadata attributes, and creates your metadata baseline. Then future
alter processes can be compared against this baseline.

Metadata Load Table Description

PS_PTRECDEFN Stores selected values from source PSRECDEFN.

PS_PTRECFIELDDB Stores selected values from source PSRECFIELDDB.

PS_PTDBFIELD Stores selected values from source PSDBFIELD.

PS_PTOBJCHNG Stores selected values from source PSOBJCHNG.

PS_PTOPTIONS Stores selected values from source PTSOPTIONS.

PS_PTAEAPLTMPTBL Stores selected values from source PSAEAPLTMPTBL.

PS_PTAEAPPLDEFN Stores selected values from source PSAEAPPLDEFN.

PS_PTINDEXDEFN Stores selected values from source PSINDEXDEFN.

PS_PTKEYDEFN Stores selected values from source PSKEYDEFN.

Note: The metadata load tables exist in PeopleTools 8.50 and later version of PeopleTools.
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Running the Alter Analyzer

After loading the metadata and creating a baseline, you would then begin applying metadata change(s).
When doing so, you can periodically run the PTALTANLYZR Application Engine program, which
compares metadata changes to the stored metadata (the baseline) and inserts differences into the alter
repository.

Working with the Alter Repository

This section discusses how to work with the alter repository.

Understanding the Alter Repository
The alter repository consists of a set of tables designed to store the results of the PTANALYZER program
run, as well as some static information to be used for reference. Once the PTANALYZER program runs,
the alter repository will contain information for each definition where metadata attributes differ between
the source and target databases. Use a SQL editor or reporting application to query the repository and
extract the information you require. This will require a working knowledge of the Alter Repository table
structure.

The alter repository consists of these tables:

• PS_PTUALTRECDATA

• PS_PTUALTRECFLDDAT

• PS_PTUALTRECFLDDEF

The structure of the tables is described in the following sections.

PS_PTUALTRECDATA Table
The following table describes the fields in the PS_PTUALTRECDATA table.

Column Name Description

PTUPG_SRECNAME Source Record Name.

PTUPG_TRECNAME Target Record Name.

PTUPG_STABNAME Source Table Name.

PTUPG_TTABNAME Target Table Name.

PTUPG_SRECTYPE Source Record’s Type.
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Column Name Description

PTUPG_TRECTYPE Target Record’s Type.

PTUPG_STMPTBLINST Temp Table Instances count for Source temp table. (Applies
only to temporary tables). Default value is 0.

PTUPG_TTMPTBLINST Temp Table Instances count for Target temp table. (Applies
only to temporary tables’). Default value is 0.

PTUPG_ALTACTION Indicates the Alter action:

A: Add Record (New)

D: Delete Record

RR: Rename Record

CR: Record Added.

DR: Record Deleted

RR: Record Renamed

AR: Alter Record with Field changes, Index changes, and
Trigger changes.

NA: Not applicable, Record with only Trigger, Index, or both
changes.

TC: Record type changed between source and target. Source
table is a non-table (SQL View, Dynamic View, Derived/Work
table, and so on) and in the Target the table is an actual SQL
table (SQL Table, Temporary Table).

TD: Record type changed between source and target.

PTUPG_IDXONLY Indicates whether changes are only to indexes.

0: Default

1: Only Index Changes

PTUPG_TRGONLY Indicates whether changes are only to triggers.

0: Default

1: Only Trigger Changes

PS_PTUALTRECFLDDAT Table
The following tables describes the fields in the PS_PTUALTRECFLDDAT table.
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Column Description

PTUPG_SRECNAME Source Record Name.

PTUPG_SRECTYPE Source Record Type.

PTUPG_SFLDNAME Source Record.Field Name.

PTUPG_SFLDTYPE Source Record.Field Name and Type. (Platform independent-
PeopleTools field type).

PTUPG_SFLDLEN Source Record.Field Name, Type, and .Length.

PTUPG_SFLDDECPOS Source Record.Field Name, Type, and Decimal Position.

PTUPG_SFLDNOTNULL Source Record.Field Name, and Null ability.

0: Null

1: Not Null

PTUPG_SFLDDEFREC Default Record Name.

PTUPG_SFLDDEFFLD Constant (or) Default Record Name. Field Name.

PTUPG_SENCRYPT (Applies only to Oracle databases using TDE.) Source Record.
Field, Encryption.

0: No Encryption

1: Encryption

PTUPG_TRECNAME Target Record Name.

PTUPG_TRECTYPE Target Record, Record Type.

PTUPG_TFLDNAME Target Record.Field Name

PTUPG_TFLDTYPE Target Record.Field Name, and Type. (Platform independent-
PeopleTools field type)

PTUPG_TFLDLEN Target Record.Field Name, Type, and Length.

PTUPG_TFLDDECPOS Source Record.Field Name, Type, and Decimal Position.
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Column Description

PTUPG_TFLDNOTNULL Target Record.Field Name, and Null ability.

0: Null

1: Not Null

PTUPG_TFLDDEFREC Default Record Name.

PTUPG_TFLDDEFFLD Constant (or) Default Record Name. Field Name.

PTUPG_TENCRYPT (Applies to Oracle databases using TDE.) Target Record
Field .Encryption.

0: No Encryption

1: Encryption

PTUPG_ALTACT_A Indicates whether the field is newly added or not.

0: Not an Added Field

1: Added Field (New)

PTUPG_ALTACT_D Indicates whether the field is deleted or not.

0: Not a Deleted Field

1: Deleted Field

PTUPG_ALTACT_CT Indicates whether the field type has changed.

0: No Change in Field Type

1: Change in Field Type

PTUPG_ALTACT_CL Indicates whether the field length has changed.

0: No Change in Field Length

1: Change in Field Length

PTUPG_ALTACT_CD Indicates whether the field decimal position has changed.

0: No Change in Field Decimal Position.

1: Change in Field Decimal Position.
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Column Description

PTUPG_ALTACT_CN Indicates whether the field null ability has changed (Null/Not
Null).

0: No Change in Null ability

1: Change in Null ability

PTUPG_ALTACT_CDR Indicates whether the default record name has changed.

0: No Change in Default Record Name

1: Change in Default Record Name

PTUPG_ALTACT_CDF Indicates whether the default field name has changed.

0: No Change in Default Field Name

1: Change in Default Field Name

PTUPG_ALTACT_CEN (Applies only to Oracle databases using TDE.) Indicates a
change in the field encryption.

0: No Change in Encryption

1: Change in Encryption

PTUPG_ALTACT_FR Indicates whether a field has been renamed.

0: No Field Rename

1: Field Renamed

PS_PTUALTRECFLDDEF Table
This table is provided for reference purposes only. It displays the PeopleSoft field types and their default
values per database platform. It is a static table, not used or updated by Alter Analyzer.

Column Name Description

PTUPG_FIELDTYPE PeopleSoft field type.

PTUPG_FLDTYPENAME PeopleSoft field type name.

PTUPG_PLTFRM_ORA Default value for Oracle databases.

PTUPG_PLTFRM_MSS Default value for Microsoft SQL Server databases.
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Column Name Description

PTUPG_PLTFRM_DB2 Default value for Db2 for z/OSdatabases.

Querying The Alter Repository
This section provides these examples to illustrate the type of information you can gather from the contents
of the alter repository.

• Example: Fields Altered For Target Records

• Example: Source Records Deleted From Target

• Example: Source Records Renamed In Target

Example: Fields Altered For Target Records

This sample query illustrates how to determine which fields on a particular target record will be altered
why.

SELECT
 PTUPG_TRECNAME,
 PTUPG_TFLDNAME,
 PTUPG_ALTACT_A,
 PTUPG_ALTACT_D,
 PTUPG_ALTACT_CT,
 PTUPG_ALTACT_CL,
 PTUPG_ALTACT_CD,
 PTUPG_ALTACT_CN,
 PTUPG_ALTACT_CDR,
 PTUPG_ALTACT_CDF,
 PTUPG_ALTACT_CEN,
 PTUPG_ALTACT_FR
FROM PS_PTUALTRECFLDDAT
WHERE PTUPG_TRECNAME LIKE 'JOB_CD_TBL'

Example: Source Records Deleted From Target

This sample query illustrates how to determine which records in the source database will be deleted from
the target.

SELECT
 PTUPG_SRECNAME,
 PTUPG_STABNAME
FROM PS_PTUALTRECDATA
WHERE PTUPG_ALTACTION = 'DR'

Example: Source Records Renamed In Target

This sample query illustrates how to determine which records in the source database are being renamed in
the target.

select
  PTUPG_SRECNAME,
  PTUPG_STABNAME,
  PTUPG_TRECNAME,
  PTUPG_TTABNAME
FROM PS_PTUALTRECDATA
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WHERE PTUPG_ALTACTION = 'RR'
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Using Command Line Parameters

Understanding PeopleSoft Application Designer Command Line
Parameters

PeopleSoft Application Designer offers a variety of command line parameters that you can use to control
the database to which it connects. By using these parameters, you can automatically navigate to the part of
the system that you need.

Use the values from the following tables to specify certain parameters.

See Command Line Parameters.

Syntax

The following command line syntax applies to all actions identified in this topic:

PSIDE [-parameter value [-parameter value . . .]]

You can include as many or as few parameters as you need.

Each parameter starts with a hyphen (-) or a forward slash (/). The value for each parameter follows the
hyphen or slash, separated by zero or more spaces. In general, the value does not need to have quotation
marks around it, even if it has internal spaces: the system treats all text following the parameter as part of
the value, up to the next parameter or the end of the command line.

Note: You must enclose a value in quotation marks only when it includes a hyphen or forward slash, or
to include leading or trailing spaces. If the value itself includes a quotation mark character, precede the
double quote with a backslash (\).

Related Links
Using the PeopleSoft Data Mover Command-Line Interface

Command Line Option Sequence
Only one command should be included in a single command line. If multiple commands are included
in the command line, the only command that will execute is the command that is last in the order of
precedence.

The following sequence is used for commands:

1. COPYDB - Copy Database

2. COPYTOFILE - Copy To File

3. COPYFROMFILE - Copy From File
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4. COMPAREDB- Compare Database

5. COMPAREFROMFILE - Compare From File

6. BUILDPRJ - Build Project

7. CONVERTPCODE - Convert PeopleCode

8. CONVERTFIELDNAMES - Convert FieldNames

9. CONVERTSEVENWORKFLOW - Convert Workflow

10. CREATEPRJ - Create Project

11. MERGEPRJ - Merge Project

12. BULKEXPORT - Bulk Export

13. SHADOWEXPORT - Shadow Export

14. VALIDATEPROJ - Validate Project Integrity

15. CMPALLPC - Compile All PeopleCode in the Database

16. CMPPRJPC - Compile all PeopleCode in the project

17. CMPDIRPC - Compile Directive PeopleCode in the Database

18. CMPPRJDIRPC - Compile Directive PeopleCode in a project

For example, if the command line included PSIDE.exe . . . . -CMPDIRPC -CMPPRJDIRPC -
VALIDATEPROJ...., CMPPRJDIRPC would process, as it comes last in the sequence order.

Command Line Parameters

This section provides a matrix of required and optional parameters specific for a function and description
of the various parameters.

Required and Optional Parameters Matrix
The following table shows a matrix of required and optional parameters for Copy and Compare functions.

Terms used in the table:

• R — Indicates required parameters for that function.

• O — Indicates optional parameters for that function.

Note: Empty cells in the table indicate parameters that are not applicable to that function.
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Function Parameter Copy Compare

From File To File Database to
Database

From File Database
to
Database

-PJFF R

-PJTF R

-PJC R

-PJFC R

Project

-PJM R

-CT R R R R R

-CS R R R R R

-CD R R R R R

-CO R R R R R

-CP R R R R R

-CI O O O O O

Connect DB

-CW O O O O O

-TS R R

-TD R R

-TO R R

Target DB

-TP R R

-TI O O

-TW O O

Log File -LF O O O O O
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Function Parameter Copy Compare

-FP R R R

-OVD O O O

-EXP O

-RST O O O

Copy

-OVW O O

Object -OBJ O O O O O

-CL O O O O O

-AF O O O O O

-PPL O O O O O

-DDL O O O O O

-CFD O O O O O

-CFF O O O O O

Copy/
Compare

-LNG O O O O O

-FLTR O O

-CMT O O

-TGT O O

-CBY O O

-ROD O O

-CMTABLE O O

Compare

-CMXML O O
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Function Parameter Copy Compare

-CMR O

-CROD O

-CRDB O

-NOTKACT O

-CUSTPRJ O

-HIDE R R R R R

-QUIET O O O O O

-SS O O O O O

No GUI

-SN O O O O O

The following table shows a matrix of required and optional parameters for the Merge, Build, Create, and
Start functions.

Terms used in the table:

• R — Indicates required parameters for that function.

• O — Indicates optional parameters for that function.

Note: Empty cells in the table indicate parameters that are not applicable to that function.

Function Parameter Merge Build Create Start

Project Definitions Project Project Start App Designer

Merge -PJMG R

-PJB RBuild

-CFG R

Create -PJR R

-PJRCUST R
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Function Parameter Merge Build Create Start

-CT R R R R

-CS R R R R

-CD R R R R

-CO R R R R

-CP R R R R

-CI O O O O

Connect DB

-CW O O O O

-LF O O O O

-OBJ O

-HIDE R R R O

-QUIET O O O O

-SS O O O O

No GUI

-SN O O O O

Available Parameters for the Various Functions
Available parameters for functions

Parameter Description Error Handling

-AF Audit flags on records (0 or 1).

Enter 1 to keep the target audit flags as
is. Enter 0 to take them from the source
database. Example: -AF 0

Optional. The default is 1.
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Parameter Description Error Handling

-ADDCLR Select a color for changed values, which
are both source and target values. Select
a color for additional data values on the
source database. These are also source-
only values.

Used while generating Traditional
compare reports and PrintProject
compare reports. However, this
parameter is not applicable while
generating Browser compare reports.

Example: -CMTRAD 1 -ROD c:\temp
\CompareReports -SHPRG 0 -SHLNS 2
-ADDCLR "#86FC83"

Note: If you want to use the customized
color defined in the Report Data Color 
(Upgrade Option> Report Option), then
pass the hex color code value (example:
#86FC83.)

Optional. The default color is dark green.

-CBY Comparison By:

To compare by release, enter REL,
 followed by the release number. To
compare by date, enter DAT, followed
by a date in the following format:
YYYY-MM-DD-HH.MM.SS.sss.
 Release numbers are included in
the Available Release Numbers list.
 Example: 2002-02-01-12.00.00.000

Optional. The default is REL.

-CD Database name.

Enter the name of the database to which
you are connecting, as you would enter it
into the PeopleSoft Signon dialog box.

Required. If you omit this parameter,
 the process stops and error messages are
written to the log file.
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Parameter Description Error Handling

-CFD Keep Target ChartField PageField
Display Size.

(Number 1 or 0). This parameter
indicates whether or not the target
ChartField page field display size
attributes are to be kept, or whether
they should be set from the source. See
Upgrade options for more information.

Enter 1 to keep the target ChartField
page field display size attributes.

Enter 0 to set these attributes from the
source values.

Example, -CFD 0

Optional. Default is 1

-CFF Keep Target ChartField Field Format.

(Number 1 or 0) This parameter indicates
whether or not the target ChartField
field format attributes are to be kept,
 or whether they should be set from the
source. See Upgrade options for more
information.

Enter 1 to keep the target ChartField
field format attributes.

Enter 0 to set these attributes from the
source values.

Example, -CFF 0

Optional. Default is 1

-CI Connect ID

Enter the ID that is used to connect to the
database server.

Optional.

If the connect ID is not specified, the
value from the registry (psfg) is used.

-CL Commit limit.

Enter the Commit limit (a number
greater than 0) for the number of objects
to be copied or compared before a
commit is issued. Example: -CL 150

Optional. The default is 50 if the user
does not set this parameter.

-CMPDIRPC Compile and save all the directive
PeopleCode.

Supply the -CMPDIRPC parameter in
the command line and there is no need
to pass any additional value. This will
compile and save all the directive people.

Required. This is the parameter to
compile and save the all directive
PeopleCode programs in the database.

If you do not supply this parameter then
directive PeopleCode programs in the
database will not be compiled and saved.

114  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 7 Using Command Line Parameters

Parameter Description Error Handling

-CMPPRJDIRPC Compile and Save the PeopleCode for
the project specified.

Enter the project name. Example: -
CMPPRJDIRPC PROJECT1.

Required. This is the parameter
to compile and save the directive
PeopleCode programs in a project. If you
do not supply this parameter then the
directive PeopleCode programs in the
project will not be compiled and saved.

-CMPRTPRJ Enable generation of PrintProject report
during compare.

Enter 1 to enable this option, and enter 0
to disable this option.

Optional. The default value is 0.

This is equivalent to setting the Generate
PrintProject Reports options on the
Report Options tab on the Upgrade
Options dialog box.

-CMR [0 | 1] Use 0 to disable, 1 to enable, the
generation of the Composite Compare
Reports. Parameter is only valid when
used in conjunction with the -PJM
option. Ignored otherwise.

Optional. If not used, then composite
report disabled. Must also use –CROD
and -CRDB options when using -CMR.

Note: Not supported for Compare from
file.

-CMT Compare type: project (1) or database 
(0). Example: -CMT 0

Optional. The default is 1.

Note: Value will always be 1 for
Compare from file.

- CMTRAD Enable generation of traditional compare
reports during compare.

Enter 1 to enable this option, and enter 0
to disable this option.

Optional. The default value is 1.

This is equivalent to setting the Generate
Traditional Reports options on the
Report Options tab on the Upgrade
Options dialog box.

-CMTABLE [0|1] Select this option to write the compare
output to database tables. This enables
you to keep a historical record of your
compares in your database, and it also
provides you the flexibility of being able
to design custom queries for analyzing
specific definitions, attributes, and so on.
 Enter 1 to enable this option, and enter 0
to disable this option.

SeeUsing the Upgrade Workspace

Optional. The default is 1.
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-CMXML Generate browser reports (0 or 1).

This command enables you to enable
the option of generating browser reports
written to your report output directory.
This is equivalent to setting the Generate
Browser Reports options on the Report
Options tab on the Upgrade Options
dialog box.

Enter 1 to enable this option, and enter 0
to disable this option.

Example: -CMXML 1

See Working with Browser Reports

Optional. The default is 0.

-CMPXMLPASS Browser compare report password.

This option enables you to secure the
browser compare report by setting a
password while generating the report.
This is equivalent to setting the Password
Protected option on the Report Options
tab on the Upgrade Options dialog box.

Example: -CMPXMLPASS 12345678

See Working with Browser Reports

Optional

-CO User ID.

Enter the PeopleSoft user ID that is
needed to sign in to the connect database.

Required. If you omit this parameter,
 the last database type is taken from the
registry. If it fails, the process stops and
error messages are written to the log file.

-CP User password.

Enter the password for the specified user
ID for the connect database.

Note: The password can be entered
either as encrypted or clear text.

Required. If you omit this parameter, the
PeopleSoft Signon dialog box appears
and prompts the user for the password.
 If the password fails, the process stops
and error messages are written to the
log file if the log file name parameter is
specified.
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-CRDB [database name] Pass the value of the Old Release
Source Database name when generating
Composite Reports. This value must
match the Source Database name value
from the Old Release Report for each
definition type. This is to ensure the
original old release report is valid and
contains the expected data. If the old
release report source database name
for the current definition type does not
match the passed value, then an error
message is generated to the log file, but
process continues for other definition
types.

Optional.

Note: Not supported for Compare from
file.

-CROD [directory path] Set path for the Old Release Compare
reports when generating Composite
Reports (-CMR 1). Only valid when used
in conjunction with the -PJM and -CMR
1 options, ignored otherwise.

If not set when generating composite
reports (-CMR 1) then its an error
condition, and processing should stop,
 and an error generated to the log file.
 Directory path can be a local directory,
 a mapped network directory, or a UNC
path specification.

Note: Not supported for Compare from
file.

-CS Server name.

Enter the name of the database server
for the database to which you are
connecting.

Required for some database types. If you
omit this parameter, the process stops
and error messages are written to the log
file.

-CT Database type.

Enter the type of the database to which
you are connecting (ORACLE, DB2, and
so on).

Required. If you omit this parameter,
 the last database type is taken from the
registry. If it fails, the process stops and
error messages are written to the log file.

-CW Connect ID password.

Enter the password for the specified
connect ID.

Optional.

If the connect ID password is not
specified, the value from the registry 
(psfg) is used.
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–DELCLR Select a color for data values that are
deleted from the source database. These
are target-only values.

Used while generating Traditional
compare reports and PrintProject
compare reports. However, this
parameter is not applicable while
generating Browser compare reports.

Example: -CMTRAD 1 -ROD c:\temp
\CompareReports -SHPRG 0 -SHLNS 2
-–DELCLR "#820041"

Note: If you want to use the customized
color defined in the Report Data Color 
(Upgrade Option> Report Option), then
pass the hex color code value (example:
#820041.)

Optional The default value is red.

-DDL Data definition language (DDL) on
records and indexes (0 or 1).

Enter 1 to keep the target database DDL
flags as is. Enter 0 to take them from the
source database. Example: -DDL 0

Optional. The default is 1.

-DIFCLR Select a color for changed values, which
are both source and target values.

Used while generating Traditional
compare reports and PrintProject
compare reports. However, this
parameter is not applicable while
generating Browser compare reports.

Example: -CMTRAD 1 -ROD c:\temp
\CompareReports -SHPRG 0 -SHLNS 2
-DIFCLR "Blue"

Note: If you want to use the customized
color defined in the Report Data Color 
(Upgrade Option> Report Option), then
pass the hex color code value (example:
#820041.)

Optional. Default is Blue.
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-EXOBJ Exclude object from copy.

Object types to exclude from copy:
List the object types as numbers with
commas as delimiters. For example, if
you choose to exclude file references
and file type codes for copying, use
the appropriate numbers for file
references and file type codes from
the Definition Type Selection table 
(PTOBJECTTYPES). For file references,
 the number is 68, and for the file type
codes, the number is 69. Example: -
EXOBJ 68,69

Optional.

-EXP Export project definition (0 or 1).

Enter 1 to export the project definition
to the target database when using the
Database Copy process. Not applicable
for Copy Project to File process.

Optional. The default is 1. Any project
with the same name is overwritten with
the new project definition.

-FLTR Report filter.

The command line report filter options
are equivalent to those displayed on the
Report Filter tab on the Upgrade Options
dialog box.

The syntax is:

-FLTR XXXXX XXXXX XXXXX
 XXXXX XXXXX

Where each X corresponds to a specific
check box on the Report Filter tab, and
each set of X's corresponds to a row
in the matrix on the Report Filter tab,
 moving left-to-right, top-to-bottom,
 beginning with the top, left-hand corner 
(Source, Absent/Target, Absent).

The value of X can be either a 0 (not
selected) or 1 (selected).

For example:

-FLTR 00000 00011 00011
 01111 01111

Using this example, and comparing this
to the GUI on the Report Filter tab, none
of the check boxes would be selected
in the first row, only the check boxes
in the Custom Changed and Custom
Unchanged columns would be selected,
 and so on.

Optional. If report filter options are not
submitted on the command line, the
system uses the current settings on the
Report Filter tab on the Upgrade Options
dialog box.
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-FP Project file path.

Enter the project file path.

Required for a Copy To File or Copy
From File process (but not for a
Database Copy process). For the Copy
From File process, the directory must
exist. For the Copy To File process,
 any project with the same name is
overwritten unless you use the -OVW
parameter. A directory specification
is created if it does not exist. Do not
include the name of the project in the file
path. Use -PJTF or -PJFF to specify the
project name.

Required for Compare from file.

-HIDE Use to hide the PeopleSoft Application
Designer interface. Always use this
parameter when performing a command
line Copy process.

Required for all project command line
processes.

-KMVP Enter 1 to retain the target properties of
materialized view.

Enter 0 to set the properties from the
source. You can copy the materialized
view properties like REFRESH_MODE,
 REFRESH_METHOD and BUILD_
MODE from the source to the target
database.

Example: -KMVP 1

Optional. Default value is 1.

-LF Log file name.

Enter the name of the file in which error
messages are logged.

Optional. If you omit this parameter, a
file is created with the specified path and
name, and all of the processing and error
messages are written to that file.
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-LNG List the language codes with commas
as delimiters or enter ALL to select all
available languages. For new languages
that are not listed in the Language
Selection table, use the xlat short name
from the LANGUAGE_CD field in
the translate table. For example, if you
choose English and Spanish for copying
or comparing, enter the appropriate
codes for English and Spanish from the
Language Selection table. For English,
 the code is ENG, and for Spanish, the
code is ESP. Example: -LNG ENG,ESP

See “Language Selections” (Application
Designer Developer’s Guide).

Optional. If you omit this parameter,
 then the languages that are already set
in the project are used as the default.
 The COMMON language code refers
to nonlanguage attributes that are not
translated. Translated attributes can be
copied or compared separately from
nontranslated attributes. If you do not
specify the COMMON code when using
-LNG, you copy or compare only the
translated language attributes.

Changing languages on the command
line changes the values that are stored
with the project definition. Subsequent
Copy and Compare processes on the
modified project use the new values
unless they are explicitly changed again
in the upgrade options.

-OBJ Object types to copy: List the object
types as numbers with commas as
delimiters. For example, if you choose
records and indexes alone for copying,
 use the appropriate numbers for records
and indexes from the Definition Type
Selection table. For records, the number
is 0, and for the indexes, the number is 1.
 Example: -OBJ 0,1

Definition type to compare: List the
definition types to compare as numbers
with commas as delimiters, or enter All.
 Example: -OBJ 0,1

Optional. If you omit this parameter,
 then all of the objects or definitions are
copied or compared by default.

For a project comparison, this refers
to all definitions in the project. For a
database comparison, this includes all
definitions in the database.

-OVD Override dependencies (0 or 1).

Enter 1 to override the checks for
unapplied dependency incidents and to
perform the copy even if dependency
incidents for the project have not been
applied to the source database.

Optional. The default is 0. When you
enter the default and if the project's
dependency incidents have not been
applied to the source database, an error
message is written to the log file listing
which incidents need to be applied.
 The copy process also stops. When you
enter 1, a warning message is written
to the log for unapplied incidents and
processing continues.

-OVW Overwrite existing project (0 or 1). Enter
1 to overwrite any existing projects
with the same name in the specified
path during the Copy Project To File
process, or in the database in the Copy
Project From File process. Enter 0 to
not overwrite existing projects. This
parameter applies to the Copy Project To
and From File processes only.

Optional. The default is 1.
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-PJB Project name.

Enter the name of the project to be built.
 This project should be available in the
database before starting the command
line project build.

Required. This is the main parameter and
is used internally to decide whether the
user can build a project. If you omit this
parameter and if you supply all of the
source database login parameters, the
program only starts the application.

-CFG RDM build setting configuration file. Required. This parameter is used with -
PJB to set the build settings.

Sample file is available at <PS_HOME>
\setup\ptbld.cfg.

-PJC Source project name.

Enter the name of the project that is to be
copied from the source database to the
target database. This project should be
available in the source database before
starting the command line Upgrade Copy
process to target database.

Required for a Database Copy process.
 This is the main parameter that is used
internally by the executable file to
identify an Upgrade Copy process. If you
omit this parameter and if you supply all
of the source database login parameters,
 the executable file starts the application.

-PJFF Copy Project From File project name.

Enter the name of the project to be
copied from the file into the source
database.

Required for a Copy From File process.
Do not include the file path to the project
with this parameter. Use -FP to specify
the file path.

-PJFC Compare from file.

Enter the project name for the file.

Required for Compare from file.

-PJM Source project name.

Enter the name of the project that is to
be compared from the source database to
the target database. This project should
be available in the source database
before starting the command line
Upgrade Compare process to the target
database.

Required. This is the main parameter that
is used internally by the executable file
to identify an upgrade compare. If you
do not supply this parameter and if you
supply all of the source database login
parameters, this executable file starts the
application.

-PJTF Copy Project To File project name.

Enter the name of the project to be
copied from the source database to the
file.

Required for a Copy To File process. Do
not include the file path to the project
with this parameter. Use -FP to specify
the file path.

-PJV Validate Project Required for Validate Project.
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-PLRM Permission List, Role, Menu (0 OR 1).

Enter 1 to keep the target database
tracking data for permissions lists, roles
and menus. Enter 0 to take the tracking
data from the source database.

Example: -PLRM 0

Note: This option applies to Upgrade
Copy operation and is ignored for
Upgrade Compare operation.

Optional. The default is 0.

-PPL Portal registry structures permission list
references.

Enter 1 to keep the target portal registry
permission list references as is. Enter 0
to take them from the source database.

Optional. The default is 1.

-QUIET Use to run in quiet mode so that no
message boxes appear. The system
writes messages to the log file or trace
file, depending on whether you also
use the -LF parameter. Quiet mode is
recommended for use with processes that
require no human interaction.

-ROD Report Output Directory.

Enter the report output directory
location. Example-ROD c:\temp
\upgreports

Optional. If you do not supply this
parameter, the system uses the Report
Output Directory value from the
Tools >  Options General tab.

-RST Reset done flags (0 or 1).

Enter 1 to reset the done flags before
initiating the Copy process. Enter 0 to
not reset them. Example: -RST 0

Optional. The default is 1.

-SHLNS Displays the number of lines above and
below the difference line in PeopleCode
Report Options.

Used while generating Traditional
Compare Reports and Browser Compare
reports. However, this parameter is not
applicable while generating PrintProject
compare reports. Example: -CMTRAD 1
-ROD c:\temp\CompareReports -SHPRG
0 -SHLNS 2

Optional. Default is 0.

This parameter works only if -SHPRG
value is 0.
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-SHPRG Based on the value selected, displays
the entire program or displays the
differences in program.

Used while generating Traditional
Compare Reports and Browser Compare
reports. However, However, this
parameter is not applicable while
generating PrintProject compare reports.
 Example: -CMTRAD 1 -ROD c:\temp
\CompareReports -SHPRG 1

Optional. Default is 1 and it displays the
entire program.

-SN Use to suppress the sound that plays
when you sign in to the PeopleSoft
system. Any other value causes the
sound to play.

Optional

-SS Use to suppress the display of the
PeopleSoft splash screen. Any other
value causes the splash screen to appear.

Optional

-TD Target database name.

Enter the name of the target database to
which you are connecting as you would
enter it into the PeopleSoft Signon dialog
box.

Required for Compare (Database to
Database).

Required for a database Copy process 
(but not used for a Copy To File or Copy
From File process).

If you omit this parameter, the process
stops and error messages are written to
the log file if the log file name parameter
is specified.

-TGT Target Orientation: PeopleSoft vanilla 
(0) or keep personalization (1).

Optional. The default is 0.

-TI Target connect ID.

Enter the ID that is used to connect to the
target database server. If the connect ID
for the target database is the same as the
connect ID for the connect database, this
parameter is not necessary.

Optional. If no value is specified, CA
determines the value in this order:

1. Uses the -CI value (Connect ID.)

2. Reads the value from the registry.
 This value is populated by pscfg.
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-TO Target user ID.

Enter the PeopleSoft user ID to use to
sign in to the target database.

Required for Compare (Database to
Database).

Required for a Database Copy process 
(but not used for a Copy To File or Copy
From File process).

If you omit this parameter, the process
stops and error messages are written to
the log file if the log file name parameter
is specified.

-TP Target user password.

Enter the password for the specified user
ID for the target database.

Note: The password can be entered
either as encrypted or clear text.

Required for Compare (Database to
Database).

Required for a Database Copy process 
(but not used for a Copy To File or Copy
From File process).

If you omit this parameter, the process
stops and error messages are written to
the log file if the log file name parameter
is specified.

-TS Target server name.

Enter the name of the target database
server for the database to which you are
connecting.

Required for Compare (Database to
Database).

Required for some database types and
for a Database Copy process (but not
used for a Copy To File or Copy From
File process). If you omit this parameter,
 the process stops and error messages are
written to the log file if the log file name
parameter is specified.

-TW Target connect ID password.

Enter the connect ID password for
the target database. If the connect ID
password for the target database is
the same as the connect database, this
parameter is not necessary.

Optional. If no value is specified, CA
determines the value in this order:

1. Uses the -CW value (Connect ID.)

2. Reads the value from the registry.
 This value is populated by pscfg.

Starting the PeopleSoft Application Designer Command Line
Interface

Use the command line syntax and available parameters to start PeopleSoft Application Designer.

Command Line Syntax

Use the command line syntax described previously to start PeopleSoft Application Designer.
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See Understanding PeopleSoft Application Designer Command Line Parameters.

Example

For this example, assume that the:

• Database type is Oracle.

• Server name is SEPNTDB05.

• Database name is EP7TST.

• User ID is PTDMO.

• Password is encrypted.

This command line statement starts PeopleSoft Application Designer and signs in to the DEP7TST
database:

PSIDE -CT ORACLE -CS SEPNTDB05 -CD EP7TST -CO PTDMO -CP ***Encrypted Password***

See Command Line Parameters.

Building Projects Using the Command Line

Use the same command line syntax as identified previously to build a project.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for the project build to:

• Connect the project to the source database.

• Use the build settings from the Windows registry to generate the SQL script for the create or alter
processes.

Before running the build command line, verify that:

• The project's system components are created and loaded.

• The build options are set in the Windows registry.

Example

For this example, assume that the:

• Project name is PROJECT1.

• Database type is Oracle.

• Database name is T1B85401.

• User ID is PTDMO.

• Password is encrypted.
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• Path name of the log file is c:\temp\psbuild.log in the Windows registry.

For this example, you would enter the following at the command line:

pside.exe -CT ORACLE -CS -CD T1B85401 -CO PTDMO -CP ***Encrypted password*** -CI people -
CW password -PJB PROJECT1 -LF C:\temp\out\BuildCreateTest.log –HIDE -QUIET -SS -SN

See Command Line Parameters.

Creating Projects Using the Command Line

Use the same command line syntax as identified previously to build a project.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for the project create to:

• Connect the project to the source database.

• Indicate the object types to include in the project.

Note: Projects created using -PJR are limited to object types and will include all instances of the
object type specified. You can include multiple object types separated by comma. To create a project
that includes all object types use ALL.

Example

For this example, assume that the:

• Project name is CREATETEST.

• Database type is Oracle.

• Database name is T1B85401.

• User ID is PTTRN.

• The object types are 79,80,81,82.

• If there is an existing project with the same name it will be overwritten.

• Path name of the log file is c:\temp\out\CreateTest.log.

For this example, you would enter the following at the command line:

pside.exe -CT ORACLE -CS -CD T1B85401 -CO PTTRN -CP password -CI people -CW password -PJR
CREATETEST -OBJ 79,80,81,82 -OVW 1 -LF c:\temp\out\CreateTest.log -HIDE -QUIET -SS NO -SN
NO

This is an example of the log file created for this command line.
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This example illustrates the fields and controls on the Example of log for creating a project.

Creating Customization Project Using the Command Line

Customization projects are used to identify any customizations made to managed objects. This feature is
only available using the command line or as a step in Change Assistant. This feature will go through the
specified objects in a database and check the user ID:

• If the user ID is not specified in the command line, PSIDE will compare the object user id with
‘PPLSOFT’ and insert the object into the customization project if the user ID is not ‘PPLSOFT’.

• If user ID is specified in the command line, PSIDE will compare the object user ID with the user IDs
specified in the command line and insert the object into the project if the user ID is one of the user IDs
specified in the command line.

Important! This feature compares the user ID of the managed object, it does not compare
LASTUPDDTTM and detail the property of the managed object.

Use the same command line syntax as identified previously to create a customization project.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for the create customization project to:

• Connect the project to the source database.

• Indicate the user IDs.

Note: To enter multiple user ID, separate the user IDs with commas.

• Indicate the object types to include in the project.
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Note: Projects created using -PJRCUST are limited to object types and will include all instances of
the object type specified. You can include multiple object types separated by comma. To create a
project that includes all object types use ALL.

Example

For this example, assume that the:

• Project name is PROJECT1.

• Database type is Oracle.

• Database name is T855805B.

• User IDs for the LASTOPRID are PTTRN and PTINT.

• User ID to signon is PTTRN.

• The object types are 0,2 (record and field).

• If there is an existing project with the same name it will be overwritten.

• Path name of the log file is C:\temp\createcust.log .

For this example, you would enter the following at the command line:

pside.exe -PJRCUST PROJECT1 -OBJ 0,2 -LASTOPRID PTTRN,PTINT -CT ORACLE -CS -CD
T855805B -CO PTTRN -CP password -CI people -CW password -LF C:\temp\createcust.log -HIDE -
QUIET -SS -SN

This is an example of the log file created for this command line.

This is an example of the log file for creating a customization project.
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Copying Definitions Using the Command Line

Use the same command line syntax as identified previously to copy definitions.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for Upgrade Copy processes to:

• Connect to the source database.

• Connect to the target database.

• Copy the project and its objects from the source database to the target database.

If the same project already exists in the target database, you can set the option to overwrite the older
project with the new project.

• Identify the definition type to copy. By default all definition types in the project are copied unless you
set the -OBJ parameter to include only specific definition types or you use the -EXOBJ parameter to
specify specific definition types to exclude.

This table lists how these parameters work together in the command line.

-OBJ -EXOBJ Object List Example

No No All Objects Command line does not have either of
these parameters

Object list contains all definition types.

Yes No All objects listed in -OBJ parameter -OBJ 1,2,3

Object list contains definition types 1, 2,
 and 3.

No Yes All objects except objects listed in -
EXOBJ parameter

-EXOBJ 1,2,3

Object list contains all definition types
except types 1, 2, and 3.

Yes Yes Objects of -OBJ excluding objects of -
EXOBJ

-OBJ 0,1,2,3,4,5 -EXOBJ 3,4,5,6,7

Object list will contains definition types
0,1 and 2.

Example: Database Copy Process

These are some command line statements for the Database Copy process:

• Copy the project PPLTOOLS from the source Oracle database, PTDMO, to the target database,
PTTST.
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• Log process and error messages to c:\temp\copy.log.

• Set the commit limit to 150.

Copy the audit flags and record and index DDLs from the source database.

• Copy only records, indexes, pages, queries, and process definitions from the project.

• Do not reset the done flags before initiating the Copy process.

• Copy only English and Spanish translations.

• Keep the target origin for permission list, roles and menus.

This is a command line statement that performs the preceding list of tasks.

PSIDE.EXE −HIDE -PJC PPLTOOLS -CT ORACLE -CD PTDMO -CO PTDMO -CP password -TD
PTTST -TO PTDMO -TP password -QUIET -LF C:\TEMP\COPY.LOG -CL 150 -AF 0 -DDL 0 -OBJ
0,1,5,10,20 -RST 0 -LNG ENG, ESP -PLRM 1

See Command Line Parameters.

Example: Copy To File Process

These are some command line statements for the Copy to File process:

• Copy the PPLTOOLS project from the Oracle database, PTDMO, by using the PTDMO user ID, to
the local directory c:\temp\export.

A directory named PPLTOOLS is created in c:\temp\export.

• Log progress and error messages to c:\temp\copy.log.

This is a command line statement that performs the preceding list of tasks.

PSIDE.EXE −HIDE -PJTF PPLTOOLS -FP c:\temp\export -CT ORACLE -CD PTDMO -CO PTDMO -
CP password -QUIET -LF c:\temp\copy.log

See Command Line Parameters.

Example: Copy From File Process

These are some command line statements for the Copy From File process.

• Copy the PPLTOOLS project to the DB2 UDB for Linux, Unix, and Windows database, PTDMO, by
using the user ID PTDMO, from the local directory c:\temp\export.

A directory named PPLTOOLS must exist under c:\temp\export.

• Log progress and error messages to c:\temp\copy.log.

This is a command line statement that performs the preceding list of tasks.

PSIDE.EXE −HIDE -PJFF PPLTOOLS -FP c:\temp\export -CT DB2UNIX -CD PTDMO -CO PTDMO -
CP password -QUIET LF c:\temp\copy.log

See Command Line Parameters.
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Merging Projects Using the Command Line

Use the same command line syntax as identified previously to build a project.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for the merge projects to:

• Connect the database.

• Merge 2 projects in that database.

Projects are merged into the first project listed.

Example

For this example, assume that the:

• Projects to merge are: PROJECT1 and PROJECT2

Projects will be merged into PROJECT1.

• Database type is Oracle.

• Database name is T1C85401.

• User ID is PTTRN.

• Password is password.

• Path name of the log file is C:\temp\Output\mergetest.log in the Windows registry.

For this example, you would enter the following at the command line:

pside.exe -CT ORACLE -CS -CD T1C85401 -CO PTTRN -CP password -CI people -CW password -
PJMG PROJECT1,PROJECT2 -LF C:\temp\Output\mergetest.log -HIDE -QUIET -SS NO -SN NO

See Command Line Parameters.

Comparing Definitions for Upgrade Using the Command Line

Use the same command line syntax as identified previously to compare definitions.

See Understanding PeopleSoft Application Designer Command Line Parameters.

Use the command line statement for an Upgrade Compare process to:

• Connect to the source database.

• Connect to the target database.

• Perform a project or database compare (based on parameters).
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• Create compare reports in the specified output directory.

Example: Comparing to Database

Use this example as a guide for running an Upgrade Compare process:

• Run a database Compare process against the source Microsoft SQL Server database, FSDMO, and the
target database, PTTST.

• Source database uses connect ID and password as defined in pscfg.

• Log process and error messages to c:\temp\compare.log.

• Set the commit limit to 150.

• Show the audit flag and DDL differences between databases.

• Compare records, indexes, pages, queries, and process definitions.

• Compare only English and Spanish translations.

• Set the database compare type.

• Set the target orientation to keep the customizations.

• Compare by release 8.52.00.000.

• Generate compare reports to the c:\temp\upgreports directory.

• Set target database server connect id to people.

• Set target database server connect password to 123456.

PSIDE.EXE −HIDE -CT MICROSFT -CD FSDMO -CO PTDMO -CP password -PJM PPLTOOLS -
TD PTTST -TO PTDMO -TP password -QUIET -LF C:\TEMP\COMPARE.LOG -CL 150 -AF 0 -DDL
0 -OBJ 0,1,5,10,20 -LNG ENG, ESP -CMT 0 -TGT 1 -CBY REL Core 8.52.00.000 -ROD C:\TEMP
\UPGREPORTS -TI people -TW 123456

See Command Line Parameters.

Example: Comparing from File

Use this example as a guide for running an Upgrade Compare From File process:

• Run a Compare From File process on the T855805B database (target) against the file C:\PROJECTS
\CUSTPRJ (source).

• Project name is CUSTPRJ.

• Log process and error messages to C:\TEMP\COMPARE.log.

• Set the commit limit to 100.

• Compare all definitions.

• Compare all languages.
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• Set the database compare type.

• Set the report filter.

• Set the target orientation to PeopleSoft Vanilla.

• Compare by release PeopleTools 8.54.00.000.

• Generate PrintProject report.

• Generate compare reports to the D:\Reports directory.

PSIDE.EXE -CT ORACLE -CS -CD T855805B -CO PTTRN -CP password -PJFC CUSTPRJ -FP C:
\PROJECTS\ -LF C:\TEMP\COMPARE.log -CL 100 -AF 1 -OBJ All -LNG All -PPL 1 -CFD 1 -CFF 1
-FLTR 00000 00011 00011 01111 01111 -TGT 0 -CBY REL PeopleTools 8.54.00.000 -CMPRTPRJ 1 -
ROD C:\Reports\ -HIDE -QUIET

See Command Line Parameters.

Compiling and Saving Directive PeopleCode

Directive PeopleCode is identified using the PTTOOLSREL column on the PSPCMPROG table. As a
part of the PeopleTools Only upgrade, it may be necessary to compile the directive PeopleCode. The
parameter -CMPDIRPC is used to compile directive PeopleCode.

Example: Compiling and Saving Directive PeopleCode

For this example, assume that the:

• Database type is Oracle.

• Database server name is SERVER1.

• Database name is QEDMO854.

• Database user ID is QEDMO.

• PeopleSoft splash screen is suppressed.

• Run in QUIET mode.

• PeopleSoft Application Designer interface is hidden.

• Compile and Save Directive PeopleCode

• Path name of the log file is c:\temp\test2.log in the Windows registry

pside.exe -CT ORACLE -CS SERVER1 -CD QEDMO854 -CO QEDMO -CP password -SS NO -QUIET
-HIDE -CMPDIRPC -LF c:\temp\test2.log

See Understanding PeopleSoft Application Designer Command Line Parameters for details on the
parameters.
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Getting Started with Application Data Sets

Application Data Set Overview

Application Data Sets referred to as ADS is the name given to a collection of technology used to migrate
application/configuration data between PeopleSoft environments. Application Data Sets is used as part
of the Selective Adoption maintenance process and can also be used between two different PeopleSoft
applications that have similar data structures.

The three main parts of ADS are:

1. Application Data Set Definitions

Application Data Set definitions define classes of Application Data Sets. Application Data Set
definitions are created and maintained in the Data Set Designer.  Data sets is the technology used
to relate data into logical objects to help simplify and improve the process of understanding and
migrating changes to the data.

2. ADS projects

ADS projects convey the data described by Application Data Set definitions.

3. Data Migration Workbench

Data Migration Workbench or DMW provides the interactive user interface to run ADS operations
such as compare and copy, review the compare reports, override merge or copy actions, provide
approvals when necessary, as well as create new ADS  projects.

Application Data Sets (ADS)
Application Data Sets (ADS) provide the underlying transport technology to move, compare, validate,
and merge configuration data. Configuration data includes:

• setup data

• application data

• tools configuration

• managed objects

Application Data Sets are designed to manage the complexity of migrating configuration data across
multiple PeopleSoft systems. It is very common to have four or more databases in a PeopleSoft
environment, including one or more for development, another for quality assurance, as well as
the primary production system. PeopleTools migrates managed objects between environments in
PeopleSoft projects that are extracted from one database and imported into another, which works well for
PeopleTools metadata however it does not handle application configuration data.
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ADS provides the ability for any authorized developer to easily define application data sets, create and
modify projects and to compare and copy the objects in the projects similar to the way managed objects
have been copied and compared for many years.

Application Data Sets:

• Enable developers to use PeopleSoft Pure Internet Architecture (PIA) to create data set definitions as
a hierarchy of records with some collective properties. A data set definition defines the shape of data
set instances. It consists of the following elements:

• A root record. The primary keys of the root record are then keys of the data set instance

• An optional hierarchy of related child records, where each child record includes the keys of its
parent record.

• An optional set of properties.

• An optional set of relationships to other data sets, and their properties.

• An optional set of attribute groups and their properties.

• An optional application class having PeopleCode that transform and/or validates the data set
instances at copy, compare and validate time.

Data set definitions are like record definitions: record definitions define a group of fields that
constitute a record; data set definitions define a group of records that constitute a data set. Both record
definitions and data set definitions are metadata that define the shape of data.

• Data sets support relations and groups. Relations make it possible to associate two or more data sets
based on keys, criteria and properties. Data Sets that include relationships with the family property
make it possible to merge the attributes when the data set is copied to the target database. Groups can
be used to define records and fields that can be safely merged or that should be hidden from compare.

• Enable developers or administrators using PIA to insert data set instances (data content) into projects
to represent a unit of work as an ADS project. ADS projects are like managed object projects: a
collection of data set instances having various data set definitions.

• Enable developers or administrators using PIA or Change Assistant to copy, compare, validate, and
merge data sets that get included in an ADS project.

• Enable PIA-based copy and compare to use powerful servers rather than the Windows workstations
required for PeopleSoft Integrated Development Environment (PSIDE)-based copy and compare.

• Integrate with the Enterprise Components Approval Framework to provide administrative control of
the project copy from file process.

• In some cases, provide enhanced security to assure that the data set definitions are suitable for
copying data, that the user has access to the PIA data set pages, and that user has the right to copy and
compare the data.

• Provide an alternative to Data Mover that offers greater visibility and control for managed changes of
a customer's environment.
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• Allow pre-defined target configuration fields values to be preserved within each instance. The object
owner defines what fields can be preserved using groups. The customer can review and choose to
override default behavior with interactive PIA-based compare.

Data Migration Workbench
Data Migration Workbench is the interactive user interface used to:

• Define ADS project content.

• Launch copy, compare and validation operations for projects.

• View compare and validation results, and modify the copy options of data sets that will be copied.

Data Migration Workbench shows the current status of a project and prevents inconsistent actions. Once
you have defined the ADS project, you can copy the data to a file that can later be compared or copied
from file on another PeopleSoft database.

The Data Migration Workbench uses a Project Repository as a place in the file system where project files
can be copied to and from. The Project Repository is defined in the data base as a repository name, an
associated file path, and one or more areas (sub folders) that can contain project files. The purpose of
Project Repository is to avoid manually copying project files from one system to another by promoting
common definition of shared file locations and providing better security for administrative control of the
places that project files can be copied to.

Main Components
This diagram illustrates the main components for Application Data Sets: Data Set Definition and Data
Migration Workbench
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Application Data Set Integration with PeopleSoft Update Manager
PeopleSoft Update Manager (PUM) is used by PeopleSoft to deliver maintenance to customers. PUM
uses ADS projects to migrate both PeopleTools-owned objects like Pivot Grids and Activity Guides,
and application-owned objects like Global Payroll. The principle change in 8.54 integration with PUM
was to create a composite project of customer-selected units of work containing ADS projects and their
dependents for ADS in a manner similar to what has been done for IDE objects in 8.53. Thus when a
customer selects units of work to apply in PUM, and the dependency calculation adds dependent units of
work, a single composite ADS project is generated. This simplifies downstream processing.

Deployment of Application Data Using Application Data Sets

In previous releases, Data Mover scripts were the only option available to load application data. There
was no way to compare the data that is copied by Data Mover. Application Data Sets provide the ability to
compare and copy the content data.

Note: Data Mover scripts are still being used to load application data, however ADS provides another
alternative for migrating data.

This diagram shows the overall flow for creating and copying ADS projects.
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This diagram shows the flow for creating and copying data sets. On the source database, you create a data
set definition in PIA just once. The data set definition is a traditional managed object, so it can be copied
and compared using the IDE (Integrated Development Environment). You can then include data defined
by the data set definition into data migration projects. Each project can contain data from multiple data set
definitions. Once the ADS project contains data content it can be copied to a file. The file will be located
in one of the Project Repositories defined for your environment. Before you can copy the ADS project
to a PeopleSoft target database, the data set definition must exist on the target database. To copy the data
set definition, you will need to create an IDE project in Application Designer that contains the data set
definition. You can then copy the IDE project to a file and copy it from the file to the target database.
On the target database, you will load the data migration project from the Project File repository location,
this step copies the project definition from the file to the target, but none of the project content is copied.
You can then compare the project and update the copy options, or, if approvals are not enabled on the
target or the approval rules do not require a compare, you may copy the project without doing a compare.
When you are ready to copy the project, you will submit for copy. If approvals are enabled on the target
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database, it will enter the approval process; otherwise the copy will be initiated. If the approval process is
enabled, then only approved projects are scheduled for copy, if the project is rejected there is no copy.

Application Data Set Implementation

This section discusses the steps used to implement and migrate data using data sets:
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Steps Reference

1. Create Data Set Definition. See Creating and Editing Data Set Definition.

2. Create or select then populate ADS Project. See Defining ADS Project.

3. Copy to file. See Copying Project to File

4. Compare ADS Project from file. See Comparing ADS Projects.

5. Review compare and validation reports. See Viewing Compare Reports.

6. Copy ADS Project from file. See Submitting for Copy.

Application Data Set Limitations and Recommendations

This section lists some limitations and recommendations for Application Data Sets.

Limitations

Keep in mind the following limitations for Application Data Sets:

• The Application Server and Process Scheduler used must both be able to access the project files using
the same path. This will require that both are running on Operating Systems that use compatible file
access conventions. For example, Microsoft Windows and UNIX-derived operating systems do not
have compatible native file access conventions.

• Although data set security has been improved in PeopleTools 8.54, and is more secure than some
other migration technologies, data migration via ADS is intended to be used for data that does not
contain sensitive data.

• The data set definition must exist on the target database before you load a data set project to the target
database.

• The shape of a data set is defined by the records and fields included in the data set. The allowed
shape changes include adding records or fields to a data set definition. Allowed shape changes do not
require PeopleCode.

Additional shape changes, such as supplying data values for a newly added field or moving data from
one record to another may require a custom transform program. The application classes associated
with data sets can support various data transformations expressed using the rowset PeopleCode API.
In 8.53 transforms are possible at copy from file time, and in 8.54 and beyond transforms can be
implemented at both copy to and from file times.

• Data set records must be physical records that have at least one primary key. All child records must
include the primary keys of the parent record, but may also have additional primary keys.
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Recommendations

The following practices are strongly recommended:

• ADS projects are meant for relatively small data sets of relatively static data.

Note: ADS projects are not recommended for large data sets.

• Do not change the source ADS Project file after the compare has been performed. If the source data
file is changed, any compares must be re-run.

Note: The decision of which objects to copy is based on the compare report, which is stored in
the database. If the ADS project is changed after the compare, you may not get the desired results.
Changing the target database may be necessary to fix validation errors, but caution is required to
avoid changes to the target database that might create validation errors during copy that were not seen
in compare.

• Setting up the Project Repositories and areas is a one time activity. The directories should first be
created by a system administrator with read/write access permissions for the users who will start the
application and process schedule servers.
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Creating and Editing Data Set Definition

This section describes how to create and edit data set definitions.

Searching For and Creating Data Sets
Use the Data Set Designer search page to search for, add, or delete a data set.

Navigation:

PeopleTools >  Lifecycle Tools >  Migrate Data >  Application Data Set Designer

This example illustrates the fields and controls on the Data Set Search page. You can find definitions for
the fields and controls later on this page.

The Data Set Search page has two tabs: Find an Existing Value, and Add a New Value.

Search

Search is the default action for Data Set Designer. Users can search for existing data sets and open an
existing data set for modification. Users can also delete one or more data sets from the search result set.

You can search for an existing data set using:

• Data Set Name

• Description

• Owner ID

Basic and advanced search is provided so users can search based on one or multiple search keys. The
search result produces a grid. Users can select one or multiple data sets in the grid to delete. Users can
open the data set for modification using the link for the data set name.
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This example illustrates the fields and controls on the Data Set Designer Search page.

Create New Data Set

Select the Add a New Value tab or link to create a new data set.

Enter a Data Set Name and a description for the new data set. Data Set Name and Description are
mandatory fields. When you click the Add button, the identity page is displayed.

See Defining the Data Set.

Defining the Data Set
Use the General page to identify the top-level properties of the data set.

Navigation:

PeopleTools >  Lifecycle Tools >  Migrate Data >  Application Data Set Designer

144  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 9 Using Application Data Set Designer

This example illustrates the fields and controls on the Data Set Designer – General page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Data Set Name Uniquely identifies the data set definition. Each data set
definition describes a distinct shape, and there can be many
instances of that type.

Description A description of the data set definition.

Long Description A long description providing additional information such as
guidance, limitations or cautions regarding this data set.
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Field or Control Description

Owner ID Identifies the product that will own the data set definition and
content.

Is Copyable Selecting this check box indicates that the data included in the
data set definition is suitable for copy from one database to
another. Data is suitable for copy only if doing so will produce
a valid object on the target and not corrupt any other data on
the target. This field is only editable if Allow setting Copy
Compare attributes on ADS definitions is selected for the users
Data Migration security profile.

See Setting Data Migration Permissions.

Derivation Type This indicates if the data set definition was created manually
or generated from a component.

Note: In PeopleTools 8.54, the generate option is no longer
available.

Add Record to Root Select the parent record, which will become the root record
and is placed in the Record Hierarchy section.

View Summary Report Select this link to view the summary report for the data set.

See Running ADS Summary Report

Save As Select this link to clone an existing data set definition. You
will be prompted to enter a new data set definition name.

See Cloning a Data Set Definition

Record Hierarchy

This section shows the record hierarchy for the data set.

There is at least one row for every record in the data set definition. Related language tables are
automatically added by the system.

Note: A related language record can be added as a child record to its base record.

The following icons are used in the record hierarchy:

Icon Description

This icon will appear before each record in the hierarchy that
is included in a merge group.
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Icon Description

Click this icon to add a child record to the hierarchy.

Click this icon to view the record details.

Click this icon to delete a record in the hierarchy.

Note: The root record can not be deleted once the data set
definition is saved.

Use the Insert Record icon to build the record hierarchy and add additional child records.

This example illustrates the fields and controls on the Icon to insert child record. You can find definitions
for the fields and controls later on this page.

When you select the Insert Record icon, a child record insertion dialog will open with child record
lookup. A child record is a record having the same keys as parent record. The child record may also
contain additional keys. The lookup list will be restricted to records that include all keys (and possibly
additional keys) of the corresponding parent record that have not already been selected for the current
parent record name.

In record hierarchy, the related language record plays a significant role. When a record added to a data set
definition (either as root record or as a child record) has a related language record, it is implicitly included
in the data set as a child record.

Note: If you use the delete icon to delete a related language record, a warning message is displayed "Do
you want to delete a Related Language Record? (257,755) Deleting Related Language Record separately
would cause inconsistency between multiple languages". If the user clicks Yes the warning is ignored and
the related language record is deleted. If the user clicks No the related language record remains in the data
set.

You can also use the Details icon to view the keys and labels for a record.
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This example illustrates the fields and controls on the Record Details page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Override Record Report Label The field and record labels are shown in compare reports. The
object owner can override the default record label by entering
a record report label here.

Override Report Label ID The field and record labels are shown in compare reports. The
object owner can select a different field label to use in the
Override Report Label ID column.

Content Type For long character fields, you can indicate if the field should
be rendered in html or text on the compare report.

Mergeable If the field is in at least one merge group, the check box will be
selected.

For more information on merge groups see Defining Groups

Note: A large record hierarchy level in a Data Set may cause performance issues, therefore if the record
hierarchy level is more than 4, a warning is displayed when saving the data set definition.
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This example illustrates the warning message when the level of record hierarchy exceeds 4.

Record Restrictions

The records in data set definitions have the following restrictions:

• Application Data Set definitions can only contain records that are physical tables.

• Data Set Designer allows a record to appear only once in the record hierarchy.

• All records in a data set must have unique keys as defined in the key view of the record in Application
Designer.

• The keys of the parent record must also be keys of the child record, though a child record may have
some keys that are not in the parent record.

• The root record cannot be deleted from the data set hierarchy once the data set has been saved.

When creating a new data set definition, you will have the ability to delete the root record before
saving the definition.
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This example illustrates the delete icon available on the root record.

When you delete the root record, all child records are also deleted. If the root record is deleted, you
can not save the data set definition.

Cloning a Data Set Definition
Save As is used to clone an existing data set definition. To clone a definition:

1. Select PeopleTools, Lifecycle Tools, Migrate Data, Application Data Set Designer.

2. Select the data set definition you want to clone.

3. Click Save As.

4. On the Save Data Set As page, enter a name and description for the new data set, then click OK.

The system will verify that the new data set name does not already exist. If it does, you will be
prompted to enter another name.

In the resulting cloned data set definition:

• All of the original data set definition's properties except for extension property will be displayed.

• The relation name is changed automatically to the new data set name.

• The Owner ID is NULL by default.

Defining Relations

Use the Relations page to define the relationship of this data set to other data sets.

Navigation:

From the General page >  Relations tab.

150  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 9 Using Application Data Set Designer

This example illustrates the fields and controls on the Data Set Designer – Relations page. You can find
definitions for the fields and controls later on this page.

Relations

Field or Control Description

To Data Set Enter the name of the data set to include in the relationship.

Relation Name Enter a name for the relation.

Description Enter a description for the relation.

Long Description Enter a long description for the relation.

From Cardinality Enter the cardinality for the referencing data set.

The values of cardinality are as follows:

• 0..1

0 or 1 (optional)

• 1

exactly 1

• 0..*

0 or more

• 1..*

1 or more
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Field or Control Description

To Cardinality Enter the cardinality for the referenced data set.

The values of cardinality are as follows:

• 0..1

0 or 1 (optional)

• 1

exactly 1

• 0..*

0 or more

• 1..*

1 or more

Relation Mapping

The relation mapping section is used to define a set of foreign key fields in a referencing data set to key
fields in a referenced data set. Enter one row for each key that needs to be mapped.

Both the From (referencing) and the To (referenced) keys can be in either the parent record or child record
of the data set definition.

Field or Control Description

From Data Set Record Enter the name of the record in the current data set that will be
used to map to a record on the To Data Set.

From Data Set Field Enter the name of the field in the current data set that will be
used to map to a record on the To Data Set.

From Set Control Select this check box if the data set uses set control processing
and the set control value is on the From record/field.

To Data Set Record Enter the name of the record in the to data set that will be used
to map to a record on the From Data Set.

To Data Set Field Enter the name of the field in the to data set that will be used
to map to a field on the From Data Set.

To Set Control Select this check box if the data set uses set control processing
and the set control value is on the To record/field.
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Relation Criteria

The Relation Criteria section is used to specify conditions imposed on the relation mapping between
records within the data set definitions. Both the To and From records can be either the root or child
record. This criteria modifies whether or not the relationship applies. The criteria applies to all uses of the
relationship.

The value is a WHERE clause-like expression containing only table names, record names, SQL operators,
and literals. There may be verbs introduced to avoid entering anything other than table name, record
name, SQL operator, and literals.

Use this section to build the WHERE clause.

Field or Control Description

Open If you are entering multiple criteria, select the appropriate
open parentheses necessary to group the criteria.

Record Field Name Enter the record field name. Use the prompt button to see all
the record fields available on both the From and To data sets.

Operation Select the operator. All standard SQL operators are available
from the drop down list.

Values Enter the value or values for your expression.

Details Lookup Icon Use the lookup icon to select values for the record field name
selected.

Close If you are entering multiple criteria, select the appropriate
close parentheses necessary to group the criteria.

Logical When you specify two or more selection criteria, You need to
indicate the logical operator – AND or OR.

Relation Properties

There is an underlying set of relationship APIs used by all the behavioral APIs to get related objects.
In cases where some but not all of the related objects are desired, relation properties are used as filters.
Relationship properties are name, value pairs that are associated with a relationship.
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This diagram illustrates a relationship named X.Y between two instance having data set definitions
named X and Y, respectively. Each instance has one key, whose values are A and B, respectively. The
relationship metadata is part of data set definition X.

PeopleSoft delivers the following relationship properties:

• Family

The Family property is used when there is custom PeopleCode to synchronize merging of two or
more instances in parallel. This can occur when the mergeable attributes in one instance affect values
in another instance. For example, families are used for Pivot Grids, Activity Guides, and Related
Content instances.

• Insert Inverse Relation and Insert into Project

Use there properties is used to designate if and how related objects should be inserted into a project.

The Insert Inverse Relation applies to the backward reference: whether to insert instances referenced
by an instance that is being inserted. For the relation X.Y illustrated in the Definition and Instance
Relationship diagram above, the Insert Inverse Relation property applies to determine whether A
should be inserted when B is being inserted.

The Insert into Project applies to the forward reference: whether to insert instances referenced by
an instance that is being inserted. For the relation X.Y illustrated in the Definition and Instance
Relationship diagram above, the Insert into Project property applies to determine whether B should be
inserted when A is being inserted.

There are 2 value options:

• PROMPT, the user will be prompted whether or not to insert the object type.

• FORCE, the related objects will be inserted even if not selected by the user if the other partner in
the relationship is selected.

• Insert Recursion Limit

The Insert Recursion Limit property is used to define how many levels of relations beyond the nearest
neighbor should be inserted into the project. If not specified, the default is that the insertion applies
only to nearest neighbor.
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• Validate Integrity

The Validate Integrity property is used to verify all required To Data Set instances exist for all From
Data Set instances in the project. Set the severity level for missing references.

• Validate Inverse Relation

The Validate Inverse Relation property is used to verify all required From Data Set instances exist for
all To Data Set instances in the project. Set the severity level for missing references.

Defining Groups

Groups are used to define sets of records and/or fields for which some common processing is required.
The processing is controlled by the properties associated with the groups.

Use the Groups page to define the records and fields to be included in the group, as well as assigning the
group properties.

This example illustrates the fields and controls on the Data Set Designer – Groups page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Group Code Enter a group code.

Group Name Enter a group name.

Description Enter a group description

Group Members

Use this section to add records and fields to the group. The record must exist in the data set and the field
must exist on the selected record.
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Fields are optional. If no field is chosen, the entire record is within the group. Omitting record and field
would be equivalent to an object property.

If the user deletes a record from the data set definition via the tree on the General tab, the corresponding
group members will be deleted. If a field is deleted on a record the file is removed from the group. If the
data set definition is deleted, group rows will be deleted as well. If the records or fields are renamed or
deleted, the group members will be renamed or deleted.

Note: If no field is specified for the record then for the purpose of data integrity, all its child records will
also be added to the group automatically when saving group definition.

Group Properties

Group properties apply to the members of the group.

The following group properties are available:

Group Description

Merge Configurations The MERGE property is used during copy to preserve any
configuration changes made on the target data set instance if
the fields changed are part of this data set group.

Merge group allows the object owner to declare that the
attributes within the group are relations and can be changed
independently of other attributes.

Note: If no field is chosen for a record in the group members,
 then the entire record will be merged. This means the entire
row change and any child rows for the record in target will be
preserved by default. All its child records will also be added to
the group automatically when saving the group definition.

Hide Differences The Hide group allows the object owner to identify records
and fields that are less important and any differences in these
fields can be hidden on the compare report to simplify the
review process.

A group with or without properties can be used in compare visualization for filtering purposes. For
example, it might be useful to create a group of all translatable text attributes, or all position attributes on
a page.

Defining Data Set Properties

Use the Properties page to assign properties to the data set.

Navigation:
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From the General page > Properties tab.

This example illustrates the fields and controls on the Data Set Designer – Properties page. You can find
definitions for the fields and controls later on this page.

The following properties are available on this page:

• HTML Style Sheet

Style sheet to use when rendering HTML in the compare visualization.

• Instance Search View

Name of a view to use when searching for data set instances in the DMW. The search keys specified
on the view will display by default. All keys of the root record must be keys in the specified view.

• Last Updated Timestamp Field

Used together with LASTUPDOPRID to determine the default merge action on compare/copy.

• Last Updated User ID Field

Used together with LASTUPDDTTM to determine the default merge action on compare/copy.

• Managed Object Delete Table

Enter the name of the delete table for the managed object. This information is used to delete cache
when an object is deleted or renamed. Objects that do not have a C++ manager should omit this
property.

• Managed Object Name

Designate the data set as a managed object. If the object has a C++ manager, the property value is the
C++ acronym for that object, such as RDM. Objects that do not have a C++ manager should leave this
blank.

• Managed Object Version

Specify the OBJECTTYPENAME of a row in PSVERSION and PSLOCK for the managed object.
This information is used to synchronize cache when the object is updated. Objects that do not have a
C++ manager should omit this property.
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Defining Extension

Use the Extension page to define the extension application class that will be used by the object owner to
provide custom PeopleCode validate, transforms, and merge data set instances.

Navigation:

From the General page >  Extension tab.

This example illustrates the fields and controls on the Data Set Designer – Extension page. You can find
definitions for the fields and controls later on this page.

The applicant class the user specifies on this page will extend the PTADSDEFN:AdsValidationBase
application class that is part of the data set framework. Specific methods of the AdsValidationBase
application class or its extension class are invoked at a particular time during processing.

There are four areas of functionality controlled by in the AdsValidationBase application class that are
designed to be implemented by object owners:

• DB Integrity Checks

• To File Custom Transforms

• From File Custom Transforms

• From File Custom Merging

Application Class Extension

Developers can extend the PTADSDEFN:AdsValidationBase base class to define specific validation logic.
AdsValidationBase provides an empty implementation of the methods of the Application Class that a data
set definition may be associated with. To provide validation or transformation logic in PeopleCode, a
developer will override the appropriate base class methods and provide additional methods and properties
as necessary.

Validation is implemented in the CustomValidate method. See CustomValidate.
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Important! Unless mentioned in this document as being designed for extension other methods in the
AdsValidationBase base class are used internally so changing or overriding them will modify basic
behavior.

DB Integrity Checks

The Database Integrity Check should be run on the target database after the copy from file to ensure
database integrity.

DB Integrity Checks use the DoADSValidations method provided in the AdsValidationBase base class.
This method will validate for static prompts, translates, Y/N values, and required fields. If a validation
error is detected, information about the error is written to a target database table and DoADSValidations
returns false to the C++ layer. Thus even if no application class has been associated with the ADS
definition, this method will perform the default validations.

To File Custom Transforms

To File Custom Transforms are used by the owners of a few objects to implement custom transform
instances from a newer PeopleTools release to an older release, such as from 8.54 to 8.53. This transform
is applied at copy to file time and on the newer release. The ADS and record definitions of both the newer
and older release must be present.

The transform is implemented in the DoTransform method. See  DoTransform.

From File Custom Transforms

From File Custom Transforms might be used by the owners of a few objects in a few circumstances such
as:

1. To implement custom transform instances from a older PeopleTools release to an newer release, such
as from 8.53 to 8.54.

2. To provide value transforms when data in the object needs to be adjusted in some way.

3. To perform custom merging outside of merge groups.

This transform is applied prior to compare, validate or copy from file time on the newer release. The ADS
and record definitions of both the newer and older release must be present.

The transform is implemented in the CustomTransform method. See CustomTransform

From File Custom Merging

This is for adjusting the automated merging performed when merge groups are present. Attribute values
that are in a merge group are, by default, merged to the source from the target. However, there may be
additional adjustments that need to be made to the object to assure the object has consistent data. In some
cases other objects in the same FAMILY may also be adjusted at this time.

The transform is implemented in the CustomMerge method. See CustomMerge
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CustomValidate

Syntax

CustomValidate(&ADSRowset, &ADSName, &CompareType)

Description

Implemented by object owners to provide custom validation logic.

Parameters

Parameter Description

&ADSRowset Specifies the current in-memory data set instance as a rowset
object.

&ADSName Specifies the ADS name as a string.

&CompareType Specifies the compare type as integer:

• 4 indicates premerge validation

• 1 indicates post merge validation

• 6 indicates Check DB Integrity

The premerge validation is performed only if there are merge
groups in the data set.

Returns

Integer.

 DoTransform

Syntax

DoTransform(&AdsNameArray)

Description

Implemented by object owners to provide custom copy to file transform, often to an older PeopleTools
release.
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Parameters

Parameter Description

&ADSNameArray AdsNameArray is an array of ADSM:AdsNameRowset.

An ADSM:AdsNameRowset is a (data set name, data set
rowset) pair. When the function is called, this array will
contain a single ADS instance in the form of the newer release.
 On return this array will contain 0 or more rowsets in the form
of the target release. There can be more that one output rowset
if the data set in one release was represented as several data
sets in another release. There would be no rowsets in the array
on return if the data set definition did not exist in the older
release.

The target release is passed as a property named TargetRelease
to the AdsValidationBase constructor – this can be used to
determine what transform to apply.

Returns

Integer.

CustomTransform

Syntax

CustomTransform(&ADSRowset,&ADSName)

Description

Implemented by object owners to provide custom transform logic at compare, validate or copy from file
time.

Parameters

Parameter Description

&ADSRowset Specifies the current in-memory data set instance as a rowset.

&ADSName Specifies the ADS name as a string.

Returns

Integer.
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CustomMerge

Syntax

CustomMerge(&ADSRowset,&ADSName,&CompareType)

Description

This method is implemented by object owners to provide custom merge logic. If merge groups are present
in the data set, then prior to compare, validate and copy each instance in the source project file is copied
to memory, and the corresponding target is also copied into memory. The merge groups attributes from
the in-memory source rowset are copied into the in-memory target rowset. The resulting rowset is then
passed to CustomMerge to allow programmatic adjustments.

Parameters

Parameter Description

&ADSRowset Specifies the current in-memory data set instance as a rowset
object.

&ADSName Specifies the ADS name as a string.

&CompareType Specifies the compare type as integer:

• 4 indicates premerge

The premerge call is called after the default merge has
been performed but before compare is run and before the
user modifies merge options.

• 1 indicates post merge

The post merge validation is executed after a user has
changed the merge options and prior to copy.

Flow for the To File Process
The only To File process is Copy to File.

During copy to file the framework iterates over instances in the project, and for each instance calls
the OnCopyToFile base class method. In turn, OnCopyToFile calls DoTransform. The base class
DoTransform makes no changes, but if the derived class implements this method then the source object
may change when copied to the project XML file.

Flow for the From File Processes
The From File processes are Compare from File, Validate from File, Copy from File.
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During From File processing the framework iterates over instances in the project, and for each
instance calls the OnPreCopyCompare then OnPreUpdate base class methods. OnPreCopyCompare is
implemented in the base class to make the roughly following preliminary calls:

1. CustomTransform: any special from file transforms.

2. Validate: standard validations of original source if DB Integrity or Validate is selected.

3. CustomValidate: any special validations.

4. Merge: perform default merge of merge groups. This includes a compare of original source object.

5. CustomMerge: any special adjustments to merge.

6. Compare: compare merged rowset if compare was requested and merging was performed.

7. Validate and CustomValidate: validate merged rowset if validate was requested and merging was
performed.

8. Copy: if copy was requested. If compare was run, then the user’s compare selections will be honored.
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Understanding ADS Projects

Once you have created a data set definition, you can create an ADS project to encapsulate instances of the
data defined by the data set definition allowing the instances to be compared and copied. In the main Data
Migration Workbench page, you first select data set definitions to include in the project, then select the
instances of that data to insert into the project. What ultimately gets inserted into the database is a set of
data set instances each identified by a unique set of root-level keys. The data contents are filtered based
on the keys in the data set.

You can define multiple projects with different criteria for the same data set.

This example illustrates that the content data is defined in an ADS project.

Once data set content has been inserted into a project and security criteria fulfilled on source, the project
can be copied to a file. Once the data set project has been copied to a file, it can be loaded into a target
database and compared from file on the target database.

Note: The target database must contain the Data Set definition that is included in the ADS project file,
however the corresponding ADS structure or the record structure may be different than on the source
database, which may require a shape transform.

Searching for, Adding and Deleting Projects

Use the Project Search page to search for or create new ADS projects.
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Note: You can add data set instances directly to a new or an existing ADS project from the object
designer pages (PIA) by using the Add to Project button rather than navigating to Data Migration Work
Bench page.
SeeAdding Data Set Instances from Object Designer Pages.

Navigation:

PeopleTools >  Lifecycle Tools > Migrate Data > Data Migration Workbench

This example illustrates the fields and controls on the Project Search page. You can find definitions for
the fields and controls later on this page.

When you click the Search button on the Project Search page, a grid displaying projects matching the
criteria is displayed.

Click the Project Name link to open the ADS project for modification.

Deleting Projects

To delete projects:

1. Select PeopleTools, Lifecycle Tools, Migrate Data, Data Migration Workbench.

2. Click Search.

3. Select the projects to delete.

4. Click the Delete Selected Rows link.

Adding Projects

To add a project:

1. Select PeopleTools, Lifecycle Tools, Migrate Data, Data Migration Workbench.
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2. Click the Add a New Value link.

3. Enter a Project Name and Description.

4. Click Add.

Loading Project from File

To load a project from file:

1. Select PeopleTools, Lifecycle Tools, Migrate Data, Data Migration Workbench.

2. Click the Load Project from File link.

3. Select the file location and area.

4. Click Add.

Note: All data set definitions must exist on the target database before you can load the project. Load
project from file only loads the project definition and data set bindings, no data content is copied.

Defining ADS Project

To define a new project:

1. The initial state is New Project. Add a description and comments.

2. Select a data set.

3. When you tab off the data set name, the Insert Data Set Content page is displayed for that data set.

4. Select the data set content.

See Inserting Data Content

5. Save the project. The new status is Created.

6. Additional data sets can be added to the project.

Use the Project Definition page to define the ADS project.

Navigation:

PeopleTools >  Lifecycle Tools > Migrate Data >  Data Migration Workbench
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This example illustrates the fields and controls on the Project Definition page. You can find definitions for
the fields and controls later on this page.

Field or Control Description

Description Enter a description for the project. The description should
include information about the project.

Comments Optionally you can add comments to the project.
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Field or Control Description

Project State Display only field that shows the current state of the project.
 You can use the Refresh button to obtain the most recent state.

Progress state on the source will show:

• New project

• Created

• Scheduled for copy to file

• Copying to file

• Copy to file succeeded

Progress state on the target will show:

• Loaded from file

• Scheduled for file compare

• Comparing from file

• Copying from file

• Compare from file succeeded

• Scheduled for copy from file

• Copy from file succeeded

Validation errors, if any, are also shown.

Progress Display only field that shows the progress of the project copy
or compare.

Data Set Name Select one or more existing data sets from the lookup. Look
up will show all the existing data sets that have Is Copyable
selected in the data set definition.

Content Description This is description associated with the data set content.

Add a new row (+) Click to add another data set to the project.

Delete a row (-) Click to delete a data set from the project.

Note: ADS projects are not shown in Application Designer project search and cannot be opened in
Application Designer.
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Defining Data Set Content

When the data set name is selected on the Project Definition page, the Insert Data Content page will open
when you tab off the data set name field. See Inserting Data Content.

Use the Data Set Content page to review the data content for the project and add additional content.

Navigation:

To add additional data set instances or modify the data set instances in an existing data set, click on the
Data Set Name on the Project Definition page.

This example illustrates the fields and controls on the Data Set Content page. You can find definitions for
the fields and controls later on this page.

Use the Insert Content button to define the data content for the project.

See Inserting Data Content

After data has been inserted into the project, you can select which rows of data you want to process.

Field or Control Description

Select Use this check box to select the rows for one of the actions
available.

Action By default, the action type is Copy. You can change the action
type to Delete.

Select All Use the Select All button to select all rows.
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Field or Control Description

Deselect All Use the Deselect All button to deselect all rows.

Delete Use to delete select rows.

Update Data Set Action Use to change the action for selected rows.

Inserting Data Content

To insert content into the project:

1. Click the link for the data set on the project definition page.

2. Click the Insert Data button.

3. By default the Basic search criteria is displayed.

Note: When you enter a Data Set Name on the Project Definition page, the Insert Data Content page will
open when you tab off the Data Set Name field.

Use the Insert Data Content page to insert data content into the ADS project.

Navigation:

Click the Insert Content button on the Data Set Content page.

This example illustrates the fields and controls on the Insert Data Content page. You can find definitions
for the fields and controls later on this page.
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Field or Control Description

Search Criteria By default the Basic Search Criteria is displayed. Click the
Advanced Search link to access.

Key Field In the Basic Search only the key fields are displayed.

Operation The operations for basic search are based on the search criteria
for the data set definition.

Values Enter the value for the SQL.

Search button Click the Search button to display the rows meeting the filter
criteria and display them on the Search Results grid.

Search Results Grid Use the Search Results grid to select the rows of data to
include in the data set content.

Select All Use the Select All button to select all rows.

Deselect All Use the Deselect All button to deselect all rows.

InsertContent Click the Insert Content button to insert the selected rows into
the data set content and remain on the page.

Insert and Return Click the Insert and Return button to insert the selected rows
into the data set content and return to the Data Set Content
page.

Insert Related Data Sets If the data set selected contains relationships to other data sets,
 the Insert Related Data Sets grid is displayed. Depending on
how the related data sets were defined, they will either always
be included, or the user will be able to select which related
data sets to include in the project.

See Defining Relations.

172  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 10 Understanding ADS Projects

This example illustrates the fields and controls on the Advanced Search Criteria example. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Field Name There are two types of fields in the grid.

• Read-only: These are the key fields of the record selected
while defining the data set definition. These fields can not
be removed.

See Creating and Editing Data Set Definition.

• Non Key: You can add any other non key fields from
the root record of the data set definition. This addition is
not in the data set definition, it is specific to this data set
content in this specific ADS project .
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Field or Control Description

Operation Select the operation to use for this field. Valid operations are:

• != (not equal)

• < (less than)

• <= (less than or equal)

• = (equal)

• > (greater than)

• >= (greater than or equal)

• All

• Between

• In

• Is NULL

• Is Not NULL

• Like (Value contains specified text)

• Not Between

• Not In

• Not Like

Values Enter the value for the SQL.

For every operation other than All you need to supply one or
more values in this text box. Based on the operator and value,
 the system will build the actual WHERE clause for the filter
condition on the root record of the data set definition.

See Using Operators to Build the WHERE Clause.

Using Operators to Build the WHERE Clause
This section provides examples for building WHERE Clauses.

Numeric Operators

For any of the numeric operators, select the operator and provide a value.
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This example illustrates using the equal operation.

Between

The Between operator expects an AND keyword in the values field.

This example illustrates using the Between operation

In

In interprets the , (comma) as the separator for the literals.
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This example illustrates using the In criteria.

Like

Like will implicitly add % (percent sign) with the string.

This example illustrates using the Like operation.
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Adding Data Set Instances from Object Designer Pages

Use the Add to Project button on the object designer pages (PIA) to add data set instances directly to an
existing or a new ADS project rather than navigating to Data Migration Work Bench page.

This example illustrates the fields and controls on the Project Search page.

Click the Add to Project button to open the Project Search page.

Click the Add a New Value link to add the data set instance to a new project or click the Search button to
open a list of matching projects to add the data set instance.

The following example illustrates insertion of data set instances and related data sets.

You have the option to add all related instances into the project.
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When you click the Insert and Return button to add the selected data set instance, a message appears to
confirm the addition of data instance into the project.

Note: After adding data set instances from Fluid pages, such as, Event Mapping page, the Add to Project
window does not close automatically. Click the Close button to close the window.

Similar to Data Migration Work Bench page, you can filter data instances based on multiple search
criteria.

While adding data instances from Fluid pages, such as OpenSearch Dashboards or Event Mapping, utilize
the multiple search criteria to overcome the URL length limit of 2000 characters.

Related Links
Searching for, Adding and Deleting Projects
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Copy Compare Overview

The Data Migration Workbench is used to copy and compare projects.

The ability to compare or copy a project is determined by the data set definition parameter Is Copyable.
The user initiating the copy or compare must also have permission to the data contained in the ADS
Project.

Data Migration Workbench provides the ability to:

• Copy an ADS project to a file.

• Compare an ADS project from file.

• Copy an ADS project from file.

Related Links
Setting Data Migration Permissions

Copy to File
Once the ADS project is defined it can be copied to file. The system will prompt you to select the file
location from the available file locations defined on the Manage File Locations page. When the copy to
file has succeeded, the Project State will be updated to Copy to file succeeded.

Compare
Before you can do a compare, all data set definitions referenced in the project file must also exist in the
target database. There may be cases where the a data set definition is different in the source and target.
Shape refers to the metadata describing the data set instances in the ADS project, including the data set
definition itself, the record definitions that are part of the data set definition, and the fields that are part of
the records that are part of the data set definitions.

Any time there is a shape difference between the source and target data set definition, an implicit data
transform is performed to align the source shape with the target shape. There are 2 categories of shape
changes:

• Regular shape change

This type of shape change is supported by the Data Migration Framework and no custom transform
PeopleCode is necessary. Examples of a regular shape change are:

• Add or remove a record that is included in a data set definition.
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• Add or remove a non-key field from a record that is included in a data set definition.

• Irregular shape change

This type of shape change requires custom transform PeopleCode.

• Change the key structure of a record.

• Change the meaning of a field value.

• Change the field size.

• Add a new data set definition or removing an existing data set definition.

• Provide default values on target that do not exist in the source.

• Change a field type or format.

• Rename a record, field or data set definition.

• Move data from one record to another.

• Refactor by splitting an object into 2 or more objects.

• Refactor by combining 2 or more objects into a single object.

• Change in data migration pathway such as an object formerly migrated using IDE project or Data
Mover is migrated using Data Migration Framework.

Compare looks for the following types of differences:

• Row Difference – Based on the record keys compares if the row exists in both the source and target
databases. All differences will be captured and shown as Absent on the database where the key is not
present.

• Field Difference – The value of a field differs between source and target.

For PeopleTools owned ADS definitions (managed objects), the compare will examine the
LASTUPDDTTM and LASTUPDOPRID fields to detect whether the object has been changed by the
customer. This is the same logic used in an IDE project compare. See Tracked ADS Definitions.

Comparing From File

When you select to compare, the system performs the following:

1. An application engine program is executed that copies each data set instance in the ADS Project from
XML to memory as a PeopleSoft rowset (not to the database) and the corresponding object is copied
from SQL to memory as a different PeopleSoft rowset.

2. The two in-memory rowsets are then compared record-by-record, row-by-row, and field-by-field.

In this case the file is the source and the local node is the target.

3. Any differences found in compare are stored in a table on the target database.
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Note: It is stored in the same table used for managed object compare.

4. The differences found can be seen by running the compare viewer, which reads the compare output
table.

Using Compare Viewer
Once the compare is completed, you can use the viewer to view differences and determine which data set
instances you want to include in the copy.

Copy from File
Once you have reviewed the compare reports on the target database and selected which data set instances
in the project should be copied, you can submit the ADS project for copy. If approval workflow has been
configured for the Data Migration Workbench, you will receive a message that the project has entered the
approval workflow. If approvals are not required for the project or when all approvals have been obtained,
the copy will be scheduled to run through the Process Scheduler.

Note: If there is a shape change in Application owned datasets between the source and target
environments the copy, compare, and validate process will fail.
To correct the shape changes, review and use the logs <filename.stdout> available at Process Monitor >
Details > View Log/Trace

Managing ADS Project File Locations

The project file locations are managed by a system administrator in the Project Repository to restrict the
places where ADS project files can be placed. Before you can copy a ADS project to a file, you must set
up the Project Repository to use. Typically, this task will be performed by a system administrator.

There are two parts to the Project Repository setup process:

1. Creating the file system folders for a specified path and the areas under that path. These folders
should be manually created by a system administrator with appropriate access permissions for those
users who will be starting the application and process scheduler servers or running Change Assistant.
The system administrator should manually create both the path folders and the area folders.

Note: On non-Windows operating systems, folder names are case sensitive. At run-time area names
are upper cased, so the names of area folders should also be upper cased.

2. Registering the path to each directory containing area folders in the database as locations for holding
project files. These registered locations and the area folders within them are the Project Repository.

Use the Manage File Locations page to register paths to valid Project Repository locations.

Navigation:

PeopleTools >  Lifecycle Tools >  Migrate Data >  ADS Project File Locations
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This example illustrates the fields and controls on the Manage File Locations page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Location Name Assign a name for your file location.

Description Optionally add a description for the file location.

Path The specified path must be accessible from both the
application server and the process scheduler server. Absolute
network paths are less prone to issues in this respect as all
servers are not likely to be running on the same machine, thus
may not have access to a local or relative path.

If the application server is on Windows and the process
scheduler server is on non-Windows or conversely, your
system administrator will need to provide special setup to
share files across machine boundaries.

Note: On Windows, you must use a UNC naming convention,
 such as \\<servername>\<sharename>. On UNIX based
platforms, you must use absolute path, such as /<rootdir>/
<subdir/.../<subdir>.

Area The area grid is populated with the sub directories in the path.

Copying Project to File

To copy an ADS project to a file:

1. Select PeopleTools >  Lifecycle Tools >  Migrate Data >  Data Migration Workbench

2. Open the project you want to copy to file.

3. Select the Copy to File  button.
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Note: If you selected to encrypt the project (see Encrypting Data Set Project Files) a message will be
displayed.

This is an example of the encryption message

4. Select the file location and area to copy the file.

5. By default all data sets in the project are selected.

6. Click the Run button.

Note: If the file already exists, you will be prompted whether or not to replace it.

7. On the Process Scheduler Request page, click OK.

The copy will run in the Process Scheduler.

8. Click OK to return to the Project Definition page.

The Project State is displayed. Use the Refresh button to check the progress of the copy.

This example illustrates the fields and controls on the Copy To File page.

Note: If dataset instances are missing from source database, copying to file will continue for the rest of
the ADS objects and a warning message will be issued for the missing objects. To view the message, open
the message log in the Process Monitor page.
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Loading Project from File

In order to load a project from file on the target system the data set definition must exist on the target
database.

When you load a ADS project to the target database, it does not load the data content from the ADS
project. Load from file causes the source project definition to be copied from the file to the target
database. It does not copy the data set instances.

Defining the Data Set Definition on the Target Database
Before the project can be loaded, copied or compared from file, the data set definitions (including
records and fields) must exist on the target database. Depending on the releases and patch level of your
environment, the data set definitions may have different shapes than on the source database.

See Comparing From File

If you have created your own custom data set definition and it does not exist on the target, you can copy
the data set definition using an IDE project.

To migrate the data set definition and related objects using IDE project:

1. On the source database, create a new IDE project in Application Designer. File > New > Project.

2. Insert the data set definitions into the IDE project. Insert > Definitions into Project > select
Definition Type: Data set Definitions > select the specific data set definitions to include > click
Insert.

Insert all the records definitions that are in the data set definition and all the database field definitions
that are in the record definitions.

3. Save the IDE project.

4. Copy the IDE project to a file. Tools > Copy Project > To File > enter the export
directory > click Copy.

5. On the target database, open Application Designer and compare the IDE project from the file.
Tools > Compare and Report > From File.

It is advisable to run a compare to check whether copying the record and field definitions are the same
on the source and target.

6. On the target database, open Application Designer and copy the IDE project from the file.
Tools > Copy > From File.

Note: You also have the option of using Copy to Database, if your environment is set up where both the
source and target databases are available. If any records were changed or added in the IDE project, it will
be necessary to table create or alter to assure that the records exist on the target.

Loading Project on Target Database
To load the data ADS project on the target database:
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1. On the target database, select PeopleTools > Lifecycle Tools > Migrate Data > Data Migration
Workbench > Load Project From File.

This example illustrates the fields and controls on the Load Project From File.

2. Select the File Location and Area. A list of projects in that location will be displayed.

See Managing ADS Project File Locations

3. Select the ADS project to load.

4. Optionally, if you want to run the load from file process asynchronously in Application Engine
through Process Scheduler, select Asynchronous check box.

5. Click Load.

If the data set definition used in the ADS project does not exist on the target database, you will receive an
error message and the project will not load.

Comparing ADS Projects

Data Migration Workbench enables you to compare the data in the ADS project file (source) with the data
in the target database (signed on database).

The compare is always executed from the target database. First you must load the ADS project file and
then execute the compare.

See Loading Project on Target Database

Tracked ADS Definitions
Starting in PeopleTools 8.57, any changes to data sets in the PSADSTRACKITEM table are tracked.
When you run the compare, the compare results for tracked ADS definitions will produce results similar
to the compare results in Application Designer.

Note: Tracked ADS definitions are defined in the table PSADSTRACKITEM.

Comparing From File
To compare an ADS project:
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1. On the target database, select PeopleTools > Lifecycle Tools > Migrate Data >  Data Migration
Workbench.

2. Load the ADS project.

3. Click the Compare button.

4. Select the data sets to compare.

5. Optionally, set the compare options.

See Compare Options

6. Click the Run button.

7. Set your Process Scheduler options and click OK.

The process will be scheduled to run in the Process Scheduler.

8. Click OK again to return to the Project Definition page.

9. Click the Refresh icon on the Project Definition page to see the new status for the project.

Use the Compare button on the Project Definition page to compare a project from a file.

This example illustrates the fields and controls on the Compare From File page. You can find definitions
for the fields and controls later on this page.

Field or Control Description

Data Sets By default all data sets in the project are selected. Use the links
to select or deselect all data sets. Select each data set you want
to compare.
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Compare Complete

When the compare is complete, the project status is updated and the compare report summary statistics
are displayed.

This example illustrates the fields and controls on the Compare Report Summary. You can find definitions
for the fields and controls later on this page.

To view the compare reports see Viewing Compare Reports.

Compare Options
When you select the Options button, three tabs are displayed — Languages, Compare Options and Report
Filter. These options are similar to the compare options available in Application Designer for Managed
Objects.
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This example illustrates the fields and controls on the Languages page. You can find definitions for the
fields and controls later on this page.

Field or Control Description

Include Language-Neutral Data By default this check box is selected.

Language neutral data is data that is not translated. In an IDE
project copy this is referred to as COMMON.

Languages By default all installed languages are selected. Use the links to
select or deselect all languages. Select each language you want
to compare.

Note: This page applies to all data sets.
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This example illustrates the fields and controls on the Compare Options page. You can find definitions for
the fields and controls later on this page.

Note: The compare options Compare By and Target Orientation only apply to Tracked Data Sets .See
Tracked ADS Definitions.

Field or Control Description

Compare By Select Release to compare by the highest release in the target.
 Use the search icon to select other releases in the target. The
Compare process labels definitions as Changed, *Changed 
(custom changed), or %Changed if they have been changed
since the date and time stamp for that release level. This is the
default.

Select Date to have the Compare process label definitions as
Changed, *Changed or %Changed if they have been changed
since the date that you specify.

See Understanding Status

Target Orientation Determines how the Upgrade check boxes are set for
comparing objects based on the user that last modified the
object. To understand the impact of the target orientation, refer
to Understanding Upgrade Action.

Merge Target Configurations If the data set includes mergeable group, this check box is
selected by default.

If the data set does not contain mergeable groups, this box is
not selected and a message is displayed that the project does
not contain any mergeable data sets.
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Field or Control Description

Validate Project Select this check box if you want to validate the project when
it is compared.

By default the check box is selected.

See Validating From File

Ignore Shape Differences This functionality is now disabled. If there is a shape change
in Application owned datasets between source and target
environments, then the copy, compare, and validate processes
fail.

To correct the shape changes, review and use
the logs <filename.stdout> available at Process
Monitor > Details > View Log/Trace.

Note: The compare options Compare By and Target Orientation only apply to Tracked Data Sets .See
Tracked ADS Definitions. For all other data sets, the page is display only.

This example illustrates the fields and controls on the Report Filter page. You can find definitions for the
fields and controls later on this page.

Before performing a comparison, you can select the definition status combinations with which you
generate reports by using report filter options.

The default settings for report filtering show conflicting configured definitions only.

• To reset your selections to the default setting, click the Default button.

• To select all definition status combinations, click the Select All button.

• If you don't want to generate any reports, click the Deselect All button to clear all of the check boxes

Removing Project Compare Sessions
The ADS or MO project compare session details are stored in PSCOMPSESSION table.
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Use the Project Session Administration page to search for a project and remove all or any selected
compare session.

Navigation:

PeopleTools > Lifecycle Tools > Manage ADS-MO Project Sessions

This example illustrates the fields and controls on the Project Session Administration page.

Note: Once the compare session is deleted, the related comparison details stored in the
PSCOMPOBJDIFF table also gets deleted.

Viewing Compare Reports

After the compare process has completed, a compare summary is displayed on the Project Definition
page.

Navigation:

PeopleTools > Lifecycle Tools > Migrate Data > Data Migration Workbench
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This example illustrates the fields and controls on the Project Summary page showing compare results.
You can find definitions for the fields and controls later on this page.

Project Content Grid

On the target database, the Project Content grid displays all data set definitions currently in the project,
but prevents changes to the project. Statistics are displayed for each data set definition in the project
indicating the count of data set instances based on type. Reviewers can use the filters to further assist in
determining where the changes or issues are located.

By clicking one of the hyperlinks displayed in the grid, you can drill in to view the data instances in the
project for each data set. When compare or validation counts are displayed, they indicate a count of data
set instances, not the number of fields compared or validated within each instance.

For large projects, use the Zoom Project Content and Search icons to find a specific data set.

Clicking on a compare or validation count will set the filter criteria on the content page appropriate to the
selected count. Clicking on the data set name hyperlink will show the content page unfiltered.

Field or Control Description

Data Set Name Each instance of the data set names is displayed as a hyperlink.
 When you click the hyperlink, the compare report for that data
set instance is displayed.

Add The count for additions is displayed as a hyperlink.

Add indicates the root record in the data set instance is new
and the action is copy.
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Field or Control Description

Delete The count for deletions is displayed as a hyperlink.

Delete indicates that all records in the data set instance are to
be deleted and the copy action is delete.

Change The count for changes is displayed as a hyperlink.

Change indicates that either the root record has changes, or
another record in the data set instance is changed, added or
deleted, and the copy action is copy.

Same The count for same is displayed as a hyperlink.

Same indicates that the data set instance is the same on both
the source and target after customizations from the target are
applied. If there are customizations that differ from the source
value, the action is set to None and can be viewed in the
details for the data set instance. If there are no customizations
to be merged, same indicates the source and target have the
same values.

Messages The count for messages is displayed as a hyperlink. Only
Warning and Error messages are displayed.

Filters

Expand and use the filters section to limit the result set shown in the Data Set Content grid. The filter will
also alter the statistics shown for each data set object in the project. All criteria specified are cumulative.

This example illustrates the fields and controls on the Filters section. You can find definitions for the
fields and controls later on this page.
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Field or Control Description

Message Type Select which message types to display. If there are any errors
or warnings the Message column will indicate the total number
of messages.

Type Select the results types to display.

Action Select which copy actions to display. Any will display the
count for all copy actions.

Upgrade Upgrade status is Yes or No. Any will display the count for all
statuses.

Done Done status is Yes or No. Any will display the count for all
done statuses.

Viewing Data Set Content
Use the Data Set content page to review and update the copy action for each instance of a data set.

This example illustrates the fields and controls on the Compare Report page. You can find definitions for
the fields and controls later on this page.

Filters

The same filters available on the Project Definition page are available for the data set instances. Use the
filters to limit the data set content display. All criteria specified are cumulative.

Data Set Content

The data set content section provides the copy action and whether or not the copy has been done at the
data set instance level.
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Field or Control Description

Source The source is the file that was loaded from Load Project from
File.

The source status is determined based on whether or not the
data set is tracked, as well as the last user and date/time stamp.
 See Understanding Status

Target Target is the database you are currently logged onto.

The target status is determined based on whether or not the
data set is tracked, as well as the last user and date/time stamp.
 See Understanding Status

Action Indicates the copy action for the data set instance, the copy
action will be:

• Merge

• Copy

See Understanding Copy Actions

Upgrade Indicates whether or not to perform the selected action.

For Tracked Data Sets, whether or not the upgrade check box
is selected, depends on the orientation selected.

See Understanding Upgrade Action

Done When the Copy from File has completed, the Done check box
will be checked.

Details Use the Details icon to view the details for the data set
instance.

Note: The details icon is displayed if there are differences
based on the report filter selected when the Compare was run.

Messages Click the message icon to view any messages for the data set
instance.

Note: Only errors and warning are displayed.
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Understanding Status
This table lists the possible statuses for the source and target.

Status Description

Same The ADS instance is the same in both databases. When an
instance in one database has this status, its counterpart in the
other database will have the equivalent status.

Changed The ADS instance’s LASTUPDOPRID value is PPLSOFT
and the LASTUPDDTTM value is greater than the date/time
stamp of the comparison release database. This indicates that
PeopleSoft modified the instance since the comparison release.

Unchanged The ADS instance’s LASTUPDOPRID value is PPLSOFT and
the LASTUPDDTTM value is less than or equal to the date/
time stamp of the comparison release database. This indicates
that PeopleSoft modified the instance prior to the comparison
release.

*Changed The ADS instance’s LASTUPDOPRID value is not PPLSOFT
and the LASTUPDDTTM value is greater than the date/time
stamp of the comparison release database. This indicates that a
customer modified the instance since the comparison release.

*Unchanged The ADS instance’s LASTUPDOPRID value is not PPLSOFT
and the LASTUPDDTTM value is less than or equal to the
date/time stamp of the comparison release database. This
indicates that a customer modified the instance prior to the
comparison release.

Absent The ADS instance is found in the other database, but not in
this one. When upgrading to a new PeopleSoft release, all new
PeopleSoft instances should have Absent status in the target
database and all of your custom instances should have Absent
in the source database.

%Changed The ADS instance does not contain any tracking data. All
untracked ADS definitions will have the status %Changed.

This status will also appear for tracked ADS definitions when
the source project is in an older release that does not contain
any tracking data.

See Tracked ADS Definitions

Understanding Copy Actions
The copy actions available will depend on the data set instance.
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Merge

The merge action is only available when the data set contains one or more mergeable groups. Merge
applies to the data set instance and will copy the data based on the individual group instance selections
made in the detail compare report.

The default action for a merge group depends on the LASTUPDOPRID. If the LASTUPDOPRID on
the target database is not PPLSOFT, the action is set to None. If the LASTUPDOPRID is PPLSOFT the
action is set to Copy.

Copy

The copy action is used to copy the data from the source database to the target database.

Understanding Upgrade Action
Whether or not the Upgrade check box is selected, depends on the source and target status, action and
orientation selected for the comparison. The orientation only applies to tracked data sets. The status of
%Changed indicates no tracking data is available or the definition is in an older release that does not
contain any tracking data.

Source
Status

Target Status Action PeopleSoft
Vanilla

Keep Customizations

Absent Changed or Unchanged DELETE True True

Absent *Changed or
*Unchanged

DELETE False False

Changed Absent COPY True True

Changed Changed or Unchanged COPY True True

Changed *Changed or
*Unchanged

COPY True False

Unchanged Absent COPY True True

Unchanged Changed COPY False False

Unchanged Unchanged COPY True True

Unchanged *Changed or
*Unchanged

COPY True False

*Changed Absent COPY True True
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Source
Status

Target Status Action PeopleSoft
Vanilla

Keep Customizations

*Changed Changed or Unchanged COPY False True

*Changed *Changed or
*Unchanged

COPY True True

*Unchanged Absent COPY True True

*Unchanged Changed or Unchanged COPY False True

*Unchanged *Changed COPY False False

*Unchanged *Unchanged COPY True True

%Changed %Changed COPY True True

%Changed *Changed, *Unchanged,
 Changed, Unchanged, or
Absent

COPY True True

*Changed,
 *Unchanged,
 Changed,
 Unchanged, or
Absent

%Changed COPY True True

Absent %Changed Delete True True

Compare Report Details
Use the CompareReports page to review the changes and update or change the Upgrade action. Click the
Details icon for the data set instance.
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This example illustrates the fields and controls on the Compare Report Details page. You can find
definitions for the fields and controls later on this page.

Action Summary

Action Summary displays Instance Level and Configurable Group Level.

• Instance Level — The current data set instance is displayed with the copy action and copy status. The
copy action is display only and derived from the Group Actions selected in the Configurable Group
Level. You can select whether or not to perform the upgrade.

• Configurable Group Level

• Group action in a specific configurable group can be None or Copy.

• Group action for “Non-Configurable Group” is Copy and can not be changed.

• If group actions for all configurable groups are changed to Copy, the instance level action status
will be Copy.

• “Custom Merge Group” is a special configurable group that uses CustomMerge in the ADS’s
extension class. The action change for “Custom Merge Group” will impact the instance level
action. Once the group action is changed from None to Copy, the instance level action will be
Copy. All other configurable groups will also be set to Copy.

Compare Report Grid

The compare report details for the data instance are displayed in the Compare Report grid. Click the
Group Name in the Action Summary, Configurable Group Level to display the details for the group.
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Field or Control Description

# The number for the record. Each field on the record will be
assigned the number of the record with a decimal value for the
field.

Group Name Description of the record.

Group Action Group action will be:

• None - the target data is retained.

• Copy - Copy the data from source to target.

Note: The group action can be changed in the Configurable
Group Level.

Row Description Description of the row.

Field Description Description of the field.

Source Value Displays the value on the source. This is the value in the
project file that was loaded for this data set instance.

Current Target Value Displays the current value in the target database.
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Compare Report Addition page

This example illustrates the fields and controls on the Compare Report Addition page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Record Name Displays the record name.

Field Name Displays the field name.

Key Labels Displays the key names.

Key Value Displays the key value.

Compare Report for Data Sets without Groups

If the data set does not contain groups, the Configurable Group level will only contain the Non-
Configurable Group.
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This example illustrates the fields and controls on the Compare Report details for data set without groups.

Using ADS-MO Unified Compare Review

ADS-MO Unified Compare Review is used with PeopleSoft Update Manager (PUM). When an update
change package contains both Managed Objects (MO) and Data Set projects (ADS), Change Assistant
will create a unified compare report that contains both MO and ADS project compare results.

Note: The ADS-MO Unified Compare Review is only available if the target database is on PeopleTools
8.57 and above

This diagram describes the PUM process for creating the online ADS-MO Unified Compare Review
report, which unifies the MO and ADS projects.

The change package will contain a step for Defining the Managed Object Compare Review, this step
combines the compare results from Running CP Compare Reports and Compare ADS MO Project From
File into a single compare review. There is a manual step Reviewing CP Compare Reports. To review the
compare report, sign on to the browser for the target database and select PeopleTools, Lifecycle Tools,
Migrate Data, ADS-MO Unified Compare Review.
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Viewing ADS-MO Unified Compare Review
On the target database, the ADS-MO Unified Compare Review grid displays all the object types in the
project. Statistics are displayed for each object type in the unified project indicating the count based on
object type:

• Non-comparable objects, such as Access Groups, Trees, Cube Definitions and so forth will display a
summary count for Add, Delete, Change, Same and Messages as 0 since no compare report exists for
these objects.

• Managed Objects, such as Activities, Records, Fields, Components and so forth will display the count
for Add, Delete, Change and Same. No messages are displayed for Managed Objects.

• Data Set Definitions, such as PIVOTGRID_DEFINITION, ACTIVITY_GUIDE_ITEM,
RCF_SERVICES, and so forth will display the count for Add, Delete, Change, Same and Messages.

By clicking on one of the hyperlinks displayed in the grid, you can drill in to view the object instances in
the project for each object type.

Navigation:

PeopleTools > Lifecycle Tools > Migrate Data > ADS-MO Unified Compare Review

The review name is the same as the name of the change package by default. User does have the option of
providing a different report name by changing the options in step Defining the Managed Object Compare
Review before running that step in the template.

This example illustrates the fields and controls on the Compare Review Workbench page. You can find
definitions for the fields and controls later on this page.

Field or Control Description

Object Type Each object type is displayed as a hyperlink. When you
click the hyperlink, the compare report for that object type is
displayed.

Description Object description (read only)
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Field or Control Description

Add The count for additions is displayed as a hyperlink.

For Managed Objects and Data Sets, Add indicates the objects
are new and the action is copy.

Delete The count for deletions is displayed as a hyperlink.

For Managed Objects and Data Sets, Delete indicates the
objects are to be deleted and the copy action is delete.

Change The count for changes is displayed as a hyperlink.

For Managed Objects and Data Sets, Change indicates the
object contains changes and the copy action is copy.

Same The count for same is displayed as a hyperlink.

• For Managed Objects, Same indicates the object is the
same on both the source and target.

• For Data Sets, Same indicates that the data set instance
is the same on both the source and target after data from
the merge group is merged. If there are differences in the
merge group, the action is set to Keep and can be viewed
in the details for the data set instance.

Messages Messages are produced for ADS validations. For Data Set
definitions, the count for messages is displayed as a hyperlink.

Since no validation is performed on Managed Objects, the
count will always be 0 (zero) for Managed Objects.

Viewing the Managed Objects Content
To view the Managed Object Content, click the link for the Managed Object on the Compare Review
Workbench page.
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This example illustrates the fields and controls on the Example Content page for Components. You can
find definitions for the fields and controls later on this page.

The grid is similar to the upgrade view in Application Designer. You can change the Action and Upgrade
columns for each row. Use the Details link to display the details.

Click Compare Options link to view the compare options.

This example illustrates the fields and controls on the Example of Compare Options for Managed Objects.

For more information on Managed Object compare reports, see Working with Definition Status

Example Component Compare Report Details

This is an example of the details in a component compare report.
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This example illustrates the fields and controls on an example Unified Compare Report. This is similar to
the report in Application Designer.

Use the First, Next, Previous and Last buttons on the page to navigate between pages in the compare
report containing multiple pages.

Clear the All Descriptions check box to hide all duplicate column values. If you select the All
Descriptions check box, values of all the columns are shown even if the values are same for all the rows.

PeopleCode Object Compare Report

When you select to view the details for PeopleCode, the unified report provides additional buttons at the
top of the page to assist in viewing the PeopleCode differences.

This example illustrates the fields and controls on the Unified PeopleCode Report. In this example First
Difference was selected and the first difference is highlighted.
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Click the buttons at the top of the page to navigate to the differences in the PeopleCode.

Viewing Data Set Content
To view the Data Set Content, click the link for the Data Set on the Compare Review Workbench page.

This example illustrates the fields and controls on the Example Content page for PivotGrid Definition
Data Set.

Similar to viewing the compare report in Data Migration Workbench, you can change the action and
upgrade columns after reviewing the details.

Click Compare Options link to view the compare options.

This example illustrates the fields and controls on the Compare Options for ADS data set objects.
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Viewing Validation Reports

Validation is initiated by one of the following processes:

• Check Integrity

On the source database, click Check Integrity on Project Definition page.

See Checking Integrity

• Validate From File

On the target database, click Validate on Project Definition page.

See Validating From File

• Copy From file

On the target database, click Copy From File on Project Definition page and select the Validate
Project check box.

When the validation process is complete, the Project Definition page is updated to indicated the message
count. Depending on which process was run, you may see additional columns in the data content grid.

This example illustrates a project that contains validation errors.

Term Definition

Filters Use the filters section to limit which validation message to
display the count for.
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Term Definition

Message Click the hyperlink for the message count to display the
messages.

Click the hyperlink in the Messages to view the data content.

This example illustrates the fields and controls on the Data content page for validation.

The data set instances that contain errors or warnings are displayed.

Term Definition

Warning message

Error message

Click on the message icon to view the message details on the Validation Report page.
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This example illustrates the fields and controls on the Validation Report page.

You can also use the Filter By section to display the report based on filters for record name, message
severity or any combination of those filters. Select the Show Results Without Merge check box to view
the messages if merge were disabled. This option can help the reviewer to decide whether to keep
configurations or copy from source.

The report has 5 columns:

Term Definition

Record Name The name of the record.

Validation Type The type of validation error.

Message Severity Indicates the severity of the error.

Message Text The message text.

Explanation An explanation of the message.

Submitting for Copy

To copy the project from file:

1. Select Select PeopleTools >  Lifecycle Tools >  Migrate Data >  Data Migration Workbench.
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2. Select the Submit for Copy button.

3. Select the languages to copy.

4. Select the data sets to copy.

5. Select which options to run.

6. Click the Run button.

7. Click OK.

If Approval Framework has been configured, the request will enter the approval workflow, otherwise
the process is scheduled in the Process Scheduler.

This example illustrates the fields and controls on the Copy From File page. You can find definitions for
the fields and controls later on this page.

Select the Options button to set the copy languages and copy options.

This example illustrates the fields and controls on the Copy Options page. You can find definitions for the
fields and controls later on this page.
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Field or Control Description

Merge Target Configurations Select this checkbox to indicate that the process should
observe all merge actions as defined in the project. If the
checkbox is de-selected, no data set instances will be merged.

Validate Project Select this checkbox to validate the project when it is copied.

Check Integrity After Copy Select this checkbox to run an integrity check after the copy
completes.

Refer to Scheduling and Approving Copy from File for approving the request.
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Understanding Data Set Validation

The purpose of Data Set validation (Validate/Check Integrity) is to check data validity based on rules
defined on record fields (metadata), for example, whether a field value can be empty. Data can be
validated from either the project file (Validate) or database (Check Integrity). The validation rules are
always stored as metadata in database.

• Validation

Data will be validated come from project file.

• Check Integrity

Data will be validated come from database.

There are two types of validation:

• Basic Validation

Provides the default validations.

• Custom Validation

Extension application class (defined in the Data Set Definition) that extends the base validation class
to define specific validation logic.

See Defining Extension

Basic Validation

Basic validation is used to check that the data set instances in a project are correct against their metadata
in the database. This table lists the validations performed:

Validation Operation Description

Translate For record fields defined as edit type Translate Table Edit,
check if field value is in the translate table.

Yes/No For record fields defined as edit type Yes/No Table Edit, check
if all yes/no fields contain yes or no data only.

Required For record fields defined as Required, check if all Required
fields contain data.
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Validation Operation Description

Prompt For record fields defined as edit type Prompt Table Edit, check
if the field value is contained in the prompt table.

Reference For references defined in Relations in the Data Set Designer,
 check if the references for data set instances in the project are
correct.

When and Where to Run Validation

Validation and Check Integrity can be run in various stages in the data migration process. When they are
run will determine the validation that takes place.

• Check Integrity

Stage Database UI Control Description

Before Copy to File Source Check Integrity button Performs all basic edits.

Before Compare/Copy From
File

Target Check Integrity button Performs all basic edits.

Copy From File Target Check Integrity After Copy
checkbox on the Copy From
File page

Performs all basic edits.

After Copy From File Target Check Integrity button Performs all basic edits.

• Validate

Stage Database UI Control Description

Before Compare/Copy From
File

Target Validate button Performs translate, Yes/No,
 and Required edits, does not
include prompt and reference
edit.

Compare From File Target Validate Project checkbox on
Compare From File page

Performs translate, Yes/No,
 and Required edits, does not
include prompt and reference
edit.
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Stage Database UI Control Description

Copy From File Target Validate Project checkbox on
Copy From File page

Performs translate, Yes/No,
 and Required edits, does not
include prompt and reference
edit.

Checking Integrity

To run the integrity check on your project in the source database:

1. Select PeopleTools > Lifecycle Tools > Migrate Data > Data Migration Workbench.

2. Open the project.

The project status must be Created or Check integrity succeeded.

3. Click Check Integrity.

4. Select the data sets to check and click Run.

5. On the Process Scheduler Request page click OK.

6. Click OK to return to the Project Definition page.

7. Use the Refresh button to check the progress of the copy.

8. When the check integrity report succeeds, the message count for each data set is displayed in the
project content grid.

9. To view only errors and warnings, use the Message Type filter.
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This example illustrates the fields and controls on the Check Database Integrity results. The 2 in the
message column indicates that integrity errors exist..

For information on viewing the validation reports see Viewing Validation Reports.

Validating From File

To run the validate from file.

1. On the Target database, select PeopleTools > Lifecycle Tools > Migrate Data > Data Migration
Workbench.

2. Select the project.

3. Click the Validate button.

4. Select the data sets to validate.

5. Click the Options button to select or deselect to Merge Target Configurations.

Note: The Ignore Shape Differences functionality is disabled. If there is a shape change in
Application owned datasets between source and target environments, then the copy, compare, and
validate processes fail.
To correct the shape changes, review and use the logs <filename.stdout> available at Process Monitor
> Details > View Log/Trace.

6. Click the Run button.

7. On the Process Scheduler Request page, click OK.
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8. Click OK to return to the Project Summary page.

9. The Project State is displayed. Use the Refresh button to check the progress of the copy.

This example illustrates the fields and controls on the Validate From File page.

Validate from File Results

When the Validate From File process completes, the project content grid is updated with the message
count for each data set.

For information on viewing the validation reports see Viewing Validation Reports.
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Running ADS Summary Report

The Data Set Summary report enables you to produce a report to view all of the information contained in
the data set definition pages including general, relationships, groups, and properties. Optionally, you can
also include overlapping data sets, referenced data sets, and referencing on the report. The report can also
be produced in PDF format.

Data Set Summary Report Page
Use the Data Set Summary Report page to run a report that provides a summary of the data set.

Navigation:

PeopleTools >  Lifecycle Tools >  Migrate Data > ADS Summary Report

The Data Set Summary Report can also be accessed directly from the Data Set Designer by clicking the
View Summary Report link on the General page.
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This example illustrates the fields and controls on the Data Set Summary Report page. You can find
definitions for the fields and controls later on this page.

Search Criteria

Use the Search Criteria section to select the data set or sets for the report. Click Search after entering the
search criteria and the report will be displayed.

Field or Control Description

Data Set Name Select or enter the data set name.

Overlapping Data Sets Select to include all data sets that contain a record included in
the record hierarchy of the selected data set.

Referenced Data Sets Select to include data sets that are defined in the relation to the
selected data set.

Referencing Data Sets Select to include data sets where the selected data set is
defined in the relation.

Export to PDF Select this button to export the report to a PDF file.
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Relevant Data Set

This section will list the data sets returned from the search with the description and deviation.

This example illustrates the selecting the data set RCF_SERVICES to include overlapping, referenced and
referencing data sets.

Field or Control Description

Data Set Name Data set name.

Description Data set description.

Deviation There are 3 values:

• Overlapping

The record hierarchy of this data set has some
overlapping with the one of data set selected in search
criteria, only the first overlapping record is displayed in
parenthesis.

• Referenced

This data set was the referenced data set of selected/input
data set in search criteria

• Referencing

This data set was the referencing data set of selected/input
data set in search criteria
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Data Set Summary

The Data Set Summary section has 4 groups: General, Relations, Groups, and Records.

This example illustrates the fields and controls on the Data Set Summary section. You can find definitions
for the fields and controls later on this page.

• General

This section shows:

• Data Set Name

• Owner ID

• Is Copyable

• Record Hierarchy: The '-' character in front of the record name means that this record has child
record(s).
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• Object Properties: Each property displays in one line with the format of PropertyName :
PropertyValue.

• Extension class Name: Full path of the application class, including the package name.

• Customized Methods: Displays which methods are overwritten(implemented) by the object
owner. Methods include: CustomMerge, CustomValidat, DoRowsetValidations, DoTransform,
CustomTransform, OnPreUpdate, or OnPostCopy.

• Relations

This section shows:

• Relation Name

• To Data Set Name

• From Cardinality

• To Cardinality

• Relation Mapping: Each mapping is displayed in one line with the format of
recordName.fieldName : recordName.fieldName (the first part is from From Data Set, while the
second part is from To Data Set).

• Relation Criteria

• Relation Properties: Each property is displayed in one line with the format of PropertyName :
PropertyValue.

• Groups

This sections shows:

• Group Code

• Group Name

• Group Members: Each record field occupies one line with the format of recordName.fieldName.
If no field name was specified, we the recordName is displayed.

• Group Properties: Each property is displayed in one line with the format of PropertyName :
PropertyValue

• Records

Expand this section to view the records in the data set.

Related Links
Creating and Editing Data Set Definition
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Understanding ADS Administrator Reports

Many of the delivered ADS definitions are complex and may include relations, properties, groups, and
app class extension to do custom validate, merge, and/or other transforms.. The delivered Administrator
reports consist of metadata reports and security reports.

Administrative reports provide information on data sets and are grouped by category. This table lists the
delivered categories:

Report Category Description

Properties Reports about data set level properties.

Security Reports about data set level security, and privileged users, and
so forth.

Relations Reports about data set relations and relation properties.

Extended Reports about data sets containing customized code or reports
about data sets containing extended code, such as merge,
 validation or transform.

Groups Reports about groups, such as mergeable groups, and so forth.

Language Reports about language records in data sets.

Security Reports
Access groups are used to determine which records the user has access to in Data Migration Workbench.
For delivered data set definitions, it is necessary to add the access groups to the Data Migration page
of the appropriate permission list. The ACCESS_GRP_RECORDS report shows the access groups
associated with each data set.

Copy and Compare access rights determine the access permission for copying and comparing ADS
projects.

Privileged users are users that have full access to upgrade, which allows the user to copy any record
without checking the specific authorization for that record.

This table lists the delivered security reports:
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Report Description

ACCESS_GRP_RECORDS Access groups for each data set.

PERM_CC_ACCESS Copy/compare access rights defined by permission lists for
each data set.

PRIVILEGED_USERS Privileged users who can bypass data set records security
check.

DEFN_CC_ACCESS Copy/compare access rights for each data set.

Metadata Reports
This table lists the delivered metadata reports by category.

Report Name Category Description

CUST_MERGE Extended Data sets containing custom merge code

CUST_VALIDATION Extended Data sets containing custom validation
code

SHAPE_TRANSFORM_OUTPUT Extended Data sets containing custom CopyToFile
transform code

MERGEABLE_FIELDS Groups Data sets and their mergeable records

MO_DATA_SETS Properties Data sets that are managed objects

DAT_SET_RELATIONS Relations Data sets and their related data sets

DATA_SET_RLR Languages Records with related language records in
data sets

Running ADS Administrator Reports

To run ADS Administrator Reports:

1. Select PeopleTools, Lifecycle Tools, Migrate Data, ADS Administrator Reports.

2. On the Administrator Report page click Search.
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3. Click the Run icon for the report you want to run.

Note: In order to run Administrator Reports, the user must have been granted the Read Only Access  for
Copy Compare Report permission. SeeDefining Copy Compare Report Permission

Administrator Reports Search Page
Use the Administrator Reports Search page to search for existing administrator reports.

Navigation:

PeopleTools > Lifecycle Tools >  Migrate Data > ADS Administrator Reports

This example illustrates the fields and controls on the Administrator Reports Search page. You can find
definitions for the fields and controls later on this page.

Click the Run icon for the report you would like to run, or click the report name link to open the report
definition page.
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This example illustrates the fields and controls on the Example of Access Group report.

Report Definition Page
Use the Report Definition page to run an administrative report.

Navigation:

From the Administrator Reports Search page, click the report name link in the search results grid.

This example illustrates the fields and controls on the Report Definition page.

Click Run to run the report.
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Understanding Data Set Security

The Application Data Set (ADS) framework allows users to:

1. Define the shape of business objects as data set definitions.

2. Define the contents of a data migration project.

3. Copy or compare the data migration projects to and from files.

Data sets may contain sensitive data, therefore it is critical to define security for data set functions and
services. Security for data sets includes security to:

• Create data sets and ADS projects.

• Copy ADS projects to file.

• Compare ADS projects from file.

• View compare reports.

• Copy ADS projects from file.

• Encrypt data set project files.

• Modify PeopleTools owned data sets.

Important! PeopleTools owned data set are delivered as read-only and should not be modified. Any
modifications necessary will be delivered in an update available from PUM.

This table provides a summary of the security used with ADS.

Access To Set In Details

ADS pages User profile

See Assigning Data Set Permissions to
Users

ADS Designer role

Access Group permission to the access
groups that contain the records in the
data sets.

Permission List - Data Migration page -
Access Group Permission link.

See Defining Access Group Permissions

The access groups are used to determine
which records the user has access to in
Data Migration Workbench.
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Access To Set In Details

Copy Compare Report permissions Permission List - Data Migration page -
Copy Compare Report link.

See Defining Copy Compare Report
Permission

Grant access to copy and compare data
migration projects.

Grant access to edit and run reports on
data sets.

Upgrade Permission List - PeopleTools page -
Application Designer link

See Setting Upgrade Permissions

Grant Full Access to Upgrade.

Full access to upgrade allows the user
to copy any record without checking the
specific authority to that record.

PeopleTools Data Access Permission List - PeopleTools page

See Setting PeopleTools Data Access

Select PeopleTools Data Access to grant
access to modify PeopleTools owned
data sets.

File Repository System Administrator creates a directory.

See Managing ADS Project File
Locations

The project repository location must be
accessible in order to load, copy and
compare data migration projects.

Assigning Data Set Permissions to Users

PeopleSoft delivers the role ADS Designer that grants access to the ADS components. Assign this role to
any user that needs access to create and use data sets.

The permission list PTPT3500 provides access to the Migrate Data pages. This permission list is included
in the role ADS Designer.

Component Reference Page

Data Set Designer PTADSDEFNSEARCH

PTADSDEFNSEARCH_AD

PTADSDEFNSEARCH_GC

Data Migration Workbench PTADSDMWSEARCH

PTADSDMWPRJDEFN

PTADSDMWCONTENT

Copy Project to file RUN_PTADSAEPRCS

Compare Project RUN_PTADSAEPRCS
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Component Reference Page

Manage File Locations PTPRJREPOSDEFN

Administrator Reports PTADSADMINRPTSRCH

PTADSADMINRPT

Data Set Summary Report PTADSSUMRPT

Setting ADS Project File Permissions for UNIX Users
PeopleSoft provides an option to choose whether to grant read and write permissions to ADS project files
to other UNIX users.

Select the Set project files permissions to allow access to all users (UNIX) option on the ADS Options
page (PeopleTools, Lifecycle Tools, Migrate Data, ADS Options).

This example illustrates the ADS Options page with Set project file permission for UNIX users selected.

By default this option is deselected.

When this option is deselected, data set project files created while Copy to File operation will have
default permissions. This provides read and write permissions only to Owner and Group users, such as
PeopleSoft administrators.

Select this option to provide read and write permission to data set project files for other UNIX users.
The other UNIX users can be users in the development environment who do not have administrative
privileges.

When you enable access to other UNIX users, it allows inter-application access between development and
production environments where there are different users belonging to different groups.
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Note: This feature is applicable only for UNIX systems. There is no change in permissions for data set
project files on non-UNIX system.

Setting Data Migration Permissions

Use the Data Migration permissions page to set the security for migrating data and running administrative
reports.

Navigation:

1. PeopleTools> Security> Permissions and Roles> Permission Lists.

2. Select the permission list to update.

3. Select the Data Migration tab.

This example illustrates the fields and controls on the Data Migration Permissions page. You can find
definitions for the fields and controls later on this page.

The Data Migration page has links to the Access Group Permissions page, where you can define the
records to which the user can have access in the Data Migration Workbench, and the Copy Compare
Report Permission page, where you can define the copy and compare operations that the user can
perform, as well as permission to run administrative reports.

Defining Access Group Permissions
Use the Permission List Access Groups page (SCRTY_ADS_ACC_GRPS) to define the query tree and
access groups, as well as the read and write privileges.

Note: If the permission list grants full access to Upgrade, it is not necessary to include all of the access
groups for a Copy from File. The access group security is always used when creating a data migration
project.

Navigation:

Click the Access Group Permission link on the Data Migration page.
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This example illustrates the fields and controls on the Permission List Access Groups Page. You can find
definitions for the fields and controls later on this page.

Access groups are nodes in a query tree, which you build with Query Access Manager. After you build a
query tree, you give users access to one or more of its access groups. Then, they can generate queries on
any tables in the access groups accessible to them.

ADS uses the query trees defined in Query Access Manager (PeopleTools, Security, Query Access
Manager).

Users who have access to Data Set Designer can create data set definitions for any records in the database,
however in order to copy or compare the data set, the user must have permission to an access group that
contains the records to be copied or compared.

To add an access group to a permission list:

1. Open the permission list and select the Data Migration tab > Access Group Permissions.

2. Select a tree name.

3. Select the highest access group that the user can access.

The system displays access groups in the selected query tree only.

The access group that you select should be the highest-level tree group to which this permission list
needs access.

4. Select the Read check box to grant the user access to the compare reports for this access group.

Note: Read access is enough for Copy to file and Compare operations.

5. Select the Write check box to grant the user access copy data for this access group from a file.

Note: Write access is required for Copy from file.

6. Save your changes.
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Read Write Privileges

Operation Permission Required

Copy to file Read

Copy from file Write

Compare from file Read

Defining Copy Compare Report Permission
Use the Copy Compare Report Permission page (SCRTY_ADS_PROFILES) to define the access
permission for copying and comparing ADS projects.

Navigation:

Click the Copy Compare Report Permission link on the Data Migration page.

This example illustrates the fields and controls on the Copy Compare Report Permission page. You can
find definitions for the fields and controls later on this page.

Copy Compare Permissions

Use this section to specify the copy and compare options available.
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Field or Control Description

Access Select the appropriate access level. Options are:

• Full Access: Enables user to copy and compare the data
set.

• No Access: User can not copy or compare the data set.

• Read-Only: User can compare the data set.

Allow setting Copy Compare attributes on data set definitions The user can set the copy and compare options on the data set
definition.

This privilege should only be given to architects with
a thorough knowledge of the data set definition and its
associated data content who would certify data set definitions
to be copyable and comparable. A flawed data set definition
could corrupt a data base. A partial list of considerations for
the architect includes the following items to assess:

• The validation rules expressed in the application class
must be accurate and complete.

• Records in the data set should represent a tightly coupled
set of data.

• Copying the data set must preserve dependency
relationships.

• No orphan rows should be created in copy or delete.

• Consideration should be made of validation dependencies:
if a dependent object is being copied from the source, it
must be copied before the objects that depends on it.

Copy Compare Access Copy to File Copy from File Compare from File

No Access No No No

Read-Only Access Yes No Yes

Full Access Yes Yes Yes

Report Permission

Use this section to specify permission to run administrative reports.

See Running ADS Administrator Reports
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Field or Control Description

Access Select the appropriate access level. Options are:

• No Access: User can not view or run administrative
reports.

• Read-Only: Enables users to run and view administrative
reports.

Setting Upgrade Permissions
In order to copy from file, the user must have all of the appropriate permissions to the records in the file.
To simplify this process, you can create a permission list that includes Full Access to Upgrade.

Full access to upgrade allows the user to copy any record without checking the specific authority to that
record. Once you create a permission list with this access and assign it to a role, you should limit the
number of users who are granted the role.

To assign Full Access to Upgrade:

1. Select PeopleTools > Security > Permissions and Roles > Permission Lists.

2. Select the PeopleTools tab.

3. Select the Application Designer check box.

4. Select the Tools Permission link.

5. Select Full Access for Upgrade.

6. Click OK and the save the page.
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This example illustrates the fields and controls on the Tools Permission page.

Related Links
“Defining Permissions” (Security Administration)

Setting PeopleTools Data Access
In order to modify a PeopleTools owned data set definition, the developer must have:

• Full access to copy and compare for data migration.

See Defining Copy Compare Report Permission

• Permission list access to the tools tables.

See Defining Access Group Permissions

• PeopleTools Data Set access
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To set PeopleTools Data Set access:

1. Select PeopleTools > Security > Permissions and Roles > Permission Lists.

2. Select the PeopleTools tab.

3. Select the PeopleTools Data Set Access check box.

4. Save the page.

This example illustrates the fields and controls on the Permission List – Tools page.
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Encrypting Data Set Project Files

Data set project files are stored in project file repositories and should be encrypted for added security. By
default, the option to encrypt data set project files is selected.

Prior to PeopleTools 8.57 ADS used 3DES encryption/decryption algorithm for ADS projects.
PeopleTools 8.57 uses a new encryption algorithm provided by PeopleTools. ADS projects can be
used across PeopleTools releases, therefore it may be necessary to use the older encryption method for
compatibility.

Note: ADS projects delivered through PUM are PeopleSoft delivered projects which are public and
therefore not encrypted. Encryption only applies to user created ADS projects.

To handle ADS project encryption, access the ADS Options page (PeopleTools, Lifecycle Tools, Migrate
Data, ADS Options).

This example illustrates the ADS Options page with Encrypt Data Set Project Files selected.

Important! If you are migrating a data set project from PeopleTools 8.54 to PeopleTools 8.53 the
encryption must be turned off.

Field or Control Description

Encrypt Data Set Project Files Select this checkbox to encrypt ADS projects using
PeopleTools 8.57 encryption algorithm.

Compatible with PT 8.56 and lower releases Select this checkbox if you will be creating ADS projects that
will span PeopleTools releases. If selected the 3DES algorithm
is used for encryption/decryption.

Note: At copy to file time, if the encryption flag is enabled but Compatible with PT 8.56 and lower
releases flag is disabled, a message is displayed to warn the user that the generated ADS project cannot be
consumed by tools release prior to 8.57.
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Setting Up Approval Framework for Data Migration

Approval Framework is included in PeopleSoft applications as part of Enterprise Components. A set of
approvals is included for ADS projects. If activated and configured, this approval process is triggered
when the user clicks the Submit for Copy button.

The ProcessID MigrateData contains all of the information necessary to route approvals to the
appropriate approvers and take the necessary action when a transaction is approved, denied, or pushed
back.

To configure and activate the Approval Framework process for MigrateData:

1. Assign the appropriate role in the user profile for the approvers.

2. Define workflow for user profile.

3. Create and maintain user list definition.

4. Set up the Approval Process for Data Migration.

Assigning Data Migration Roles
Two roles are delivered for Data Migration approvals:

• EOMW_REVIEWER

• EOMW_APPROVER

You can use these roles or create new roles as needed for your approvers.

To assign data migration roles to a user profile:

1. Select PeopleTools >  Security > User Profiles > User Profiles > Roles .

2. Insert the role or roles.

3. Save the page.

Related Links
“Defining Role Options” (Security Administration)

Defining Workflow for User Profile
In order to receive approval notifications, the user must have the worklist option selected in the user
profile.

To set up a workflow user:

1. Select PeopleTools >  Security > User Profiles > User Profiles

2. Select the user profile, or create a new one.

3. Access the Workflow page.
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4. Select the Worklist check box.

Related Links
“Specifying Workflow Settings” (Security Administration)

Creating and Maintaining User List Definition
A user list is a collection of users (PeopleSoft User IDs) expressed as the result of a SQL statement,
PeopleSoft role, or PeopleSoft Application Class. User lists are used to represent the business process of
your approval hierarchy on a transaction-by-transaction basis. PeopleSoft delivers pre-defined user lists.
If none of the delivered user lists apply to your organization's hierarchy, then you can define your own
using the User List Setup component (Enterprise Components, Approvals, Approvals, User List Setup).

There are two delivered User Lists for Data Migration, however you can use any of the user lists that
apply for your applications.

User List Description

MigrateData_Reviewer Based on the role EOMW_REVIEWER. The transaction will
be routed to any user that has the role EOMW_REVIEWER
defined in the user profile.

MigrateData_Approver Based on the role EOMW_APPROVER. The transaction will
be routed to any user that has the role EOMW_APPROVER
defined in the user profile.

For more information on setting up user lists see Approval Framework, Defining Notification Templates
and Users for Approval Framework.

Setting up the Approval Process for Data Migration
To set up approval process definitions, use the Setup Process Definitions component.

Business analysts use this component to define an approval process definition. The process is made up
of stages and their paths and steps. The approval steps that you place on the approval path represent the
approval levels that are required for a transaction.

Approval Flow Description

Stage A stage is one part of an approval process that can contain
multiple paths. The system executes stages in sequence where
one must complete the stage before the next one begins. A
stage can be at the header or line level. For Data Migration
only the header level is used.

Path A path contains a sequence of steps. Within a stage, paths
execute in parallel. Path entry criteria determines whether or
not a path executes for a given transaction.
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Approval Flow Description

Step A step represents one or more approvers or reviewers. Steps
within a path execute in sequence. Separate criteria for each
step determines whether or not that step executes. Each step
can also have a set of reviewers.

Typical approval processes for Data Migration might include:

• Supervisor or Manager to review data that will be copied to the database.

• Manager to approve the data migration before it is copied to the database.

• Two different approvers for each step, where both approvers at a step must approve the request for it
to advance to the next step.

Example Approval Process Definition

This section provides an example of how to set up an approval process definition for a transaction that is
specific to MigrateData.

To set up the approval process definition:

1. Select Enterprise Components > Approvals > Approvals > Setup Process Definitions.

2. Select ProcessID MigrateData.
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This example illustrates the fields and controls on the Set Up Process Definition page. You can find
definitions for the fields and controls later on this page.

In the Definition Options section, the process definition needs to be set to Active.

In this example the approval process contains two stages – Supervisor and Copy Scheduler. Each stage
has one path and one step. The first stage requires supervisor approval before the ADS project can be
routed to the Copy Scheduler. When the copy scheduler approves the request (final approval), the ADS
project will be scheduled for copy in the Process Scheduler.

You can define multiple stages, paths, and steps for an approval process definition. For example, perhaps
you require administrator approval for the copy request. In this case, you would create an additional path
within the existing stage that contains one step requiring administrator approval.

The Approval Framework processes multiple stages and steps sequentially. The engine cannot advance to
the next step until you complete the preceding step in the given path. Likewise, the engine cannot advance
to the next stage until you complete all paths within a given stage. For paths, however, you can define
them as static (processed sequential) or dynamic (processed in parallel).

Criteria

By default, the criteria will be Always True, which means if the process definition for MigrateData is
active, Approval Framework will always be invoked.

You can add logic that the Approval Framework evaluates at runtime for a Boolean result. You can define
criteria at the definition, path, or step level. To set up criteria, click the Definition Criteria link at the top
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of the Setup Process Definitions page for the definition, for path and step criteria, click the associated
criteria icon for that path or step.

This example illustrates the fields and controls on the Criteria Definition page.

Refer to the Approval Framework PeopleBook, Setting Up Approval Framework Process Definitions,
Defining Criteria for Approval Framework Processes for details on how to define the criteria.

Scheduling and Approving Copy from File

This section discusses how to schedule and approve copy from file.

Submitting for Copy using Approval Framework
When the MigrateData approval process is active, all approvals must be completed before the Copy from
file will be scheduled in the Process Scheduler.

To request the copy from file:

1. In the Process Definition component (PeopleTools, Lifecycle Tools, Migrate Data, Data Migration
Workbench) select the Submit for Copy button.

2. Select the languages to copy.

3. Click Run.

You will receive a message that the project has been submitted for approval and the status will be
updated to Evaluating Approval.

4. Click OK to return to the Project Definition page.

5. To view the approvals required, click the Work Approvals link.
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This example illustrates the fields and controls on the ADS Approval View. You can find definitions for
the fields and controls later on this page.

This example shows the two paths. First the Supervisor must approve the project and then the copy
scheduler. Note in this example that for Copy Scheduler there are multiple approvers. If you want to see
who the approvers are, click on Multiple Approvers for a list of possible approvers. Only one approval
is needed, so once one of the copy scheduler approvers approves the copy, the transaction will be deleted
from the other copy scheduler approvers worklist.

Approving a Copy Request
The approval request is added to the approvers worklist. To approve a request:

1. Sign on as the approver.

2. Select Worklist from the menu bar or select Worklist, My Worklist - Summary View.

3. In the Link column, click the link.

4. The Data Migration Approval page is displayed.

This example illustrates the fields and controls on the Data Migration Approval page. You can find
definitions for the fields and controls later on this page.
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Field or Control Description

Approve Click to approve the transaction.

Deny Enter a comment in the Approval Comment edit box and click
to deny the transaction.

Pushback Click to push back the transaction.

Pushback is an optional feature that can be implemented in
the Approval Monitor. If implemented, push back takes a
currently pending step out of pending status and requeues the
previous step to its approvers. The meaning of push back is
that the approver is questioning the prior step’s approval and
is requesting clarification. Push back is only possible within a
path, therefore, the first step of a path cannot push back.

Request Information Click this button to request additional information from the
originator. The approval will be placed on hold.

Save Comment Enter a comment in the Approval Comment edit box and select
Save Comment.

Requesters can add comments to transactions, and approvers
can associate their comments with the approval process rather
than the request transaction directly. The Approval Framework
Monitor provides a mechanism for associating comments
with a particular approval process instance, which is tied
to a particular application transaction. Approvers can view
comments added by another approver, but they cannot change
previous comments.

Expand the ADS Approval View to view the current progress of the request.
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This example illustrates the fields and controls on the ADS Approval View.
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Running PeopleTools Configuration
Reports

Understanding PeopleTools Configuration Reports

Drop zones, event mapping, Application Engine plug-ins, and configurable search allow users to
configure the delivered pages, components, Application Engine programs, and search pages without
customizing those.

For example, you can use drop zone to add fields to the delivered pages, use event mapping to add
PeopleCode program to the delivered components, and so on.

You can generate SQR reports to capture details on configurations done using drop zones, event mapping,
Application Engine plug-ins, and configurable search. You can refer to the configuration details during
lifecycle management.

This table describes the SQR programs run in Process Scheduler to generate the SQR reports:

SQR Program Description

XRFPGDZ Lists all pages and their related drop zone subpages.

XRFAEPL Lists all delivered Application Engine programs, which have
been configured with Application Engine plug-in program that
contains the new SQL or PeopleCode action, which will be
used to configure the delivered Application Engine program
and various other values such as, section, step, action, and
mode.

XRFEVPC Lists all components, pages, records and fields that are mapped
to application package PeopleCode program and event type.

XRFCSCR Lists all configurable search customizations such as
components, search records, and search definitions.

The SQR reports can be produced in CSV, HP, HTM, LP, PDF, PS, or SPF formats.

Related Links
“Understanding Cross-Reference Reports” (Application Designer Developer’s Guide)
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Generating SQR Reports

This section discusses how to generate SQR reports on configurations done using drop zones, event
mapping, Application Engine plug-ins, and configurable search.

You can generate the reports from Process Scheduler or Isolated Customization Reports page.

Generating SQR Reports from Process Scheduler
This section discusses how to generate SQR reports on configurations done using drop zones, event
mapping, Application Engine plug-ins, and configurable search using Process Scheduler.

To generate a report:

1. Select PeopleTools, Process Scheduler, Schedule Process Request.

2. The Sample Processes page appears,

3. Click Add a new Value and enter a run control ID.

4. On the Schedule Process Request page, click Run.

The Process Scheduler Request page appears.

This example illustrates the fields and controls on the Process Scheduler Request page.

5. Select the process — XREFPGDZ, XRFAEPL, XRFCSCR, or XRFEVPC depending on which report
you want to generate.

6. Click OK to generate a report. By default, a consolidated report is generated that contains both the
PeopleSoft and non-PeopleSoft delivered configurations.
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This is an example of a Drop Zone SQR report in PDF format.

Note that an SQR report gets generated even if there is no data. The empty report will contain the header
information and columns. The data section will display the ‘No References Found’ message.

Instead of a consolidated report, you can customize to generate a PeopleSoft-only or non-PeopleSoft
delivered configurations.

To customize a report:

1. Select PeopleTools, Process Scheduler, Process Scheduler Processes.

2. On the Override Options tab, you can modify parameters to generate filtered reports.

This example illustrates the fields and controls on the Override Options page.

By default, the override options are set to 11111, FULL, and BOTH, which generates a full database
report.

To generate a report on a specific project, replace 11111 with the name of the project to be analyzed.

For a report on non-PeopleSoft delivered configurations, replace FULL with FILTER.
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BOTH generates the SQR report in your chosen format, and saves the Managed Object list to the
PS_PTADSUMMOL table and ADS instances list to the PS_PTADSUMAOL table.

Replace BOTH with OUTDB to add managed Object list and ADS instances list to
PS_PTADSUMMOL table and PS_PTADSUMAOL table respectively. No SQR report will be
generated.

Replace BOTH with OUTFILE to generate only the SQR report, which gets saved in a chosen format
such as, PDF or Web.

Generating SQR Reports from the Isolated Customization Reports Page
Use this page to generate SQR reports to capture details on configurations done using drop zones, event
mapping, Application Engine plug-ins, and configurable search.

Navigate to PeopleTools, Lifecycle Tools, Isolated Customization Reports.

This example illustrates the fields and controls on the Isolated Customization Reports page.

You can find definitions for the fields and controls later on this page.

Field or Control Description

Report Category Select database or project.

Project name field to select a project is enabled when you
choose the project category.

Report Type The options are Filter or Full.

Full- Generates a full database report.

Filter- Generates a filtered report.
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Field or Control Description

Output to Table Select this option to add Managed Object list and ADS
instances list to the PS_PTADSUMMOL table and PS_
PTADSUMAOL table respectively.

Reports For Select the options to generate reports on Drop Zones, Event
Mapping, Application Engine Plug-ins, and configurable
search.

View Reports After running the SQR program with the PTISOCUSTRPT
Application Engine program, you can view the status.

If it is success, you can see a Reports link to view the report in
PDF or other supported formats.

Click the Process Details link to view the details. If the
program fails, click on the Process Instance link for further
troubleshooting.

After selecting the required options, click Run. The Process Scheduler Request page opens where you run
the PTISOCUSTRPT Application Engine program.

This example illustrates the fields and controls on the Process Scheduler Request page.

When PTISOCUSTRPT runs, the selected SQR programs gets scheduled on the Process Scheduler.

The report can be generated only in HTM or PDF format.
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Note that only data pertaining to the latest run is maintained. When an SQR program is run, the previous
data gets overwritten.

Same SQR report generated by multiple users is maintained in the Managed Object list table
PS_PTADSUMMOL and ADS instances list table PS_PTADSUMAOL, along with the user ID, to avoid
conflicts.

For example, configurable search report generated by two users QEDMO and VP1 will be maintained in
the database table. When VP1 generates the configurable search report again, then the previous data gets
overwritten. However, the configurable search report generated by QEDMO remains.

Related Links
“Configuring Drop Zones” (Application Designer Developer’s Guide)
“Configuring Application Engine Action Plug-ins” (Application Engine)
“Mapping Application Class PeopleCode to Component Events ” (Portal Technology)
“Working with Configurable Search” (Search Technology)
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Using PeopleSoft Data Mover

Understanding PeopleSoft Data Mover

This section provides an overview of PeopleSoft Data Mover.

Note: PeopleSoft supports a number of versions of UNIX and Linux in addition to Microsoft Windows.
Throughout this documentation, we make reference to operating system configuration requirements.
Where necessary, the documentation refers to specific operating systems by name. However, for
simplicity the word UNIX refers to all UNIX-like operating systems, including Linux.

PeopleSoft Data Mover Overview
PeopleSoft Data Mover enables you to:

• Transfer application data between PeopleSoft databases.

• Move PeopleSoft databases across operating systems and database platforms.

• Run Structured Query Language (SQL) statements against any PeopleSoft database, regardless of the
underlying operating system or database platform.

• Control database security and access.

• Create, edit, and run scripts.

These scripts may include any combination of SQL commands and PeopleSoft Data Mover
commands for exporting and importing data.

Note: Data in PeopleSoft databases generally can't be transferred directly between major releases using
PeopleSoft Data Mover. For example, you can't import data from a PeopleTools 7.x database into a
PeopleTools 8.x database.

PeopleSoft Data Mover Environment
There are two ways to run PeopleSoft Data Mover:

• Using the Data Mover development environment.

This a graphical user interface (GUI), which runs only in Microsoft Windows. Use the Data Mover
shortcut in the PeopleSoft program group. Select Start, Programs, your_PSFT_program_group, Data
Mover.

• Using the Data Mover command-line interface.
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The command-line interface is intended mainly for UNIX servers. You run PeopleSoft Data Mover
from a console in Microsoft Windows and from a telnet session in UNIX.

Note: PeopleSoft Data Mover runs in two-tier mode only. You must sign in to the database directly, not
through an application server.

You set Data Mover environment variables in PeopleSoft Configuration Manager on Windows and in the
psconfig.sh for UNIX.

Related Links
Setting Up UNIX to Run PeopleSoft Data Mover

PeopleSoft Data Mover Operating Modes
Operating modes determine how you are connected to the database. PeopleSoft Data Mover operating
modes are:

• Regular mode.

Most of the time, you use regular mode. To sign in to regular mode, enter your PeopleSoft user ID and
password during sign-in. In regular mode, all commands are valid.

• Bootstrap mode.

In bootstrap mode, you use a database access ID and password when signing in. Typically, you use
bootstrap mode for database loading, because no PeopleSoft security tables are established yet. You
also use bootstrap mode for running some security commands, such as ENCRYPT_PASSWORD.

Note: In bootstrap mode, the following script commands are not valid: EXPORT and RENAME.

Understanding Data Mover Scripts

This section discusses the commands and statements used in Data Mover Scripts.

Data Mover Script Commands
This section discusses the valid PeopleSoft Data Mover commands that you can include in PeopleSoft
Data Mover scripts.

PeopleSoft Data Mover commands are platform-independent and are unique to PeopleSoft Data Mover.
You can use PeopleSoft Data Mover commands for importing, exporting, and other tasks, such as
controlling the run environment, renaming fields and records, administering database security, and
denoting comments.

The following table describes the PeopleSoft Data Mover commands and the ways that you can indicate
comments:
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Command Description

ENCRYPT_PASSWORD Encrypt one or all user passwords (operator and access)
defined in PSOPRDEFN for users.

EXPORT Select record information and data from records and store the
result set in a file. You can use the generated export file as
input for migrating to another platform. This file is portable
between ASCII and EBCDIC character sets, and also supports
double-byte characters.

IMPORT Insert data into tables using the information in an export
file. If a tablespace or table does not exist, this command
creates tablespace, table, and indexes for the record, using the
information in the export file, and inserts the data.

REM, REMARK, and -- Indicate comment statements.

RENAME Rename a PeopleSoft record, a field in one record, or a field in
all records.

REPLACE_ALL This is a variation of the IMPORT command. If a table already
exists, use this command to drop the table and its indexes from
the database. It then does the following:

1. creates the table.

2. creates any triggers.

3. inserts the data.

4. creates indexes.

REPLACE_DATA This is a variation of the IMPORT command. Delete data in
existing tables and insert the corresponding data from the
export file.

REPLACE_VIEW Recreate specified views found in the database.

RUN Run a specified .DMS file from within a PeopleSoft Data
Mover script. The file cannot contain nested RUN commands.

SET When a command is followed by valid SET parameters, it
forms a statement that establishes the conditions under which
PeopleSoft Data Mover runs the PeopleSoft Data Mover and
SQL commands that follow.
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Command Description

SET_IGNORE_IMPORT_ERRORS (Optional) If this command is set, then all errors produced by
IMPORT, REPLACE_DATA, and REPLACE_ALL will be
ignored and processing will continue until the end of the data
file or last import command.

Any failed records will be shown in the Data Mover log if it is
run from the Data Mover GUI or the import output if it is run
from the command line.

SET IGNORE_ERRORS (Optional) If this command is set, then all errors produced
by the SWAP_BASE_LANGUAGE command are ignored.
 Otherwise, the system stops on errors.

SET IGNORE_SPLCHARS (Optional), If this command is set with option ON, then special
character, such as colon would not be used as bind variable.

The carriage returns and spaces in a SQL string are not
skipped and gets inserted into the database as it is written in
the DMS script.

Default value is OFF.

SET BASE_LANGUAGE Swap individual language tables. You should swap individual
tables only when there is an error with any of the tables after
the SWAP_BASE_LANGUAGE command.

SWAP_BASE_LANGUAGE Swap all the language tables from PSRECDEFN.

Related Links
Using PeopleSoft Data Mover Commands
Using PeopleSoft Data Mover Command Modifiers
Using SET Parameters

Supported SQL Commands
With PeopleSoft Data Mover, you can use supported SQL commands in scripts on any supported database
platform. Except as noted in the following discussion regarding standard SQL commands, you can use all
of the supported SQL commands with the following Data Mover SET statements:

• SET LOG

• SET NO COMMIT

• SET NO TRACE

Standard SQL Commands with DMS Scripts

PeopleSoft Data Mover supports the following standard SQL commands:
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• ALTER

• COMMIT

• CREATE

• DELETE

• DROP

Note: With DROP commands, any drop errors are ignored. The script continues, but the errors are
reported in the log.

DB2 UTS customers can use the DROP table command.

• GRANT

• INSERT

Important! INSERT cannot be used with SET NO COMMIT or SET NO TRACE.

• ROLLBACK

• UPDATE

• TRUNCATE

Warning! PeopleSoft Data Mover does not support SELECT statements, because they require a SQL
FETCH function.

Standard SQL Commands with SQL Files

PeopleSoft Data Mover supports all SQL commands and other database-specific function calls that are
supported by the database engine.

Note: PeopleSoft Data Mover runs only files with the extension .SQL.

Nonstandard SQL Commands

With PeopleSoft Data Mover, you can also use the following nonstandard SQL commands created
by PeopleSoft: STORE and ERASE. Use the commands to change COBOL SQL statements in
PS_SQLSTMT_TBL.

The STORE command first deletes the existing stored statement from PS_SQLSTMT_TBL, and then
inserts the new statement using the following syntax:

STORE progname_type_stmtname

For example:

STORE PTPEMAIN_S_MSGSEQ
SELECT MAX (MESSAGE_SEQ), PROCESS_INSTANCE
  FROM PS_MESSAGE_LOG
  WHERE PROCESS_INSTANCE = :1
  GROUP BY PROCESS_INSTANCE
;
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The ERASE command deletes one or all stored statements from PS_SQLSTMT_TBL. When deleting a
single statement, you use the progname_type_stmtname format as shown for STORE. For example:

ERASE PTPEMAIN_S_MSGSEQ;

When deleting all SQL statements for a particular program, you include only the program name in the
command line format. For example:

ERASE PTPEMAIN;

Expressing Dates and Time in SQL Used in Data Mover

When you need to express dates and time in Data Mover SQL statements, use PeopleSoft meta-
SQL date and time constructs, such as %CURRENTDATEOUT, %CURRENTTIMEOUT,
%CURRENTDATETIMEOUT, %DATEIN, %TIMEIN, and so on.

See “Understanding Meta-SQL” (PeopleCode Language Reference).

Truncating Tables

Occasionally, it is necessary to delete all the rows in a table from Data Mover. Data Mover supports the
use of the TRUNCATE command. When used, Data Mover resolves the command to the current database
syntax using PeopleTools meta-SQL constructs.

For best performance, using the TRUNCATE command is recommended, rather than performing a mass
DELETE operation, which can encounter performance issues where large tables and triggers are involved.

See “%TruncateTable” (PeopleCode Language Reference).

Data Mover Commands Compared to SQL Commands
The following table shows the relationship between SQL and PeopleSoft Data Mover commands.
DDL refers to data definition commands, which define the structure of a database. DML refers to data
manipulation commands which define the contents of a database.

Function Command Type Supported SQL
Commands

Data Mover Commands

Create tables, tablespaces, and
indexes.

DDL CREATE IMPORT

REPLACE_ALL

Create views. DDL CREATE REPLACE_VIEW

Drop tables. DDL DROP REPLACE_ALL

Modify tables. DDL ALTER None

Modify PeopleSoft records. DDL None RENAME
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Function Command Type Supported SQL
Commands

Data Mover Commands

Delete all rows. DDL TRUNCATE None

Insert rows. DML INSERT

STORE

IMPORT

REPLACE_ALL

REPLACE_DATA

Delete rows. DML DELETE

ERASE

REPLACE_DATA

Update rows. DML UPDATE None

Encrypt rows. DML None ENCRYPT_PASSWORD

Select rows. Query None EXPORT

Save or don't save changes. Transaction COMMIT

ROLLBACK

SET (when used with
COMMIT or NO COMMIT)

Control or run other
PeopleSoft Data Mover
commands.

Environment None SET

RUN

Denote an explanatory
statement.

Comment None REM

REMARK

--

PeopleSoft Data Mover COMMIT Statements
PeopleSoft Data Mover issues COMMIT statements after most successful SQL commands, except for
EXPORT and IMPORT. For EXPORT and IMPORT, PeopleSoft Data Mover issues a COMMIT after
each record. With IMPORT, a SET COMMIT n command performs a COMMIT after the system inserts
every n rows.

If you are executing native SQL in PeopleSoft Data Mover, and no COMMIT statements exist in the SQL
script, PeopleSoft Data Mover issues a COMMIT after each successful SQL statement. For example, if
you run a PeopleSoft Data Mover script that contains three update commands, and the third command
fails, the first and second update commands are committed, but the third command is not.
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Using the Development Environment

This section discusses how to use the development environment.

Signing In to the Development Environment
To start PeopleSoft Data Mover in the Windows development environment:

1. Select Start, Programs, PeopleSoft Group, Data Mover.

If you don't have a PeopleSoft Data Mover shortcut, you can add one to the desktop. The executable
to launch is: PS_HOME\bin\client\winx86\psdmt.exe

2. Sign in using the appropriate ID and password.

In regular mode, use a user ID and password. In bootstrap mode, use a system access ID and access
password, such as SYSADM.

Navigating the Data Mover Window
The PeopleSoft Data Mover interface consists of two horizontal panes: an input pane and an output pane.
The input pane is on top.

The status bar at the bottom of the window provides the following information:

• Database name (for example, QEDMO, PTS920HR, and so on).

• Database type (for example, Oracle, DB2, and so on).

• Operating mode (regular or bootstrap).

• Trace status (on or off).

The input pane displays the script that you open. In this pane, you view and edit PeopleSoft Data Mover
scripts.

The output window displays the results after running a script. If you encounter any errors, the output
window shows where the script failed. In a multi database environment, always check the information at
the top of the output to ensure that you run the script against the appropriate database. Specifically, verify
the information on the Database line.

Note: By default, the results in the output window are saved to the file DATAMOVE.LOG, which is
written to the default log directory as specified in PeopleSoft Configuration Manager (on the Edit Profile,
Common tab). You can specify a different file name.

The status of the SQL Trace utility appears on the right-hand end of the status bar. Use PeopleSoft Data
Mover with tracing turned off. There are several ways to disable the SQL Trace utility (for the Microsoft
Windows environment) before starting PeopleSoft Data Mover. You can use:

• PeopleSoft Configuration Manager.

• PeopleTools options.
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• A Data Mover command (NO TRACE).

The operating mode on the status bar indicates either regular mode or bootstrap mode. If you connect to
the database in regular mode, the operating mode status is blank. The operating mode is bootstrap if you
sign in using the access ID and password.

Note: Verify the mode that you are using. Most commands require regular mode to run successfully.

Related Links
Using SET Parameters
NO TRACE
PeopleSoft Data Mover Operating Modes

Creating and Running PeopleSoft Data Mover Scripts

This section provides overviews of command types and syntax rules in PeopleSoft data mover scripts.

Understanding Command Types
A PeopleSoft Data Mover script can contain two types of commands:

• Data Mover commands.

Use these commands to export and import database information and to otherwise modify the database.
PeopleSoft Data Mover commands also control script execution, call other PeopleSoft Data Mover
files, and indicate comments.

• SQL commands.

You can use both standard and nonstandard SQL commands that modify the database.

Understanding Syntax Rules
To create or edit PeopleSoft Data Mover scripts, follow these syntax rules to ensure that the commands
run successfully.

Delimiters

With the exception of double-hyphen (--) comment statements, every command statement must be
followed by a delimiter.

Valid delimiters are:

• Semicolon (;)

A semicolon can appear on the same line as the command itself, or by itself on the line immediately
following a command statement. For example, the following two examples of the semicolon delimiter
are valid:

   SET OUTPUT c:\temp\abc.dat;
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   SET LOG c:\temp\new.log
   ;

• Forward slash (/)

This delimiter can be used only on a line by itself, in column 1, on a line immediately following a
command statement. For example:

   IMPORT *
   /

Multiline Statements

With the exception of double-hyphen (--) comment statements, statements can span multiple lines. For
example:

EXPORT absence_hist
   WHERE absence_type = 'A';

Multiline Comments

A double-hyphen (--) comment statement does not require a delimiter termination. However, each
statement can't span more than one line. Be sure to add a space after the double hyphen before you start
the comment. For example:

Correct:

-- This script imports the information stored in
-- the ABC.DAT file.

Incorrect:

--This script imports the information stored in
the ABC.DAT file.

White Space

Command statements can contain any amount of white space between items.

Case Sensitivity

Statement text is not case-sensitive. For example,

IMPORT *

is equivalent to

import *

String Constants

String constants are case-sensitive and must be surrounded by single quotation marks. For example,
'ABC' is treated differently than 'Abc' or 'abc'.
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Record Names and Table Names

In PeopleSoft Data Mover, when a record name needs to be specified as one of the elements in the
command statement syntax, as in an IMPORT statement, you can specify either the record name or the
corresponding table name. For example, the following IMPORT statements are equivalent:

Correct:

   IMPORT job;

Correct:

   IMPORT ps_job;

However, when a table name is required for one of the elements in the command statement syntax, you
must use the table name, not the record name. For example:

Correct:

   IMPORT job  AS  ps_process;

Incorrect:

   IMPORT job  AS  process;

Creating and Editing Scripts
When you use PeopleSoft Data Mover to manipulate the information in a database, you can either write a
new script or open and edit an existing script that is similar to the one that you want to create.

The default file extension for scripts is .DMS, which stands for Data Mover script.

Creating a New Script

To create a new script:

1. Select File, New.

When you first launch PeopleSoft Data Mover, a new file appears automatically. .

2. Enter the script text (that is, the code) in the input pane, which appears on top.

Using proper Data Mover syntax, enter the command statements that you want the script to run.

3. Save the script.

Select File, Save. In the Save As dialog box, select the Save as Unicode check box (if appropriate)
and click Save.

Editing an Existing Script

To edit an existing PeopleSoft Data Mover script:

1. Select File, Open.

2. Select the file and click OK.
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By default, you view only .DMS files. You can select All Files from the Files of type drop-down list
box to view all file types. After you open a script, it appears in the PeopleSoft Data Mover input pane.

3. Modify the script.

If the file that you opened is not a .DMS file, verify that it conforms to the required syntax rules and
that it doesn't contain unsupported SQL commands.

4. Save the script with a new name.

Select File, Save As.

In the Save As dialog box, enter a file name, select the Save as Unicode check box (if appropriate)
and click Save.

If the script is edited in Unicode format, then the default save is Unicode. However, if the file is
opened in ASCII format, then the default is ASCII.

Related Links
Understanding Data Mover Scripts
Understanding Syntax Rules

Preparing to Run Export Scripts
Before running a PeopleSoft Data Mover export script, you must first prepare the database.

To prepare for an export:

1. Load DDL model information by running all DDL*.DMS files through PeopleSoft Data Mover.

2. To change the DDL model information, use the DDL Model Defaults utility in PeopleTools Utilities.

3. Run DDDAUDIT.SQR and fix any errors that it finds.

4. Run SYSAUDIT.SQR and SYAUD01.SQR and fix any errors.

5. Use the SQL Alter function in Application Designer to alter all tables.

Either let the files alter in place or run the script that it generates to alter any tables that it marks as out
of synchronization.

6. Use the SQL Create function in Application Designer to create all records, using the If table exists ...
Never recreate option.

Related Links
System and Server Administration
“Understanding Data Integrity Tools” (Data Management)
Application Designer Developer’s Guide
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Running Scripts
Through PeopleSoft Data Mover, you can run DDL, DML, and SQL scripts created with the following
tools:

• PeopleSoft Data Mover (DMS scripts).

• Build SQL functionality in Application Designer (SQL scripts).

• Platform-specific SQL utilities (SQL scripts).

Note: You can also schedule PeopleSoft Data Mover scripts using PeopleSoft Process Scheduler. This can
be useful in scheduling audit routines or extracting data from the PeopleSoft database. Additionally, logs
and data files generated by PeopleSoft Data Mover can be posted to the report repository in PeopleSoft
Process Scheduler so that they can be viewed either through Process Monitor or Report Manager.

Note: DMS scripts which contain characters outside of the US ASCII range should be saved in UTF-8
encoding.

When running scripts through PeopleSoft Data Mover, keep the following items in mind:

• Turn off the SQL Trace utility to run PeopleSoft Data Mover scripts.

If SQL Trace is enabled, disable it on the Trace tab in PeopleSoft Configuration Manager before you
run the script. You can also enter the SET NO TRACE statement within scripts. This disables SQL
Trace for the DMS script even if it is enabled in PeopleSoft Configuration Manager.

• Records defined using the PeopleSoft Data Mover EXPORT and IMPORT commands can have a
maximum of 500 columns, and they can have multiple long columns within the limitations for long
columns set by the database platform.

Check with the database vendor for restrictions on the number of long columns allowed for the
platform.

• On DB2 UDB platforms, locks can occur on system catalogs.

Do not run unattended PeopleSoft Data Mover sessions. Close the session as soon as all scripts
terminate.

• To run a SQL script, you must open it by selecting File, Open so that the SQL runs properly.

Do not copy and paste SQL from another source into PeopleSoft Data Mover.

Note: If you plan to import or export files greater than 2 gigabytes (GB) on UNIX, you must enable
large file support at the operating system level.

To run a script:

1. Select File, Open.

2. Select one of the following types of script to run.

• PeopleSoft Data Mover files (.DMS).

These are the files created using PeopleSoft Data Mover.
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• Query files (.SQL).

These are the files created using the Build SQL functionality in Application Designer or using a
query tool specific to a relational database management system (RDBMS), such as PL/SQL on
Oracle.

• All files.

Select to view all available files in a directory. Only .DMS and .SQL files are valid file types for
PeopleSoft Data Mover.

Note: SELECT commands are not supported. When performing upgrades, use the SQL utility for
the platforms to run .SQL scripts, not PeopleSoft Data Mover.

3. Select File, Run.

You can monitor the script's progress in the output pane, which reveals any error messages and
displays the message Script Completed when processing has ended.

Using the Database Setup Utility

This section discusses how to use the database setup utility.

Typically, you use the Database Setup utility during PeopleSoft installations and upgrades, not on a daily
basis. You use this utility to create PeopleSoft Data Mover import scripts that load data into a PeopleSoft
database.

Note: If you are performing an installation, use the documentation included in your PeopleSoft
installation guide, which provide specific details regarding your applications, languages, and RDBMS.
This section provides a general overview and is not specific to the installation procedure.

Accessing the Database Setup Utility
To access the Database Setup utility:

1. Sign in to PeopleSoft Data Mover in bootstrap mode.

Use the access ID and password rather than your PeopleSoft user ID and password.

2. Select File, Database Setup.

Note: If you sign in to PeopleSoft Data Mover using regular mode, not bootstrap mode, the Database
Setup menu item is not available.

Working with the Database Setup Utility
This section discusses the dialog boxes that make up the utility.

268  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 17 Using PeopleSoft Data Mover

Database Setup

Field or Control Description

Select Target Database Select the RDBMS against which to run the database setup
script. For instance, if the database that you are creating will
run on an Oracle server, select Oracle.

Database Type PeopleSoft supports non-Unicode (ANSI) and Unicode
database types. Select the appropriate type for the system. For
some RDBMS types, Unicode is not available.

Select Character Set Select a character set. Your choices vary depending on the
database type that you selected.

Select PeopleSoft Application

Field or Control Description

PeopleSoft Application Only the applications that you have licensed appear. Select
the applications for which you want to create PeopleSoft Data
Mover scripts. To add applications selectively, use the Add
button. To add all applications available, use the Add All
button.

Data Mover Scripts to Create Use the Remove button to remove a single application, or use
the Remove All button to clear the list box.

Database Type Specify what the result of running the script should be. There
are two database codes: PT for PeopleTools and EP for
PeopleSoft applications. Options are:

• Demo: Select to create a demonstration database.

• System: Select to create a system database.

• Add New Language: Select to add support of new
languages to an existing database.

• Add New Product: Select to add a new PeopleSoft product
to the current system. With this option selected, only non-
PT database codes appear.
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Database Parameters

Field or Control Description

Database Name Enter the name of the database against which to run the script.
 The database name that appears is the database to which you
are currently signed on. If the script that you are creating will
be run against another database, specify the appropriate name
here. If you generate a script for a database other than the
current database, the system uses a default database using the
following convention: XXDMO for demonstration databases
and XXSYS for system databases. The XX represents the
product code, such as HR.

Symbolic ID Enter the ID used as the key to retrieve the access ID and
access password. For initial installation, set it equal to the
database name.

Access ID This ID is the RDBMS ID with which PeopleSoft applications
are ultimately connected to the database once the PeopleSoft
system validates the user or connect ID. It typically has all the
RDBMS privileges necessary to access and manipulate data
for an entire PeopleSoft application.

Access Password Enter the password associated with the access ID.

Connect ID This ID is used for the initial connection to the database. Any
two-tier connection requires a connect ID. A connect ID is a
valid user ID, that when used during logon, takes the place of
PeopleSoft user IDs for the sign-in process.

Table Owner (DB2 UDB for z/OS) This field populates the CREATOR
field in the system catalog table SYSIBM.SYSTABLES. You
determine the name of the table owner ID during the initial
installation.

Index Storage Group (DB2 UDB for z/OS) Enter the storage group where the index
spaces are created.

Table Space Storage Group (DB2 UDB for z/OS) Enter the storage group for tablespaces.
 This value must be the same as that used in the XXDDL.SQL
script when you create tablespaces during the installation.
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Checking the Generated Script
After running the Database Setup utility, check the output directory for the generated script. Some
commands are added that call other scripts and perform various functions. These commands are added
to reduce the number of scripts and commands that you must run manually. For example, note that the
following commands appear at the end of the script:

• REPLACE_VIEW

This command creates views for the new database.

• CREATE_TEMP_TABLE

This command creates any necessary temporary table images. The number of temporary tables is
determined by the value for the Temp Table Instances setting in PeopleTools options (Utilities,
Administration, PeopleTools Options) plus the number of PeopleSoft Application Engine temporary
tables.

• SWAP_BASE_LANGUAGE

If you selected a base language other than English, this command modifies the system to recognize
that language as the base language. The default PeopleTools language is English if the PSSTATUS
table is not available.

• RUN

This command runs the CURRXXX.DMS script to load the system with the appropriate currency
information, and it runs MSGTLXXX.DMS to load the system with the appropriate PeopleTools
messages (error and informational messages). The XXX represents the language code, such as FRA for
French. The system runs these scripts only if you have selected a base language other than English.

Note: After each DDL create table, import data, and DDL create indexes command, PeopleSoft Data
Mover issues an UPDATE STATISTICS command (except on z/OS), which improves the performance of
subsequent commands, such as the REPLACE_VIEW command.

Related Links
CREATE_TEMP_TABLE
SWAP_BASE_LANGUAGE

Using the PeopleSoft Data Mover Command-Line Interface

This section provides an overview of using the PeopleSoft Data Mover command-line interface.

Understanding the PeopleSoft Data Mover Command-Line Interface
The PeopleSoft Data Mover command-line interface enables you to run PeopleSoft Data Mover scripts
from the command line in UNIX and Microsoft Windows environments. The command-line interface
is designed only for running scripts, not creating and editing scripts. In Microsoft Windows, you create
and edit scripts using the PeopleSoft Data Mover development environment. In UNIX, you can use any
supported text editor.
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When using the command-line interface, the results of the script run appear in the command-line window,
much like the contents of the output pane in the PeopleSoft Data Mover GUI. The system also writes this
information to the log file.

The PeopleSoft Data Mover command line supports the environment variable $PS_HOME on UNIX and
%PS_HOME% on Windows.

Note: Although the command-line interface also runs on Windows machines, this documentation
primarily discusses UNIX.

Important! The PeopleSoft Data Mover command line on UNIX is intended to increase performance
with large database loads during installation. Use the PeopleSoft Data Mover Windows interface for other
types of scripts.

Setting Up UNIX to Run PeopleSoft Data Mover
Before running the PeopleSoft Data Mover command-line interface on UNIX, verify that Tuxedo is
installed. Tuxedo is required for PeopleSoft Data Mover to run on UNIX.

Next, configure the psconfig.sh shell script to set the UNIX and PeopleTools environment variables
properly for Data Mover, then run the script. You must run it from the PS_HOME directory.

Note: The UNIX environment requires certain platform-specific environment variables. These variables
are set automatically, but you can reconfigure the psconfig.sh script file to change their values.

UNIX Environment Variables

Data Mover environment variables for UNIX are stored in the psconfig.sh script. When you run
psconfig.sh, several environment variables are automatically set to default values that reflect a standard
PeopleSoft Data Mover install.
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To modify them, you must edit psconfig.sh or manually change the environment.

Statement Description

$DM_HOME=$HOME/PS_DM Data Mover output, log file and trace file path. This
environment setting needs to point to a writable location in
case of a secure, read-only PS_HOME environment.

The default setting is $HOME/PS_DM

PS_DM_DATA_IN=$PS_HOME/data Specifies the directory where PeopleSoft Data Mover searches
for input data (.DAT) files. The default setting is $PS_HOME/
data.

PS_DM_DATA_OUT=$DM_HOME/data Specifies the directory where PeopleSoft Data Mover writes
the output data (.DAT) files. The default setting is $DM_
HOME/data.

PS_DM_SCRIPT=script_path;export PS_DM_SC⇒

RIPT

$PS_DM_SCRIPT specifies the location of the PeopleSoft
Data Mover script files. The default setting is $PS_HOME/
scripts.

PS_DM_LOG=log_path;export PS_DM_LOG $PS_DM_LOG specifies the location of PeopleSoft Data
Mover log files. The default is $DM_HOME/log, as in as in
$HOME/PS_DM/log.

Note: $DM_HOME/log is an environment variable for UNIX specifying a location to which Data Mover
has write access in the case of a read-only PS_HOME configuration.

Note: If you want to perform tracing under UNIX, you must set additional environment variables.

Note: If you have installed your PeopleSoft application outside of PS_HOME, make sure to consider the
PS_APP_HOME location.

See Setting Up Tracing.

Setting Up Tracing
To enable tracing for PeopleSoft Data Mover, you must set the PS_SERVER_CFG environment variable
to point to the Data Mover configuration file, which contains parameters for tracing and character set:

• In Windows, you can set PS_SERVER_CFG in the System control panel, or issue the following
command in a batch file or at a command prompt:

set PS_SERVER_CFG=%PS_HOME%\setup\psdmtx.cfg
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• In UNIX, edit psconfig.sh to include the following statement:

PS_SERVER_CFG=$PS_HOME/setup/psdmtx.cfg;export PS_SERVER_CFG

To configure tracing for PeopleSoft Data Mover, you must edit the psdmtx.cfg file to specify the
appropriate tracing behavior. Use the TraceSql bitfield parameter to set the level of the SQL trace by
adding together the numeric values that represent each degree of tracing required. The values are defined
as follows:

Bit Value Type of Tracing

1 SQL statements.

2 SQL statement variables.

4 SQL connect, disconnect, commit and rollback.

8 Row Fetch (indicates that it occurred, not data).

16 All other API calls except ssb.

32 Set Select Buffers (identifies the attributes of columns to be
selected).

64 Database API specific calls.

128 COBOL statement timings.

4096 Manager information.

8192 Mapcore information.

After running PeopleSoft Data Mover, look for the generated trace log file in PS_CFG_HOME\log
\APPSRV.LOG.

For UNIX, the TraceFile environment variable enables you to configure the trace file path and name. The
system only uses the TraceFile value when TraceSql is set to a value greater than 0. The default value of
TraceFile is DM_HOME/datamover.trc. For example,

TraceFile=%DM_HOME%/datamover.trc

Running Data Mover Scripts from the Command Line
The PeopleSoft Data Mover command line program is located as follows:

• Microsoft Windows: PS_HOME\bin\client\winx86

• UNIX: PS_HOME/bin
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At a command prompt, change to the program directory and issue the psdmtx command with the
appropriate parameters.

Standard Command Line Syntax

Use the following standard syntax to run most Data Mover scripts:

psdmtx -CT dbtype  -CD database_name
-CO user_ID -CP user_password[-CI connect_ID -CW connect_password]
[-I process_instance] -FP dms_filepath

The value of each parameter follows the parameter name, separated by zero or more spaces. It doesn’t
need to have quotation marks around it, even if it has internal spaces — the system treats all text
following the parameter name as part of the value, up to the next parameter or the end of the command
line.

Note: You must enclose a value in quotation marks only when it includes a hyphen or forward slash, or
to include leading or trailing spaces. If the value itself includes a quotation mark character, precede the
double quote with a backslash (\).

To display a listing of all the command-line parameters and their arguments at the command prompt,
enter:

psdmtx /help
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Standard Command Line Parameters

The following table lists the standard command-line parameters and arguments for running the psdmtx
command:

Parameter Argument Example

–CT Specify the database type. Valid values
are DB2, DB2ODBC, MICROSFT, and
ORACLE.

Note: Notice the spelling of
MICROSFT.
DB2ODBC is the database type for DB2
z/OS.

-CT ORACLE

–CS Specify the server name -CS SERVER

–CD Specify the name of the database to
connect to, as you would when signing in
to PeopleSoft.

-CD HR857DMO

–CO Specify the PeopleSoft user ID you're
using to sign in.

-CO JPHAM2

–CP Specify the user password for the
PeopleSoft user ID you specified.

-CP password

–CI (Optional) Specify the connect ID used
to connect to the database server.

Note: This parameter is required only if
you're running PeopleSoft Data Mover in
regular mode.

-CI people

–CW (Optional) Specify the password for the
Connect ID you specified.

Note: This parameter is required only if
you're running PeopleSoft Data Mover in
regular mode.

-CW password

–I (Optional) Specify the Process Scheduler
process instance.

-I %%INSTANCE%%
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Parameter Argument Example

Note: This parameter is required only if
you're running PeopleSoft Data Mover
from PeopleSoft Process Scheduler. You
generally enter the predefined metastring
%%INSTANCE%% in the process
type definition, and PeopleSoft Process
Scheduler inserts the correct value at
runtime.

–FP Specify the file name and path of the
PeopleSoft Data Mover script to run.

-FP $PS_HOME/scripts/
test.dms

/help No value required. psdmtx /help

Note: When running scripts, be sure to consider your PS_APP_HOME location if you've installed your
PeopleSoft application outside of PS_HOME.

Following is an example of a standard psdmtx command line on a UNIX system:

psdmtx -CT DB2 -CD FS845A1 -CO PSOFT -CP PSOFT
 -CI people -CW peop1e -FP fs845a1dbo.dms

Using a Parameter File

Rather than submitting parameters manually on the command line, you can have PeopleSoft Data
Mover read a file that contains appropriate parameters. Create a text file that contains a complete set of
parameters as you would enter them on the command line.

If you submit a parameter file name and path to PeopleSoft Data Mover as the first parameter in the
command line, PeopleSoft Data Mover reads the contents of the file and interprets them as parameters
entered on the command line. For example:

psdmtx c:\dms\myparmfile.txt

Note: You must enter the full path to the parameter file.

Warning! For security reasons, after PeopleSoft Data Mover interprets the contents, it immediately
deletes the parameter file.

Using PeopleSoft Data Mover Commands

This section provides the details of syntax and use for each of the PeopleSoft Data Mover commands.
This section also discusses PeopleSoft Data Mover command modifiers, such as AS, WHERE, and
IGNORE_DUPS, which can be used to modify certain commands.
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CHANGE_ACCESS_PASSWORD

Syntax
CHANGE_ACCESS_PASSWORD SymbolicID newAccessPswd

The following special characters do not work for database passwords:

• double quote(")

• forward slash (/)

• single quote (‘)

• at sign (@)

• backquote (`)

• backslash (\)

Description

Use this command to reset the access password and make it transparent to users.

The CHANGE_ACCESS_PASSWORD command performs the following operations:

• Selects the access password field from the PSACCESSPROFILE table for the specified symbolic ID.

• Changes the access ID's database password to the new access password that you specify (for Oracle
and Microsoft SQL Server only).

• Updates the PSACCESSPROFILE table for the specified symbolic ID with the new access password.

Parameters

LOG and NO TRACE

CREATE_SEQUENCE

Syntax
CREATE_SEQUENCE [* | sequence_name ];

Description

Creates database sequences.

Note: If a sequence does not exist in the database, then the system creates a new sequence.

To define a database sequence as a managed object, refer “Using Maintain Database Sequences” (System
and Server Administration)
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CREATE_TEMP_TABLE

Syntax
CREATE_TEMP_TABLE {record | *}

Description

Creates temporary table images for use with PeopleSoft Application Engine programs. To customize
the number of temporary tables, you need to modify the PeopleTools Options page or updated the
PSOPTIONS table using the following SQL:

UPDATE PSOPTIONS SET TEMPTBLINSTANCES = number

You also need to review the number of temporary tables allotted for PeopleSoft Application Engine
programs

Note: For security reasons, this command is disabled for z/OS.DMS scripts generated by the Database
Setup utility.

CREATE_TRIGGER

Syntax
CREATE_TRIGGER {* | recordname}

Description

Creates database triggers on the specified table.

Note: If you use CREATE_TRIGGER in bootstrap mode, the system automatically activates SET
IGNORE ERROR. This enables PeopleSoft Data Mover to continue processing until all of the view
definitions have been processed, and all errors have been written to the current .LOG file (or an error log
file). This is similar to the REPLACE_VIEW behavior.

ENCRYPT_PASSWORD

Syntax
ENCRYPT_PASSWORD {userID | *};

Description

Encrypts one or all user passwords (user passwords and access passwords). When encrypting a single
user's password, the user ID must be present in PSOPRDEFN. You can use an asterisk instead of a name
to encrypt all passwords in PSOPRDEFN.
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Parameters

LOG, NO COMMIT, and NO TRACE.

Example

Here's an example of how to encrypt a single user password (FS) already listed in PSOPRDEFN:

ENCRYPT_PASSWORD FS;

To encrypt all user passwords in PSOPRDEFN, enter:

ENCRYPT_PASSWORD *;

EXPORT

Syntax
EXPORT {record | *} [WHERE conditions];

Description

Creates a single export file containing the specified database contents. The result set can contain any
of the following: a single PeopleSoft record, a group of records, or the entire database. You can use the
export file as input for the PeopleSoft Data Mover IMPORT command to migrate the data within the
platform or to another platform.

Note: This command is not available in bootstrap mode.

Records exported using EXPORT can have a maximum of 500 total columns and multiple long columns
within the limitations for long columns set by the database platform. Check with the database vendor for
restrictions on the number of long columns allowed for the platform.

When you export all records using EXPORT*, PeopleSoft Data Mover orders the records alphabetically
(with the exception of PSLOCK, which is the last record exported). After each record, PeopleSoft Data
Mover indicates how many records remain. After all the tables are exported, then the views are exported.

Warning! The WHERE clause, when used in this command, supports only US-ASCII (seven-bit ASCII)
values. Characters beyond this range can produce errors in the export file.

Parameters

LOG, NO COMMIT, NO DATA, NO TRACE, NO VIEW, and OUTPUT.

Note: SET NO VIEW is only valid with EXPORT *.

Note: If SET OUTPUT is not used, PeopleSoft Data Mover writes to the default file name,
DATAMOVE.DAT.
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Example

To export a single record, use an EXPORT command for the specific record. For example:

EXPORT PS_JOB;

Note: When specifying a particular record in the EXPORT command (as shown in the previous example),
the specified record must be a table, not a view.

To export all PeopleSoft records, including views, enter

EXPORT *;

IMPORT

Syntax
IMPORT {record | *} [IGNORE_DUPS]   [AS new_table_name] [WHERE conditions];

Description

The IMPORT command:

• creates database spaces.

• creates nonexisting tables and indexes.

• appends non-duplicate rows to records.

• creates views if the export file was created using EXPORT * and imported using IMPORT *.

Warning! All duplicate row-checking depends on the existence of a unique index. If no unique indexes
are created before loading the data, there is a potential for duplicate data.

In the IMPORT statement, the AS clause is only valid if you specify a table name.

Using * with AS or WHERE is allowed in cases where the imported data file consists only of a single
table. For example,

IMPORT * AS table_name

If the data file consists of the more than one table when using * AS or WHERE, the system returns the
following error message:

Error: The Input File file_name contains number_of_records records.

The table name that you specify immediately after the AS command modifier must not exceed 18
characters (including the ps_ prefix). If you do specify a table_name that exceeds 18 characters, the
following error appears: Error: Unable to process create statement.

See WHERE.

Records defined using IMPORT can have a maximum of 500 columns with multiple long columns. The
number of long columns allowed is determined by the limitations for long columns set by the database
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platform. Refer to your database vendor documentation for restrictions on the number of long columns
allowed for the platform.

There are two variations of IMPORT that you can use:

• REPLACE_ALL

• REPLACE_DATA

Parameters

All except OUTPUT.

INPUT is a required parameter.

Note: IGNORE_DUPS is only valid in bootstrap mode.

Example

To import a single record from an export file, use an IMPORT command for that record. For example:

SET INPUT file_name;
IMPORT PS_JOB;

To import all PeopleSoft records from an export file, including views, enter:

SET INPUT file_name;
IMPORT *;

Globalization Considerations

PeopleSoft Data Mover offers a base-language-independent method for moving application data between
databases. PeopleSoft Data Mover loads a single DAT file, detects the target database base language, and
inserts the data into the correct base or related language table.

If Oracle provides a software fix, you don't need to swap the base language before importing it into a
database with a different base language. For example, suppose that a fix is sent with the base language
English (ENG) and the related language Japanese (JAP). In this case, you can import this file directly into
a database where the base language is JAP and the related language is ENG.

Upon EXPORT, the system adds the LANGUAGE_CD (language code) to the generated DAT file. For
example:

SET BASE_LANGUAGE ENG

Then, when you use the IMPORT command to import the generated DAT file, the system detects the
LANGUAGE_CD in the DAT file and compares it with the LANGUAGE_CD in the target database to
determine how to swap the base language and related language tables.

Note: Base language is the database base language. It can be any PeopleSoft-supported language.

Consider the following points when running the IMPORT command:

• This feature is enabled whenever you import a DAT file.
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• Running the IMPORT command may have an unavoidable adverse affect on performance.

Related Links
REPLACE_ALL
REPLACE_DATA

REM, REMARK, and – –

Syntax
REM comments; REMARK comments; -- comments

Description

Each of these three command variations indicates explanatory text in a PeopleSoft Data Mover script.

Example

Here are three examples demonstrating the use of each:

REM  This example demonstrates the use of the REM command to set off script
 comments.
 These statements can span multiple lines and must be terminated with a valid
 delimiter;
REMARK  The REMARK command variation has the same restrictions as REM
/
--  This example demonstrates the use of two dashes to denote script
--  comments.  No delimiters are required, but statements can not
--  exceed one line without using another double-dash.

When using a double hyphen (--), as in the third example, you need at least one space after the double
hyphen, before the start of the actual text of the comment. Otherwise, you receive a syntax error.

When used in conjunction with a comment prefixed by REM or REMARK, the forward-slash delimiter
(/) should be by itself on the last line of that comment. In such cases, instead of using a forward-slash (/),
you can also use a semicolon (;) by itself on this last line. The forward slash (/) can also be used by itself
without a REM or REMARK statement, in lieu of blank lines, which are also allowed in a script.

RENAME

Syntax
RENAME {RECORD record | FIELD {field | record.field}}  AS new_name;

Description

Renames a PeopleSoft record, a field in one record, or a field in all records.

Note: This command is not available in bootstrap mode.
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Warning! Using RENAME only modifies a definition in the PeopleSoft tables. To write the record and
field change to the system tables, you must use Application Designer to modify the affected definitions.

To rename a record field, you must qualify the original name of the field with the record name. If you
don't qualify the record name, PeopleSoft Data Mover attempts to globally change the field name in all
records.

Renaming a record field is only possible through PeopleSoft Data Mover.

To rename a record field:

1. Perform the rename in PeopleSoft Data Mover.

For example:

RENAME FIELD RECORD.FIELD AS NEWFIELD; COMMIT;

2. In Application Designer, create a project that includes the record that contains the field that you
renamed, and save the project.

In the case of a subrecord field rename, the subrecord along with all tables that contain that subrecord
must be inserted into the project.

3. Select Build, Settings.

• Select the Alter tab.

• Select Adds and Renames.

• Clear Changes and Deletes.

Note: Drop column and change column length do not apply.

• Select the Scripts tab and select output settings.

• Specify an output file and click OK.

4. Select Build, Project.

• Select Alter Tables (Create Indexes is selected by default).

• Click Build.

• Click Yes to continue the build process.

5. Run the generated SQL script using the query tool.

This adds the new field to the tables within the project.

Note: For subrecord field renames only, data is not automatically migrated from the old field to the
new field. You will need to migrate this data manually.

To remove the old field from the tables:
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1. In Application Designer, open the project that you created using the preceding steps.

• Select Build >  Settings.

• Select the Alter tab.

• Select Drop column if data present.

• Select Deletes.

• Clear Adds and Renames.

• Select the Scripts tab.

• Give the output file a different name and click OK.

2. Select Build, Project.

• Select Alter Tables (Create Indexes is automatically selected).

• Click Build.

• Click Yes to continue the build process.

3. Run the generated SQL script using the query tool.

The old field should no longer appear on the tables included in the project.

Parameters

LOG, NO COMMIT, and NO TRACE.

Example

Here's an example of how to rename a record:

RENAME RECORD absence_hist AS absent_hist;

Here's an example of how to globally rename a field:

RENAME FIELD effdt AS currdate;

Here's an example of how to rename a recfield:

RENAME FIELD course_tbl.duration_days AS duration_d;

REPLACE_ALL

Syntax
REPLACE_ALL {record | *}   [AS new_table_name];
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Description

This is a variation of the IMPORT command. If a table already exists, use this command to drop the table
and its indexes from the database. It then:

1. creates the table.

2. creates any triggers.

3. inserts data.

4. creates indexes.

In the REPLACE_ALL statement, the AS clause is only valid if you specify a particular record. It is not
valid and should not be used with REPLACE_ALL *.

The table name that you specify after the AS command modifier should not have more than 18 characters
(including the ps_ prefix). Specifying a table name that is greater than 18 characters invokes the following
error message: Error: Unable to process create statement.

Note: Records defined using REPLACE_ALL can have a maximum of 500 total columns and multiple
long columns within the limitations for long columns set by the database platform. Check with the
database vendor for restrictions on the number of long columns allowed for the platform.

Parameters

All except IGNORE_DUPS and OUTPUT. INPUT is a required parameter.

REPLACE_DATA

Syntax
REPLACE_DATA {record | *};

Description

This command is a variation of the IMPORT command. Use it to delete data in existing tables and insert
the corresponding data from the export file.

Parameters

COMMIT, EXECUTE_SQL, EXTRACT, INPUT, INSERT_DATA_ONCE, LOG, NO COMMIT, NO
TRACE, NO VIEW, SIZING_SET, SPACE, START, and VERSION. INPUT is a required parameter.

REPLACE_VIEW

Syntax
REPLACE_VIEW {view | *};
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Description

Recreates one or all specified views in the database.

Parameters

LOG, NO COMMIT, NO TRACE, and START.

Note: If you use REPLACE_VIEW in bootstrap mode, the system automatically activates SET IGNORE
ERROR. This enables PeopleSoft Data Mover to continue processing until all of the view definitions have
been processed, and all errors have been written to the current .LOG file.

RUN

Syntax
RUN dms_file_name;

Description

Runs a DMS file from within a script. The specified file can contain any supported SQL commands,
PeopleSoft Data Mover commands, or SET statements, but it cannot contain any RUN commands.

The RUN command cannot contain a directory path. The RUN command uses the same directory as the
current PeopleSoft Data Mover script in which RUN is used.

SET

Syntax
SET parameter_1; SET parameter_2; ... SET parameter_n;

Description

The SET command, when combined with valid SET parameters, creates statements that establish the
conditions under which PeopleSoft Data Mover runs a script.

A SET statement controls the processing environment for the commands in a script until another SET
statement intervenes between commands. At that point, all SET parameters are reset to their default
values.

Example
SET LOG c:\temp\new.log
SET OUTPUT c:\temp\new.dat;
/
EXPORT absence_hist;
EXPORT employee_tbl
/
SET NO DATA
/
REMARK  All other SET parameters will be reset to defaults at this point;
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EXPORT bank_branch_tbl;

In the previous script, the specified log and output files (NEW.LOG and NEW.DAT) are used for the first
two EXPORT commands. Then, because SET NO DATA interrupts the script commands, all other SET
parameters are reset to their default values. So, for the third EXPORT and any subsequent PeopleSoft
Data Mover or SQL commands, the log file used is the default log file, DATAMOVE.LOG, and the
output file used is the default output file, DATAMOVE.DAT.

See Using SET Parameters.

SET BASE_LANGUAGE

Syntax
SET BASE_LANGUAGE current_language_code; SWAP_BASE_LANGUAGE recordname;

Description

Use only when there is an error with any of the tables after the SWAP_BASE_LANGUAGE
new_language_code command.

Note: Never run SET BASE_LANGUAGE current_language_code and SWAP_BASE_LANGUAGE
recordname commands before SWAP_BASE_LANGUAGE new_language_code.

SET IGNORE_IMPORT_ERRORS

Syntax
SET IGNORE_IMPORT_ERRORS;

Description

Use this command in conjunction with IMPORT, REPLACE_DATA or REPLACE_ALL command.

If there is an import error, processing will continue until the end of the input file. Any records that failed
to import will be shown in the Data Mover log. If the Data Mover script is run from the command line,
the errors will be shown in the output.

Note: SET IGNORE_IMPORT_ERRORS is only valid in bootstrap mode.

Example

Here is an example to ignore errors when importing import the entire file, when there are errors.

SET INPUT in.dat;
SET IGNORE_IMPORT_ERRORS;
IMPORT *;
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SET IGNORE_SPLCHARS
Use this command to ensure that special character, such as colon, is not used as a bind variable, and
carriage returns and spaces in a SQL string are not skipped and gets inserted into the database as it is
written in the DMS script.

Syntax

Use the syntax with ON option.

SET IGNORE_SPLCHARS ON;

Example

When this example SQL string is run with ON option, the special character colon is retained as it is and
the SQL runs to success.

SET LOG JOE_DMS.LOG;
SET IGNORE_SPLCHARS ON;
insert into PS_PTIASQLTXTDFN select 'ONEROUTECONTROL3','0','GBL','
',TO_DATE('1900-01-01','YYYY-MM-DD'),'00.00.000','0',30,0,'PS',to_timestamp('2021
-02-1903.20.01.03','YYYY-MM-DD HH24.MI.SS.FF'),'0','CEO',TO_CLOB('SELECT RECNAME
,FIELDNAME ,EOCC_CRITERIA_SYM ,EOCC_VALUE_MATCH , EOCC_FIELD_TYPE FROM
PS_EOCC_CONFIG_CRT WHERE PNLGRPNAME=:1 AND MARKET = :2 AND SEQUENCE_NUMBER =
:3 AND EOCC_CONFIG_TYPE = :4

                     ')from dual;

SET COMMIT

Syntax
Set COMMIT level;

Description

Sets the commit level for inserting rows and not for DDL statements. If the level is set to 0, commits are
only done when all rows for a record are inserted. Due to the expense of recompiling and rebinding after a
commit, the default is 0.

Note: There are performance implications associated with the SET COMMIT command. For a large
database with millions of rows, there is significant degradation in performance. However, for a small
database, performance slows down somewhat. Run the SET COMMIT command only as necessary.

Parameters

The default is to commit at the end of the record.
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Example

The following examples demonstrate how to use SET COMMIT in conjunction with SWAP
BASE_LANGUAGE:

Set COMMIT 2;
SWAP BASE_LANGUAGE FRA;

or

Set COMMIT 2;
SET BASE_LANGUAGE ENG;
SWAP_BASE_LANGUAGE MY_RECORD;

SWAP_BASE_LANGUAGE

Syntax
SWAP_BASE_LANGUAGE new_language_code;

or

SET BASE_LANGUAGE current_language_code; SWAP_BASE_LANGUAGE recordname;

Description

Installs any language other than English.

The command swaps all the language tables from PSRECDEFN. It gets all table names that contain
related tables, and it swaps one table at a time. It copies the base table into the related table, updates the
related record into the base table, and then deletes the related record from the related table.

If successful, the command updates PSOPTIONS SET LANGUAGE_CD to the new base language.

Swapping an individual table (SET BASE_LANGUAGE current_language_code and
SWAP_BASE_LANGUAGE recordname) is used only when there is an error with any of the tables after
the SWAP_BASE_LANGUAGE new_language_code command has been run.

Note: Never run a combination of SET BASE_LANGUAGE current_language_code and
SWAP_BASE_LANGUAGE recordname command before SWAP_BASE_LANGUAGE
new_language_code.

Example

To swap English for Canadian French, enter the following:

SWAP_BASE_LANGUAGE CFR

CFR is the new language code.

Note: During the initial installation, the Database Setup utility generates a script that automatically swaps
the base language if, while in the Database Setup interface, you select a base language other than English.
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Using PeopleSoft Data Mover Command Modifiers

The following commands enable you to modify a PeopleSoft Data Mover command to limit its scope,
rename the item being processed, or control error messaging.

AS

Syntax
{IMPORT | REPLACE_ALL} record   AS table_name;

Description

Changes the name of a record and then imports it. When using this modifier, keep the following points in
mind:

• If used with an IMPORT, the record is not imported if the table name specified in the IMPORT
command already exists in the database.

• When using the AS command modifier, you can specify either the record or table name for the record
or table specified preceding the AS.

However, you must always specify the table name (not the record name) for the record or table
specified following the AS. The name specified following the AS is the actual name that is used for
the table to be created.

• This modifier is not supported for records containing trigger definitions.

Parameters

IMPORT and REPLACE_ALL

Example

The following example imports a new record or table originally named PS_JOB and creates it as
PS_PROCESS:

IMPORT job
  AS ps_process;

Also correct:

IMPORT ps_job
  AS ps_process;

Incorrect:

IMPORT ps_job
  AS process;

Incorrect:

IMPORT job
  AS process;
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The last two examples are incorrect because process is specified, instead of ps_process. This means
that the table created is named PROCESS, but it should be named PS_PROCESS to comply with the
convention that all non-PeopleTools tables have the prefix PS_.

The table name that you specify following the AS command modifier should not have more than 18
characters (including the ps_ prefix). Specifying a table name that is greater than 18 characters invokes
the following error message: Error: Unable to process create statement.

When you import a record in this way, it is only created in the system tables, not in the PeopleSoft tables.
You must also create the record in the PeopleSoft tables, such as PSRECDEFN.

To create a table after running the IMPORT command:

1. Launch Application Designer.

2. Create or clone the new record.

Using the job and process example from the previous discussion, you would open JOB and then select
File, Save As and rename the record to PROCESS.

Note: The PS_ prefix does not appear in Application Designer.

3. Select Build, Current Object.

4. In the Build dialog box, select Create Tables under Build Options.

You may also want to make sure that all the appropriate options are set on the Build Settings tabs.

IGNORE_DUPS

Syntax
SET IGNORE_DUPS; IMPORT {record | *};

Description

Ignores duplicate-row error messages from the database. The IMPORT process continues despite any
duplicate-rows errors in the output window and log file. When IGNORE_DUPS is set, bulk loading, the
ability to load more than one row at a time, is turned off. By default, bulk loading is on and inserts up to
100 rows into a table at a time. Because turning off bulk loading slows performance, you should use this
feature only when required.

Note: SET IGNORE_DUPS is only valid in bootstrap mode.

Parameters

IMPORT
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UPDATE_DUPS

Syntax
SET UPDATE_DUPS; IMPORT {record | *};

Description

On command, PeopleSoft Data Mover imports a new row and updates an existing row.

Note: This command is valid for both bootstrap mode and regular mode. In regular mode, if the table is
identified as a language table, the system automatically resolves and swaps the base and related language
tables.

See IMPORT.

Parameters

IMPORT.

WHERE

Syntax

Data Mover Command {record | *} WHEREcondition(s)[;var#1_type,_var#1_value,var#2_ty⇒

pe, var#2_value,...var#n_type,var#n_value];

Note: In an EXPORT statement, the WHERE modifier must be on the same line as the EXPORT
command.

Description

Retrieves a partial set of rows from the data source. The data source could be a data file or the database.
The syntax and conditions of a Data Mover WHERE clause are similar to a WHERE clause in SQL. For
EXPORT, you can write the WHERE clause with comparison operands in-line or as bind variables. For
IMPORT the WHERE clause only supports comparison operators as bind variables. Parentheses are not
support in IMPORT. You can also use nested SELECT statements.

Warning! When comparing string or character values, use only US-ASCII (seven-bit ASCII) values.
Characters beyond this range can produce errors in the export file.

Parameters

EXPORT

IMPORT
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Example

Here's an example of a WHERE clause using both an inline operand and bind variables in an EXPORT
script:

EXPORT JOB WHERE
  EFFDT > :1 AND
  HOURLY_RT > :2
  AND GRADE = 'ADV';DATE,1994-01-01,NUMBER,100;

There are no single or double quotation marks around the bind data, as they are not necessary, and dates
are formatted as YYYY-MM-DD. The valid data types for binding are CHAR, NUMBER, DATE, TIME,
DATETIME, LONG, and IMAGE. Not all database platforms support LONG or IMAGE data types in the
WHERE clause, so you should not use WHERE clauses with these data types.

The following operators are supported in an import WHERE clause: =, < >, <, >,< =, > =, and simple uses
of AND and OR. For example, in the following formula, if A, B, and C are true, or if D is true, or if E is
true, then the whole statement is true

WHERE
  A = :1 AND B = :2 AND C = :3
  OR D = :4
  OR E = :5;NUMBER,10,NUMBER,20,NUMBER,30,NUMBER,0,NUMBER,1;

Using SET Parameters

The following parameters can be appended to a SET command to create a valid SET statement.

COMMIT

Syntax
SET COMMIT #of_rows;

Description

Sets the commit level only for inserting rows and not for DDL statements. If the level is set to 0, commits
are only done when all rows for a record are inserted. Due to the expense of recompiling and rebinding
after a commit, the default is 0.

Parameters

IMPORT, REPLACE_ALL, and REPLACE_DATA.

CREATE_INDEX_BEFORE_DATA

Syntax
SET CREATE_INDEX_BEFORE_DATA;
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Description

Creates the index before inserting rows into a record. The default method is to insert rows into a record
and then create the index.

Parameters

IMPORT and REPLACE_ALL.

DBSPACE

Syntax
SET DBSPACE {old_dbname.old_spacename} AS {new_dbname.new_spacename};

Description

The DBSPACE command is applicable only to PeopleSoft application databases installed with segmented
tablespaces. It cannot be used with databases installed with universal tablespaces. See the PeopleTools
Installation Guide for DB2 for z/OS for additional details.

The DBSPACE command is similar to the SPACE command, but it is designed to handle the combination
of DBNAME.DDLSPACENAME. On DB2 UDB, the DBNAME or DDLSPACENAME alone is not
necessarily unique. However, the combination of the two (DBNAME.DDLSPACENAME) provides a
unique relationship. For example, DBSPACE would be needed in the following scenario:

PSFSDMO.HRAPP
PSHRDMO.HRAPP
PSPTDMO.HRAPP

Note: This command is supported only on DB2 UDB for z/OS. You use this command in place of the
SPACE command used on other platforms.

Parameters

IMPORT and REPLACE_ALL.

Example

The wildcard (*) character is permitted for the database name and space name parameters to apply to all
values being processed for the specific parameter in which the wildcard character is used. The following
are examples of using this command to achieve one of the following:

To change a specific DBNAME/DDLSPACENAME combination to a single new combination:

SET DBSPACE old_dbname.old_spacename AS new_dbname.new_spacename

To keep the current database name the same but change the specific space name to a new name:

SET DBSPACE *.old_spacename AS *.new_spacename
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To keep the current space name the same, but change the specific database name to a new name:

SET DBSPACE old_dbname.* AS new_dbname.*

Warning! Because of the large number of objects delivered in the PeopleSoft logical databases, do not
override all old database name or space name values to a single new database name or space name value
when building a SYS or DMO database. However, this feature may be useful in working with smaller
data files that contain a smaller number of objects.

For large databases, do not use the following commands:

SET DBSPACE *.* AS new_dbname.new_spacename

SET DBSPACE *.* AS *.new_spacename

SET DBSPACE *.* AS new_dbname.*

You can use multiple SET DBSPACE statements to override the space name in the .DAT file. This
enables you to override multiple databases in the same section of the script. For example:

SET DBSPACE PSFSDMO.* AS MYFSDMO1.*;
SET DBSPACE PSFSDMOF.* AS MYFSDMO2.*;
SET DBSPACE PSFSDMOD.* AS MYFSDMO3.*;
SET DBSPACE PSFSDMOM.* AS MYFSDMO4.*;

ENABLE_DB2UTS

Syntax
SET ENABLE_DB2UTS;

Description

This command enables PeopleTools to support universal tablespaces for DB2 for z/OS during database
installation. Use this only if you plan to use universal tablespaces. See the PeopleTools Installation Guide
for DB2 for z/OS for additional details.

DDL

Syntax
SET DDL {RECORD
| INDEX | UNIQUE INDEX | SPACE} {object_name |
*}    INPUT parm AS value;

Note: The object_name is only available for the SPACE option, not the RECORD, INDEX, and UNIQUE
INDEX. The RECORD, INDEX, and UNIQUE INDEX are available for the *, not the object_name.

Description

Substitutes values for the parameters specified in the DDL template commands. Substitute the parm and
value placeholders for an actual parameter and its value. If an asterisk is used instead of an object name, a
SQL update on PSDDLDEFPARMS is performed on the parameter and value upon successful completion
of the IMPORT or REPLACE_ALL command that corresponds to the SET DDL statement.
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Parameters

IMPORT and REPLACE_ALL.

Example

Below are some examples of DDL template SET commands from a DB2 UDB import script:

SET DDL RECORD   *  INPUT dbname   AS ps910dg0;
SET DDL INDEX   *  INPUT stogroup   AS wps04sg;
SET DDL SPACE   *  INPUT stogroup   AS wps04sg;

EXECUTE_SQL

Syntax
SET EXECUTE_SQL
[AFTER] sql_statement;

Description

Performs the SQL statement specified at the beginning of a transaction. Typically, this command is used
to set up a specific cursor environment before PeopleSoft Data Mover begins processing. For example,
in DB2 UDB, use this command to set the current setID, or for Oracle, use this command to designate a
specific rollback segment.

This command doesn't run for DDL SQL statements. For example, in DB2 UDB, you cannot set the
current setID before creating spaces, tables, indexes, or views.

Parameters

IMPORT, REPLACE_ALL, and REPLACE_DATA.

EXTRACT

Syntax
SET EXTRACT {COMMAND
| DDL | INPUT | SPACE | OUTPUT file_name};

Description

Extracts various types of information from an export file (the DAT file specified in the corresponding
SET INPUT command that precedes the IMPORT or REPLACE ALL command) and writes this
information to the user-defined output file specified in the SET EXTRACT OUTPUT file_name
statement.

Note: You must use SET EXTRACT OUTPUT before issuing any other SET EXTRACT statements.

EXTRACT INPUT writes out any statements from the DAT file that are associated with the tables being
imported. EXTRACT DDL writes out any CREATE TABLE, CREATE INDEX, or CREATE UNIQUE
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INDEX statements from the DAT file. EXTRACT COMMAND writes out the EXPORT statements from
the DAT file.

When EXTRACT statements are issued, no SQL CREATE or INSERT statements are executed. The
associated IMPORT or REPLACE_ALL command is not actually executed, so no import is performed.

Parameters

IMPORT and REPLACE_ALL.

IGNORE_DUPS

Syntax
SET IGNORE_DUPS;

Description

Ignores duplicate-row error messages from the database; the IMPORT process continues despite any
duplicate-row errors displayed in the output window and log file. You can set this command for the entire
import script or by record, using IGNORE_DUPS as a command modifier.

When IGNORE_DUPS is set, bulk loading, the ability to load more than one row at a time, is turned off
(to allow checking for duplicates, so that duplicate rows can be ignored or bypassed). By default, bulk
loading is on and inserts many (100) rows into a table at a time. Because turning off bulk loading slows
performance, use this feature only when required or by record.

See IMPORT.

See IGNORE_DUPS.

Parameters

IMPORT.

Note: The command SET IGNORE_DUPS is only valid in bootstrap mode. This prevents the loss of data
during a PeopleSoft Data Mover import of a language table in regular mode.

INPUT

Syntax
SET INPUT file;

Description

Specifies the name of the exported file to import; typically this file has a .DAT extension, though this is
not a requirement. Because this statement is required to do an import, there is no default file.
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If you don't specify a path for this file, PeopleSoft Data Mover searches for the file in the following
locations in the order presented:

• It searches the Data Mover input directory as defined in PeopleSoft Configuration Manager on the
Edit Profile, Common tab.

• If the input directory setting is blank (not set) on the Edit Profile, Common tab, PeopleSoft Data
Mover searches the C:\TEMP directory.

Parameters

IMPORT, REPLACE_ALL, and REPLACE_DATA.

INSERT_DATA_ONCE

Syntax
SET INSERT_DATA_ONCE record;

Description

Skips (that is, bypasses importing) the specified record if there is already one or more rows in the table
corresponding to that record. If the table is empty, only a single row is inserted.

Parameters

IMPORT, REPLACE_ALL, and REPLACE_DATA.

LOG

Syntax
SET LOG file;

Note: You must specify a file name for the SET LOG statement or else a log file is not created. If you do
not want to specify a log file name, omit the SET LOG statement completely.

Description

Specifies a user-defined file name for the log file that is created when running a PeopleSoft Data Mover
script or command. If the SET LOG statement is omitted completely, a default log file is created with the
name DATAMOVE.LOG. PeopleSoft Data Mover writes this DATAMOVE.LOG file to the default log
directory, which is DM_HOME\log.

The system uses the PeopleSoft Data Mover log directory specified on the Edit Profile, Common tab in
PeopleSoft Configuration Manager. If the preceding setting is blank, the log file is written to C:\TEMP.

Note: If you use the SET LOG statement but do not specify a file name and path, PeopleSoft Data Mover
writes the user-defined log file to the default log directory according to the same rule.
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When checking the DATAMOVE.LOG file in a multi database environment, make sure you are
examining the correct log file. At the top of the output file, verify the date and the database name.

Logging status in C:\TEMP\datamove.log
Started: Fri Mar 17 13:47:15 2001
Data Mover Release: 8.4
Database: HR702U40
...
Ended: Fri Mar 17 13:47:20 2001
Successful completion

Parameters

All.

NO DATA

Syntax
SET NO DATA;

Description

During an export, the NO DATA command prevents data from being exported. In an import, this
command prevents data from being inserted.

Parameters

EXPORT, IMPORT, and REPLACE_ALL.

NO INDEX

Syntax
SET NO INDEX;

Description

Prevents indexes from being created during an IMPORT or a REPLACE_ALL command.

Parameters

IMPORT and REPLACE_ALL.

NO RECORD

Syntax
SET NO RECORD;
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Description

Prevents records from being created during an import.

Parameters

IMPORT and REPLACE_ALL.

NO SPACE

Syntax
SET NO SPACE;

Description

Prevents tablespaces from being created. This is the default setting. You can use this statement to reset the
default after executing a SET SPACE statement.

Parameters

IMPORT and REPLACE_ALL.

NO TRACE

Syntax
SET NO TRACE;

Description

Sets the PeopleSoft trace flag (TraceSQL) in PeopleSoft Configuration Manager to Off for the commands
that follow, until the next SET statement. This is the recommended method of executing commands. If
SET NO TRACE is specified, then no trace file is created, even if you specify a trace file in PeopleSoft
Configuration Manager on the Trace tab. Commands that you run without specifying SET NO TRACE do
trace SQL, if SQL tracing is enabled in PeopleSoft Configuration Manager.

By default, the trace file is written to DM_HOME\trace. The default trace file name is datamover.trc.

Note: This statement cannot be used with an INSERT command.

Parameters

All.
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NO VIEW

Syntax
SET NO VIEW;

Description

Prevents views from being created.

Parameters

EXPORT * only, IMPORT * only, REPLACE_ALL * only, and REPLACE_DATA * only.

OUTPUT

Syntax
SET OUTPUT file;

Note: You must specify a file name for the SET OUTPUT statement or else an output file is not created.
If you do not want to specify an output file name, omit the SET OUTPUT statement completely.

Description

Specifies a user-defined file name for the output file that is created by the corresponding EXPORT
statement. If the SET OUTPUT statement is omitted completely, a default output file with the name
DATAMOVE.DAT is created. The location that the output file is created is determined by the following:

• The system uses the PeopleSoft Data Mover output directory specified on the Edit Profiles, Common
tab in PeopleSoft Configuration Manager.

• If the previous setting is blank, the output file is created in the C:\TEMP directory.

Note: If you use the SET OUTPUT statement but do not specify a file name and path, PeopleSoft Data
Mover writes the user-defined output file to the default output directory.

Parameters

EXPORT.

OUTPUTDb2DBDDL

Syntax
SET OutputDb2DBDDL file;
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Example

This is the example:

SET OutputDb2DBDDL C:\temp\DB_DDL_only.txt;

Description

Specifies the path and file name for the script that will contain extracted CREATE DATABASE DDL
statements.

Note: The DDL scripts will only be generated for PeopleSoft Db2 databases for which Universal
Tablespace support has been enabled.

Review the sample script in the example section of SET Db2UTSDDL topic.

OUTPUTDb2UTSDDL

Syntax
SET OUTPUTDb2UTSDDL file;

Example

This is the example:

SET OUTPUTDb2UTSDDL C:\temp\UTS_DDL_only.txt;;

Description

Specifies the path and file name of the script that will contain extracted CREATE TABLESPACE (UTS)
DDL statements.

Note: The DDL scripts will only be generated for PeopleSoft Db2 databases for which Universal
Tablespace support has been enabled.

Review the sample script in the example section of SET Db2UTSDDL topic.

SET Db2DBDDL

Syntax
SET Db2DBDDL;

Description

Specifies the Data Mover to write CREATE DATABASE DDL to the script identified by
OutputDb2DBDDL.

SET NO RECORD and SET NO INDEX continues to work as expected.
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Review the sample script in the example section of SET Db2UTSDDL topic.

Note: The DDL scripts will only be generated for PeopleSoft Db2 databases for which Universal
Tablespace support has been enabled.

SET Db2UTSDDL

Syntax
SET Db2UTSDDL;

Description

Specifies the Data Mover to write CREATE TABLESPACE (UTS) DDL to the script identified by
OutputDb2UTSDDL.

SET NO RECORD and SET NO INDEX continues to work as expected.

Note: The DDL scripts will only be generated for PeopleSoft Db2 databases for which Universal
Tablespace support has been enabled.

Example

The following is the sample Data Mover scripts for OutputDb2DBDDL, OutputDb2UTSDDL,
Db2DBDDL, and Db2UTSDDL.

Note: SET ENABLE DB2UTS and SET EXTRACT DDL statements are prerequisites to generate Db2
database and UTS DDLs using SET Db2DBDDL and SET Db2UTSDDL statements respectively.

SET LOG c:\temp\ptengs1.log;
 SET INPUT C:\PT860P02B_2211160502-retail\DATA\ptengs.db;
 SET OutputDb2DBDDL C:\temp\DB_DDL_only.txt;
 SET OutputDb2UTSDDL C:\temp\UTS_DDL_only.txt;
 SET OUTPUT C:\temp\table_and_indexDDL.txt;
 SET EXECUTE_SQL SET CURRENT SQLID = 'Q8602D7P';
 ....etc....
 REM uncomment the following line to enable UTS ;
 SET ENABLE_DB2UTS;
 SET Db2DBDDL;
 SET Db2UTSDDL;
 ....etc....
 SET EXTRACT DDL;
 IMPORT *;

SIZING SET

Syntax
SET SIZING_SET n;
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Description

Specifies the sizing set number as defined on the DDL Model Defaults page. The default is 0. To use this
parameter, the specified sizing set must be defined in the export file.

See  System and Server Administration.

Parameters

IMPORT and REPLACE_ALL.

SPACE

Syntax
SET SPACE old
spcname AS new_spcname;

Description

Use for all operating systems other than z/OS.

Renames the default space names to customized space names. To name all record default space names to a
single space name, substitute * for a space name.

Parameters

IMPORT and REPLACE_ALL.

Example
SET SPACE * AS PS;

START

Syntax
SET START [AFTER] record;

Description

Designates where in the export file to start the import process. The default is to start at the beginning of
the file. To start immediately after a particular PeopleSoft record in the file, use SET START AFTER.
This SET statement is useful for restarting a script after an error.

If the AFTER parameter is omitted, the import process starts at the record that is specified in the SET
START statement. If the AFTER parameter is specified, the import process starts after the record
specified in the SET START statement.
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Note: If the same record name appears multiple times in the same DAT file, the SET START AFTER
command begins after the last occurrence of the record name in the DAT file.

When you use the SET START command with REPLACE_VIEW and no DAT file specified, you
designate at which (or after which) view in the database to start. Views are created in alphabetical order.

Parameters

IMPORT, REPLACE_ALL, REPLACE_DATA and REPLACE_VIEW.

STATISTICS

Syntax
SET STATISTICS
{ ON | OFF };

Description

Sets UPDATE STATISTICS to on or off. The default value is on. Set the value to off if you do not want to
update statistics after an IMPORT. This command works only in bootstrap mode.

Parameters

IMPORT and REPLACE_ALL.

UNICODE

Syntax
SET UNICODE {
ON | OFF }

Description

This command is recommended for use in bootstrap mode for an initial database load. It specifies whether
the database is Unicode or non-Unicode.

Warning! If the database is already fully loaded, DO NOT use this command because it could result in
the wrong value ENABLE_UNICODE flag being set on the PSSTATUS table.

Parameters

IMPORT and REPLACE_ALL.
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VERSION

Syntax
SET VERSION sql_table.column condition;

Description

Verifies the version of the database for importing.

Parameters

IMPORT, REPLACE_ALL and REPLACE_DATA.

Example

Suppose that you state the following:

 SET VERSION PSLOCK.TOOLSREL="8.4"

PeopleSoft Data Mover verifies that the TOOLSREL column in PSLOCK equals 8.4. This avoids
importing an export file into the wrong database. Use the SQL table name to indicate which PeopleSoft
record to check.

Using Script Examples

This section provides several example script files. Review these scripts to see how you can use PeopleSoft
Data Mover to accomplish various tasks.

Exporting Databases

Description

This example shows how to export a database.

Example
SET OUTPUT c:\temp\pt.dat;
SET LOG c:\temp\pt.log;
EXPORT *;

Building Databases

Description

This example shows how to build a database.
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Example
set log c:\temp\hcengd.log;
set input c:\HRDMO\data\hcengd.db;
set no view;
set no space;
set no trace;
import *;
update PSLOCK set OWNERID = <OWNER_ID>;
update PSOPRDEFN set ACCESSID = <ACCESS_ID>, ACCESSPSWD = <ACCESS_ID_PSWD>,
 PTOPERPSWDV2= '0000000000000000' where OPRTYPE = 0;
update PSACCESSPROFILE set STM_ACCESS_ID = <ACCESS_ID>, STM_ACCESS_PSWD = <ACCESS_I⇒

D_PSWD>,
 VERSION = 0, ENCRYPTED = 0;
set log c:\temp\grant.log;
encrypt_password *;

Then run the resetpswd.dms data mover script from the PS_HOME/scripts directory.

Recreating All Views

Description

This example shows how to recreate all views.

Example
SET LOG c:\temp\view.log;
REPLACE_VIEW *;

Importing with REPLACE_ALL with a Commit Level

Description

This example shows how to import with REPLACE_ALL with a commit level.

Example
SET INPUT c:\ptdvl\bin\exp2.dat;
SET LOG c:\ptdvl\bin\exp2.log;
SET COMMIT 2;
REPLACE_ALL employee_review;
REPLACE_ALL course_tbl
   WHERE days_duration = :1 AND course_type > :2;number,1,char,C;
REPLACE_ALL absence_hist
   WHERE return_dt > :1;date,1988-01-01;

Combining SQL Commands and IMPORT

Description

This example shows how to combine SQL commands and IMPORT.

308  Copyright © 1988, 2025, Oracle and/or its affiliates.



Chapter 17 Using PeopleSoft Data Mover

Example
SET INPUT c:\ptdvl\bin\exp2.dat;
SET COMMIT 10;
SET START AFTER course_tbl;
SET IGNORE_DUPS;
DELETE FROM ps_absence_hist WHERE emplid = '8001';
IMPORT *;
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